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	p Information on software for this product
1.	� Included with this product is software licensed under the GNU General Public License (GPL) and GNU Lesser General 

Public License (LGPL), and users are hereby informed that they have the right to obtain, change and redistribute the 
source codes of this software.

	� To obtain the source codes, go to the following website:
	 https://pro-av.panasonic.net/en/
	� The manufacturer asks users to refrain from directing inquiries concerning the source codes they have obtained and 

other details to its representatives.
2.	� Included with this product is software which is licensed under MIT-License.
3.	� This product includes software which is licensed under FreeType Project (www.freetype.org).

For more information about these, refer to the website below.
https://pro-av.panasonic.net/manual/en/index.html
Details are given in the original (English language) text.

Trademarks and registered trademarks

	p The terms HDMI and HDMI High-Definition Multimedia 
Interface, and the HDMI Logo are trademarks or registered 
trademarks of HDMI Licensing Administrator, Inc. in the 
United States and other countries.

	p NDI® is a registered trademark of NewTek, Inc. in the 
United States and other countries.

	p Other names of companies and products contained in these 
Operating Instructions may be trademarks or registered 
trademarks of their respective owners.

About copyright and licence

Distributing, copying, disassembling, reverse compiling, 
reverse engineering, and also exporting in violation of export 
laws of the software provided with this unit are expressly 
prohibited.

Abbreviations

The following abbreviations are used in this manual.
	p Personal computers are referred to as “computers”.

Illustrations and screen displays featured in the 
manual

	p What is shown in the manual’s illustrations and screen 
displays may differ from how it is actually appears.



3

Read this first!

 indicates safety information.

WARNING:
Always keep accessories (ground connector 
mounting screws, cable clamp) out of the reach of 
babies and small children.

WARNING:
This equipment is compliant with Class A of CISPR 32.
In a residential environment this equipment may 
cause radio interference.

CAUTION:
A coin type battery is installed inside of the unit.
Do not expose the unit to excessive heat such as 
sunshine, fire or the like.

CAUTION:
To reduce the risk of fire or electric shock caused by 
damage to the power supply cord, do not squeeze, 
bend, or pull the power supply cord when using the 
apparatus.

CAUTION:
To reduce the risk of fire or electric shock and 
annoying interference, use the recommended 
accessories only.

WARNING:
•	� To reduce the risk of fire or electric shock, do not 

expose this equipment to rain or moisture.
•	� To reduce the risk of fire or electric shock, keep 

this equipment away from all liquids. Use and store 
only in locations which are not exposed to the risk 
of dripping or splashing liquids, and do not place 
any liquid containers on top of the equipment.

CAUTION:
In order to maintain adequate ventilation, do not 
install or place this unit in a bookcase, built-in 
cabinet or any other confined space. To prevent risk 
of electric shock or fire hazard due to overheating, 
ensure that curtains and any other materials do not 
obstruct the ventilation.

CAUTION:
The mains plug of the power supply cord shall remain 
readily operable.
The AC receptacle (mains socket outlet) shall be 
installed near the equipment and shall be easily 
accessible. To completely disconnect this equipment 
from the AC mains, disconnect the power cord plug 
from the AC receptacle.

WARNING:
This equipment must be grounded.
To ensure safe operation, the three-pin plug must 
be inserted only into a standard three-pin power 
outlet which is effectively grounded through normal 
household wiring.
Extension cords used with the equipment must 
have three cores and be correctly wired to provide 
connection to the ground. Wrongly wired extension 
cords are a major cause of fatalities.
The fact that the equipment operates satisfactorily 
does not imply that the power outlet is grounded 
or that the installation is completely safe. For your 
safety, if you are in any doubt about the effective 
grounding of the power outlet, please consult a 
qualified electrician.

CAUTION:
This apparatus can be operated at a voltage in the 
range of 100 – 240 V AC.
Voltages other than 120 V are not intended for U.S.A. 
and Canada.
Operation at a voltage other than 120 V AC may 
require the use of a different AC plug. Please contact 
either a local or foreign Panasonic authorized service 
center for assistance in selecting an alternate AC 
plug.

CAUTION:
Do not remove panel covers by unscrewing.
To reduce the risk of electric shock, do not remove 
the covers. No user serviceable parts inside.
Refer servicing to qualified service personnel.

CAUTION:
Naked flame sources, such as lighted candles, should 
not be placed on the apparatus.

For U.S.A. and Canada



4

The symbols on this product (including the accessories) represent the following:

AC

DC

Read this first!

FCC NOTICE (USA)
Supplier’s Declaration of Conformity
Model Number: AV-HSW10P
Trade Name: Panasonic
Responsible Party: Panasonic Corporation of North America
Two Riverfront Plaza, Newark, NJ 07102
Support contact: 1-800-524-1448

This device complies with part 15 of the FCC Rules.
Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation.

FCC Note:
This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to Part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy, and if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense.

Warning:
To assure continued FCC emission limit compliance, the user must use only shielded interface cables when connecting 
to external units. Also, any unauthorized changes or modifications to this equipment could void the user’s authority to 
operate it.

NOTIFICATION (Canada)
CAN ICES-003 (A)/NMB-003(A)

For AV-HSW10P

 indicates safety information.
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Read this first!

For AV-HSW10E

Caution for AC Mains Lead
FOR YOUR SAFETY PLEASE READ THE FOLLOWING TEXT CAREFULLY.
This product is equipped with 3 types of AC mains cable.

Appropriate mains cable must be used in each local area, since the other type of mains cable is not suitable.

FOR CONTINENTAL EUROPE, 
ETC.
Not to be used in the U.K.

FOR U.K. ONLY
If the plug supplied is not suitable for 
your socket outlet, it should be cut 
off and appropriate one fitted.

FOR INDIA ONLY

FOR U.K. ONLY
This appliance is supplied with a moulded three pin 
mains plug for your safety and convenience.
A 13 amp fuse is fitted in this plug.
Should the fuse need to be replaced please ensure that 
the replacement fuse has a rating of 13 amps and that it 
is approved by ASTA or BSI to BS1362.
Check for the ASTA mark  or the BSI mark  on the 
body of the fuse.

If the plug contains a removable fuse cover you must 
ensure that it is refitted when the fuse is replaced.
If you lose the fuse cover the plug must not be used  
until a replacement cover is obtained.
A replacement fuse cover can be purchased from your 
local Panasonic Dealer.

How to replace the fuse
1.	Open the fuse compartment with a screwdriver.

2.	Replace the fuse.

Fuse

 indicates safety information.

Manufactured by: 
Panasonic Connect Co., Ltd.
4-1-62 Minoshima, Hakata-ku, Fukuoka 812-8531, Japan
Importer:
Panasonic Connect Europe GmbH
Hagenauer Strasse 43, 65203 Wiesbaden, Germany
Authorized Representative in EU:
Panasonic Connect Europe GmbH
Panasonic Testing Centre
Winsbergring 15, 22525 Hamburg, Germany

Importer for UK:
Panasonic Connect UK,
a branch of Panasonic Connect Europe GmbH,
Maxis 2, Western Road, Bracknell, Berkshire, RG12 1RT
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Read this first!

EMC NOTICE FOR THE PURCHASER/USER OF THE APPARATUS

1.	 Pre‑requisite conditions to achieving compliance with the above standards
	 <1>	�Peripheral equipment to be connected to the apparatus and special connecting cables
		  •	� The purchaser/user is urged to use only equipment which has been recommended by us as peripheral equipment to 

be connected to the apparatus.
		  •	 The purchaser/user is urged to use only the connecting cables described below.
	 <2>	�For the connecting cables, use shielded cables which suit the intended purpose of the apparatus.
		  •	� Video signal connecting cables 

Use double shielded coaxial cables, which are designed for 75‑ohm type high‑frequency applications, for SDI (Serial 
Digital Interface). 
Coaxial cables, which are designed for 75‑ohm type high‑frequency applications, are recommended for analog 
video signals.

		  •	� Audio signal connecting cables 
If your apparatus supports AES/EBU serial digital audio signals, use cables designed for AES/EBU. 
Use shielded cables, which provide quality performance for high‑frequency transmission applications, for analog 
audio signals.

		  •	� Other connecting cables (LAN, RS‑422) 
Use shielded cables, which provide quality performance for high‑frequency applications, as connecting cables.

		  •	 When connecting to the DVI signal terminal, use a cable with a ferrite core.
		  •	� If your apparatus is supplied with ferrite core(s), they must be attached on cable(s) following instructions in this 

manual.
2.	 Performance level
	� The performance level of the apparatus is equivalent to or better than the performance level required by these standards. 

However, the apparatus may be adversely affected by interference if it is being used in an EMC environment, such as an 
area where strong electromagnetic fields are generated (by the presence of signal transmission towers, cellular phones, 
etc.). In order to minimize the adverse effects of the interference on the apparatus in cases like this, it is recommended 
that the following steps be taken with the apparatus being affected and with its operating environment:

		  1.  Place the apparatus at a distance from the source of the interference.
		  2.  Change the direction of the apparatus.
		  3.  Change the connection method used for the apparatus.
		  4.  �Connect the apparatus to another power outlet where the power is not shared by any other appliances.

Disposal of Old Equipment and Batteries
Only for European Union and countries with recycling systems
These symbols on the products, packaging, and/or accompanying documents mean that used electrical and electronic products and 
batteries must not be mixed with general household waste.
For proper treatment, recovery and recycling of old products and used batteries, please take them to applicable collection points in 
accordance with your national legislation.
By disposing of them correctly, you will help to save valuable resources and prevent any potential negative effects on human health 
and the environment.
For more information about collection and recycling, please contact your local authority, dealer or supplier.
Penalties may be applicable for incorrect disposal of this waste, in accordance with national legislation.

Note for the battery symbol (bottom symbol):
This symbol might be used in combination with a chemical symbol. In this case it complies with the requirement set by the Directive 
for the chemical involved.

Turkey Only
AEEE Yönetmeliğine Uygundur.
AEEE Complies with Directive of Turkey.

TO REMOVE BATTERY
Back-up Battery (Lithium Battery)
• For the removal of the battery for disposal at the end of its service life, please consult your dealer.

WARNING:
THIS PRODUCT CONTAINS A COIN 
BATTERY
Keep coin battery out of the reach of infants 
and small children whether the battery is new 
or used. Severe or fatal injuries can occur 
within 2 hours of ingestion. Seek medical 
attention immediately.
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ІНФОРМАЦІЯ ПРО ПІДТВЕРДЖЕННЯ ВІДПОВІДНОСТІ ПРОДУКТУ
Виробник: Panasonic Connect Co., Ltd. Панасонік Коннект Ко., Лтд.
Адреса виробника: Fukuoka, Japan Фукуока Японія
Країна походження: China Китай

Імпортер: ТОВ “ПАНАСОНІК УКРАЇНА ЛТД”
Адреса Імпортера: вул. Васильківська, буд. 30, м. Київ 03022, Україна

Примітки:

Термін служби виробу 7 років

Дату виготовлення можна визначити за комбінацією букв і цифр серійного номера, що розташований на 
маркувальній табличці виробу.

Приклад:           X      X      XXXXXXX

			 

Рік: остання цифра року (6 – 2016, 7 – 2017,…0 – 2020)
Місяць: А – Січень, В – Лютий… L – Грудень

Read this first!

Information for Users in India
Information on hazardous constituents as specified in the E-Waste (Management) Rules in electrical and electronic equipment.
Declaration of Conformity with the requirements of the E-Waste (Management) Rules limits with respect to Lead, Mercury, Cadmium, 
Hexavalent chromium, Polybrominated biphenyls,Polybrominated diphenyl ethers.
The content of hazardous substance with the exemption of the applications listed in the E-Waste (Management) Rules:
1.	Lead (Pb) – not over 0.1% by weight.
2.	Cadmium (Cd) – not over 0.01% by weight.
3.	Mercury (Hg) – not over 0.1% by weight.
4.	Hexavalent chromium (Cr6+) – not over 0.1% by weight.
5.	Polybrominated biphenyls (PBBs) – not over 0.1% by weight.
6.	Polybrominated diphenyl ethers (PBDEs) – not over 0.1% by weight.

For the purpose of recycling to facilitate effective utilization of resources, please return this product to a nearby authorized collection 
center, registered dismantler of recycler, or Panasonic service center when disposing of this product.
Customer care number (Toll free) : 1800 103 1333 ,1800 108 1333
Please see the Panasonic website for further information on collection centers, etc. or call the customer care toll-free number.
https://www.panasonic.com/in/corporate/e-waste-management.html

Do’s & Don’ts

No. Do’s Don’ts

1 All electrical and electronic products are required to be handed 
over only to the Authorized recycler.

The product should not be opened by the user himself / herself, 
but only by authorized service personnel.

2 The product should be handed over only to authorized recycler 
for disposal.

The product is not meant for re-sale to any unauthorized 
agencies / scrap dealers / kabariwalas.

3
Keep the product in an isolated area, after it becomes non-
functional / unrepairable so as to prevent its accidental 
breakage.

The product is not meant for mixing into household waste 
stream.

4 Refer to Operating Instructions for handling of end of life 
products.

Do not keep any replaced spare part(s) from the product in an 
exposed area.

5
Always dispose of products that have reached end of life at 
Panasonic Life Solutions India Authorized Service Centre.

Do not donate old electronic items to anybody.
Do not dispose of your product in garbage bins along with 
municipal waste that ultimately reaches landfill.

6
Wherever possible or as instructed, separate the packaging 
material according to responsible waste disposal options and 
sorting for recycling.

Do not give e-waste to informal and unorganized sectors like 
Local Scrap Dealers / Rag Pickers.
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	wOverview
This unit is a 1 ME digital video switcher which supports a multiple number of 3G and HD formats.
Despite its compact size, it comes with four SDI inputs, two HDMI inputs, two SDI outputs, one HDMI output, four IP inputs, two 
IP outputs, and analog audio 2-channel input/output.
The AV-HSW10 compact live switcher, compatible with IP input/output systems such as NDI*1/SRT/RTMP, along with 3G-SDI, 
has basic functions that rival those in mid-range medium-sized switchers, enabling the production of HD video.
With its excellent portability, the all-in-one main unit can easily be transported for use at a variety of live, music, sport, and 
entertainment events.
Furthermore, along with support for 3G/HD multiformat, it also has a variety of IP inputs and outputs, is compatible with UVC, 
enabling it to not only be smoothly operated at events where there are a number of cameras*2, but also to directly transmit video 
using a variety of methods of expression at remote locations.
The keyers, which enable a variety of program production techniques, include two keyers, including PinP 2ch and chroma key 
1ch.
Furthermore, you are able to flexibly select video output to match your purposes, even when you have scenes using different 
formats, using the up/down converter function and the HDMI scaler function.
We have endeavored to make the product useful in a variety of portable applications, such as special event venues, broadcast 
vehicles, at university or company presentations, etc., and of course inside broadcasters themselves. This compact live switcher 
really exhibits its high performance capabilities when it produces living images on location.

*1	�NDI® stands for High bandwidth NDI®, and NDI®|HX stands for High efficiency low bandwidth NDI®|HX.  
NDI® is a protocol used to support live image production workflows that use IP, which was developed by NewTek, Inc.

*2	�Panasonic 4K/HD integrated cameras and the AG-CX350 memory card camera recorder. 
For 4K/HD integrated cameras that are compatible with NDI® and NDI®|HX, refer to the following Panasonic website.  
https://pro-av.panasonic.net/en/

	wConcerning the ratings display
The name, model number, and power rating for the unit are displayed on the side panel.

	wDisclaimer of warranty
IN NO EVENT SHALL Panasonic Connect Co., Ltd. BE LIABLE TO ANY PARTY OR ANY PERSON, EXCEPT FOR 
REPLACEMENT OR REASONABLE MAINTENANCE OF THE PRODUCT, FOR THE CASES, INCLUDING BUT NOT LIMITED 
TO BELOW:

1	�ANY DAMAGE AND LOSS, INCLUDING WITHOUT LIMITATION, DIRECT OR INDIRECT, SPECIAL, CONSEQUENTIAL 
OR EXEMPLARY, ARISING OUT OF OR RELATING TO THE PRODUCT;

2	�PERSONAL INJURY OR ANY DAMAGE CAUSED BY INAPPROPRIATE USE OR NEGLIGENT OPERATION OF THE 
USER;

3	�UNAUTHORIZED DISASSEMBLE, REPAIR OR MODIFICATION OF THE PRODUCT BY THE USER;
4	�INCONVENIENCE OR ANY LOSS ARISING WHEN IMAGES ARE NOT DISPLAYED, DUE TO ANY REASON OR CAUSE 

INCLUDING ANY FAILURE OR PROBLEM OF THE PRODUCT;
5	�ANY PROBLEM, CONSEQUENTIAL INCONVENIENCE, OR LOSS OR DAMAGE, ARISING OUT OF THE SYSTEM 

COMBINED BY THE DEVICES OF THIRD PARTY;
6	�ANY INCONVENIENCE, DAMAGES OR LOSSES RESULTING FROM ACCIDENTS CAUSED BY AN INADEQUATE 

INSTALLATION METHOD OR ANY FACTORS OTHER THAN A DEFECT IN THE PRODUCT ITSELF;
7	�LOSS OF REGISTERED DATA CAUSED BY ANY FAILURE;
8	�ANY DAMAGE OR CLAIMS DUE TO LOSS OR LEAKAGE OF IMAGE DATA OR SETTING DATA SAVED ON THIS UNIT 

OR ON A USB MEMORY OR COMPUTER.

Before use
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	wNetwork security
The unit also has functions which are used when it is connected to a network. Using the unit when it has been connected to a 
network may possibly give rise to the following issues.

1	Leakage or theft of information through this unit
2	�Use of this unit for illegal operations by persons with malicious intent
3	�Interference with or stoppage of this unit by persons with malicious intent

It is your responsibility to take precautions such as those described below to protect yourself against the above network security 
risks.

	p Use this unit in a network secured by a firewall, etc.
	p If this unit is connected to a network that includes computers, make sure that the system is not infected by computer viruses 
or other malicious entities (using a regularly updated antivirus program, anti-spyware program, etc.).

The following points should be borne in mind as well.
	p Use with the same segment is recommended for the equipment which is connected to the unit. 
If the unit is connected to equipment whose segments are different, events dependent upon the settings inherent to the 
network equipment, for instance, may occur so thoroughly check the connections with the equipment to which the unit will be 
connected prior to the start of operation.

	p Do not choose an installation location where the unit, cables and other parts will be easily damaged.
	p NDI communication may become unstable in some network environments. 
Confirm the planned amount of NDI traffic by roughly calculating the volume of NDI communication, then make sure there is 
enough latitude in the line speed. 
When multiple references are made to a single NDI source, there is an expansion in NDI signal volume on the transmission 
side corresponding to the number of references. 
Investigate the use of multicasting if it appears to be required by the system design.

Before use
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 Handle carefully.
	� Do not drop the product, or subject it to strong shock or 

vibration.  
Do not carry or move the product by the fader lever. This is 
important to prevent malfunctioning or accidents.

 �Use the product in an ambient 
temperature of 0 °C to 40 °C (32 °F to 
104 °F).

	� Avoid using the product at a cold place below 0 °C (32 °F) 
or at a hot place above 40 °C (104 °F) because extremely 
low or high temperature will adversely affect the parts 
inside.

 �Power off before connecting or 
disconnecting cables.

	� Before plugging or unplugging the cables, be sure to 
switch power off.

 �Avoid humidity and dust.
	� Avoid using the product at a humid, dusty place because 

much humidity and dust will cause damage to the parts 
inside.

 �Maintenance
	� Turn off the unit’s power and wipe the product using a dry 

cloth. To remove stubborn dirt, dip a cloth into a diluted 
solution of kitchen detergent (neutral), wring it out well, and 
wipe the product gently. Then, after wiping the product with 
a moist cloth, wipe it again with a dry cloth.

•	�Avoid using benzine, paint thinners and other volatile 
fluids.

•	�If a chemical cleaning cloth is to be used, carefully 
read through the precautions for its use.

Caution

 �Precaution to be observed during 
production

	� This product’s image switching and image effect functions 
can be used to produce images which flicker rapidly or 
images which change rapidly.

	� However, bear in mind when using these functions in 
production that the kinds of images produced may have an 
adverse effect on the viewer’s physical well-being.

 When the product is to be discarded
	� When the product is to be discarded at the end of its 

service life, ask a specialized contractor to dispose of it 
properly in order to protect the environment.

 Concerning the consumable parts
Cooling fan:
	� This is a consumable part. 
	� As a general rule, replace it every 5 years or so (when 

the unit has been operated for 15 hours a day).
AC Adaptor:
	� This is a consumable part. 
	� As a general rule, replace it every 5 years or so (when 

the unit has been operated for 15 hours a day).

The period when the consumable parts need to be 
replaced will differ depending on the operating conditions.
When the time comes to replace one of these parts, be 
absolutely sure to ask your dealer to do the job.

Precautions for use
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	q In addition to heeding the points presented in the “Read this first!”, observe the 
following precautions as well.

Be absolutely sure to ask your dealer to do the jobs of installing and connecting the unit.

Connecting the power supply
	p Be absolutely sure to use only the AC 
Cable and AC Adaptor supplied with the 
unit.

	p Be absolutely sure to connect the ground 
terminal (SIGNAL GND) at the rear of the 
unit to the system ground.

	p Push the AC Adaptor in fully all the way.
	p When the unit is not going to be used for a prolonged 
period of time, turn off its power, and disconnect the power 
plug from the AC outlet.

Handle carefully!
	p Dropping the unit or subjecting it to strong impact or 
vibration may cause trouble and/or malfunctioning.

Do not allow any foreign objects to enter inside the 
unit!

	p Allowing water, metal items, scraps of food or other foreign 
objects inside the unit may cause a fire and/or electric 
shocks.

Choosing the best installation location
	p This unit is designed for indoor use only.
	p Install the unit on a sufficiently strong, stable and level 
surface for use.

	p Ensure a space of at least 100 mm (3-15/16 inches) around 
the unit’s vents to avoid obstructing ventilation.  
In particular, ensure sufficient space between ventilation 
and wiring when using mounted in a panel or table.

	p Do not install the unit in a manner in which its cables and 
other accessories can be easily damaged.

	p Do not install the unit in a cold place where the 
temperatures will drop below 0 °C (32 °F) or in a hot place 
where the temperatures will rise above 40 °C (104 °F).

	p Avoid installing the unit where it will be exposed to direct 
sunlight or to the hot air that is blown out from other 
products.

	p Installing the unit in a very humid, dusty or vibration-prone 
location may give rise to trouble.

Vent inlet

Vent outletVent inlet

Installation precautions
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Compact design, abundant inputs and outputs
	p �Despite its compact size, it comes with four SDI inputs, two 
HDMI inputs, two SDI outputs and one HDMI output.  
Furthermore, it is capable of handling a variety of live 
switching situations, being equipped with IP inputs and 
outputs, reference input, through output, 2-channel analog 
audio input and output, and UVC output.

	p Along with the background transitions using cuts, mixes, 
and wipes, the unit is also equipped with two keyers 
including one channel for chroma keys and two channels of 
PinP.

	p The multi view display function enables a single monitor to 
be divided so that it can display a maximum of 16 videos.

	p Input/output accommodates 3G/HD-SDI, and each input is 
equipped with a frame synchronizer (FS).

	p It supports many IP input and output systems, including 
NDI, NDI|HX, SRT, and RTMP.

	p The 2-channel analog audio input connectors enable 
embedding of audio via any of the output buses.  
You can also make adjustments to the input level and audio 
delay.

Supports multiple formats
	p The following signal formats are supported:

2K formats:
1080 × 59.94p, 1080 × 50p, 1080 × 29.97p, 1080 × 25p, 
1080 × 24p, 1080 × 23.98p, 1080 × 59.94i, 1080 × 50i

HD formats:
720×59.94p, 720×50p

	p Supports multiple 2K/HD formats.
	p Compatible with a variety of interfaces, such as 3G-SDI, 
1.5G-SDI, HDMI and IP.

	p The maximum number of inputs is four for SDI, two for 
HDMI, and four for IP.

	p The maximum number of outputs is two for SDI, one for 
HDMI, and two for IP.

	p Equipped with two keyers to enable an abundance of video 
effects.

	p Equipped with features such as up/down converters.
	p Equipped with two AUX BUS. Has a MIX transition function.
	p Fitted with a remote camera controller function that is able 
to control tally of a maximum of nine Panasonic 4K/HD 
integrated cameras.

	p Chroma key is possible.
	p Video memory (two for still images) can be recorded and 
called up with key signals attached.

	p Equipped with a shot memory function.
	p Compatible with USB memory.

Features
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Check that the following accessories are present and accounted for.
	p After removing the product from its container, dispose of the power cable cap (if supplied) and packing materials in an 
appropriate manner.

	p This unit is supplied with a cable clamp that prevents the AC Adaptor from unplugging accidentally.

AC Adaptor..................................1
Cable clamp................................1

AC Cable for AV-HSW10P...........1

AC Cable for AV-HSW10E...........3
	p For U.K. and Saudi Arabia 	p For Continental Europe, etc. 	p For India only

	p This product is equipped with 3 types of AC mains cable. 
Appropriate mains cable must be used in each local area, since the other type of mains cable is not suitable.

Accessories
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Attaching the cable clamp

DC IN 16V

Detaching the cable clamp

1	 Pinch 1 and pull in the direction of 2.

DC IN 16V







Securing the AC Adaptor

1	 Unlock the cable clamp.

DC IN 16V

2	 Insert the AC Adaptor.

DC IN 16V

3	 Lock the cable of the AC Adaptor with the cable 
clamp.

DC IN 16V

Accessories



18

Parts and their functions

Control panel

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

3

1

2

4 5C6 7 ? 8 9

:

;

<

=

A

B

D

E

@ >

1	POWER indicator [POWER]
This indicator lights when the POWER switch (F) on the 
rear panel is set to ON while power is supplied to the DC 
IN connector (U).

2	ALARM indicator [ALARM]
This indicator lights when the cooling fan (T) has stopped 
running, when there is a problem with the power supply 
(voltage drop) or when the temperature inside the unit has 
reached an abnormally high level.
When this occurs, an alarm message appears on the OSD 
menu while the OSD menu is displayed on an external 
monitor (in the OSD ON status).
The alarm information can be output to an external device 
from the unit’s TALLY/GPI connector (N).
 Refer to “Alarm message”.
When an alarm has occurred, stop using the unit 
immediately, and be absolutely sure to contact your dealer. 
Continuing to use the unit even after an alarm has 
occurred could damage the unit. 

3	STREAM button [STREAM]
Transmissions can be directly started, stopped, and 
set to standby from this unit with SRT/RTMP. The 
color of the LED illumination changes to indicate the 
status of transmissions. (OFF: Off (*1), Standby: Green, 
Transmitting: Red)
This unit is equipped with two transmission channels (CH1 
and CH2), and operations for CH2 can be performed while 
pressing the [SHIFT] button (6).

Button  
operation

Transmission  
channel: LED

Press Hold down

OFF: Off (*1) Transmitting: Red Standby: Green

Standby: Green Transmitting: Red OFF: Off (*1)

Transmitting: Red Standby: Green OFF: Off (*1)

*1  �Lights in the colors set in Color Group in [12] Config > 
Button Illumination > Color Group Other > STREAM.

4	USER buttons [USER 1, USER 2, USER 3]
Any six functions selected from among the menu items can 
be assigned to the [USER 1] button, [USER 2] button and 
[USER 3] button, and then used.
The functions registered in [USER 1] and [USER 4] are 
assigned to the [USER 1] button whereas the functions 
registered in [USER 2] and [USER 5] are assigned to the 
[USER 2] button, and the functions registered in [USER 3] 
and [USER 6] are assigned to the [USER 3] button.
While the SHIFT button (6) is held down, the function 
registered in [USER 4], [USER 5] or [USER 6] can be 
selected.
Lights The functions assigned to the [USER] 

buttons are enabled.
Extinguished The functions assigned to the [USER] 

buttons are disabled.
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5	Shot Memory button [SHOT MEM]
This button enables registration, recalling, and deleting of 
shot memories.
 Refer to “Shot memories”.

6	SHIFT button [SHIFT]
This button is used to call up the functions of [USER 4], 
[USER 5], and [USER 6] that have been assigned to the 
[USER 1] button, [USER 2] button, and the [USER 3] 
button, and also to call up the XPT7 to XPT12 materials 
assigned to crosspoint buttons [1] to [6], and for Shot 
Memory operations.
Lights The [SHIFT] button is enabled.
Extinguished The [SHIFT] button is disabled.

(The functions executed using the [SHIFT] button take 
effect only while the button is held down.)

7	OSD/TIME dial
The following operations are performed using this dial.

	p When the main menu is displayed:
Turn the OSD/TIME dial to select a submenu, and press 
the dial to enter the selection.
	p When a submenu is displayed:
Turn the OSD/TIME dial to select a submenu, and press 
the dial to enter the selection.
When entering setting values, the setting values change 
when you first press the dial and then turn it, then the 
setting values are confirmed when you press the dial 
again.
Hold down the dial to return a setting value to the default 
value.
	p When the dial is turned while it is still held down after the 
[KEY1 ON], [KEY2 ON], [FTB ON] or [AUTO] button has 
been held down, the respective transition duration can 
be changed.

8	EXIT button [EXIT]
This button takes you up one submenu layer when you are 
using the OSD menus.

9	MENU button [MENU]
This selects whether the OSD menu is to be displayed or 
hidden.
Each time you hold down the [MENU] button, the menu is 
either displayed or hidden.
Orange light OSD menu displayed
Off OSD menu hidden

When the [MENU] button is pressed while the OSD menu 
is being displayed, the display switches between the main 
menu and the status display.
You can view the following information in the status 
display:

	p Wipe pattern settings
	p Transition time settings
	p [USER] button settings
	p Crosspoint assignment settings

:	FTB ON button [FTB ON]
Press this button to fade out the program image to a black 
screen for the transition duration which has been set.
When the button is pressed again, the program image is 
faded in from the black screen.

Press the button. Blinks

Now fading out.

Now fading in.

Lights

The button indicator 
goes off.
Program image

Lights
Fade-out is now 
completed.

Press the button.

An image other than the black screen can be set as the 
screen to which the program image is to be faded out.
 Refer to “FTB (Fade to Black)”.
By turning the OSD/TIME dial (7) while keeping the 
[FTB ON] button pressed after the button has been held 
down, the transition duration can be changed.

;	KEY 1 ON button, KEY 2 ON button 
	 [KEY 1 ON, KEY 2 ON]

This is used to combine key materials for the transition 
duration which has been set.

Press the button.
Blinks

Image combining is now 
underway.

Image combining is now 
disabled.

Lights

The button indicator 
goes off.
Images can no longer 
be combined.

Lights
Image combining is now 
completed.

Press the button.

By turning the OSD/TIME dial (7) while keeping the [KEY 
1 ON] button or [KEY 2 ON] button pressed after the 
button has been held down, the transition duration can be 
changed.

<	CUT button [BKGD CUT]
This instantly initiates a transition for the currently selected 
operation.
Lights The transition is being executed.
Extinguished The transition is complete.

Parts and their functions
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=	AUTO button [BKGD AUTO]
This automatically initiates the transition for the transition 
duration which has been set (Auto transition).
Lights Auto transition is being executed.
Extinguished Auto transition is complete.

If the [AUTO] button is pressed while auto transition is 
being executed, the auto transition operation is aborted.
When the button is pressed again after the operation was 
aborted, the remaining transition is executed.
When the [AUTO] button is pressed while the fader lever 
(>) is at an interim setting, the transition is executed in the 
time remaining from the interim setting.
By turning the OSD/TIME dial (7) while keeping the 
[AUTO] button pressed after the button has been held 
down, the transition duration can be changed.

>	Fader lever
This is used when executing transitions manually.
When the fader lever is moved to the end, the transition is 
completed.
If the fader lever is moved during auto transition, the 
operation switches to manual at the point where the fader 
lever position overtakes the current amount of transition.
It is possible to select a background or key using a menu 
for materials involving transitions.

?	MIX/WIPE switching button [MIX, WIPE]
This button selects the transition method.
MIX and WIPE switch each time you press the button.
MIX This is used to execute transitions (MIX 

transitions) while overlapping the images of the 
A bus and B bus (or images of the PGM bus and 
PST bus).
While a transition is being executed, the total of 
the A bus and B bus (or PGM bus and PST bus) 
outputs is held at 100 %.
The [MIX] indicator to the left lights orange while 
MIX is selected.

WIPE The transition is made according to the selected 
wipe pattern.
The [WIPE] indicator to the left lights orange 
while WIPE is selected.

@	Bus tally indicators [A, B]
The indicator corresponding to the bus whose program 
(PGM) materials are being output lights.

A	AUX bus selector buttons
	 [AUX BUS DELEGATION]

Select the bus to be operated using the AUX bus 
crosspoint buttons (B). 
The selected button lights.

[KEY 1], [KEY 2]:
This button is used to change the AUX bus crosspoint 
buttons (B) into the source selector buttons for the key fill 
buses or key source buses.
Each time it is pressed, the selector button function is 
switched between the key fill buses and key source buses.
Orange light Key fill buses
Green light Key source buses

[AUX 1], [AUX 2]:
These buttons are used to change the AUX bus crosspoint 
buttons (B) into the selector buttons for the sources of the 
AUX buses.

B	AUX bus crosspoint buttons
These buttons are used to select the source of the bus 
which was selected by the AUX bus selector button (A).
Buttons 1 to 12 can be selected using the [SHIFT] button 
(6). When the crosspoint buttons (B, D, E) are held 
down, the OSD shows the name of the input material and 
the crosspoint button number.

C	�Dedicated crosspoint buttons for the AUX bus 
[AUX SOURCE]
While the [AUX 1], [AUX 2] AUX bus selector buttons (A) 
are illuminated, these select AUX bus sources.
The buttons that are pressed turn amber.

[MV]:
Selects either multi view display signal for the AUX bus.

[PGM/PVW]:
Selects either the PGM signal or the PVW signal for the 
AUX bus.
Switching between the PGM signal and the PVW signal is 
done with the [SHIFT] button (6).

D	PGM bus crosspoint buttons [1 to 6]
These are used to select the PGM/A bus video signals. 
Buttons 1 to 12 can be selected using the [SHIFT] button 
(6).
Bus Mode can be selected as “A/B”, “PGM-A/PST-B”, or 
“PGM-B/PST-A” in the Config menu.
 Refer to “Background transition”.
When the crosspoint buttons (B, D, E) are held down, 
the OSD shows the name of the input material and the 
crosspoint button number.

E	PST bus crosspoint buttons [1 to 6]
These are used to select the PGM/B bus video signals. 
Buttons 1 to 12 can be selected using the [SHIFT] button 
(6).
Bus Mode can be selected as “A/B”, “PGM-A/PST-B”, or 
“PGM-B/PST-A” in the Config menu.
 Refer to “Background transition”.
When the crosspoint buttons (B, D, E) are held down, 
the OSD shows the name of the input material and the 
crosspoint button number.

Parts and their functions
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F	Power switch [POWER]
When the [POWER] switch is turned on, the [POWER] 
indicator (1) lights up, and the unit can be operated.

G	SDI IN connectors [SDI IN 1 to 4]
These are the HD SDI signal input connectors.

	p SDI IN 1 and HDMI IN 1 are mutually exclusive. Select 
one of them from the Input menu.
	p There are advanced up-converter/down-converter 
settings available for SDI IN 3 and 4.

H	SDI OUT connectors [SDI OUT 1, 2]
These are the HD SDI signal output connectors. The 
following signals can be assigned to the connector by 
menu operations:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

OSD menus are not displayed from the SDI OUT 1 
connector.

I	HDMI IN connectors [HDMI IN 1, 2]
These are HDMI signal input connectors. They support 
HDMI 1.4b. This unit does not support HDCP.
Signals with the following resolutions can be input with 
menu operations.
Resolution (Vertical frequency: 60Hz):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024), 
WXGA (1280 × 768), XGA (1024 × 768)
Resolution:
1920 × 1080/59.94p, 1920 × 1080/50p, 
1920 × 1080/29.97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23.98p, 1920 × 1080/59.94i, 1920 × 1080/50i, 
1280 × 720/59.94p, 1280 × 720/50p

	p The HDMI IN connector supports the scaler function.

J	HDMI OUT connector [HDMI OUT]
This is the HDMI signal output connector. The following 
signals can be assigned to the connector by menu 
operations:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

It is possible to output with the same resolution as the 
system format of this unit.

Signals with the following resolutions can be output with 
menu operations.
The output resolution can be fixed to 1080/720.
Resolution (Vertical frequency: 60Hz):
WSXGA+ (1600 × 1050), SXGA (1280 × 1024),  
WXGA (1280 × 768), XGA (1024 × 768)
Resolution:
1920 × 1080/59.94p, 1920 × 1080/50p, 
1920 × 1080/29.97p, 1920 × 1080/25p, 1920 × 1080/24p, 
1920 × 1080/23.98p, 1920 × 1080/59.94i, 1920 × 1080/50i, 
1280 × 720/59.94p, 1280 × 720/50p

K	Reference input connector [REF]
Loop-through output in the external sync mode.
If the loop-through output is not going to be used, provide 
a 75-ohm termination.

L	Audio input connector [AUDIO IN]
These are the connectors for inputting external audio 
(microphone/line).
They support two channels, left and right.

M	USB connector (*1) (Type C connector) 
	 [USB STREAM OUT]

You can load video and audio output from this unit onto a 
computer by connecting them via USB Video Class.
The following signals can be assigned to the connector by 
menu operations:
PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

*1  �USB 3.2 Gen1 DEVICE, no USB bus power 
functionality

Rear panel area

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

Q F

R P O N M J

L K H G

I

Parts and their functions
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N	TALLY/GPI connector  
	 [TALLY/GPI] (D-sub 15-pin, female, inch screw)

The unit is equipped with 5 contact input ports to control 
this unit from external devices and 8 open collector output 
ports for outputting tally information and alarm information 
from this unit.

O	LAN connector [LAN] (RJ-45) (1000Base-T)
This is a LAN connector (RJ-45) used for connecting an 
external device to this unit for the purpose of IP control.
Furthermore, IP signals are also sent end received by this 
connector.
Use a LAN cable (*1) for connection.

*1  �Category 5e or better, STP (Shielded Twisted Pair), 
max. 100 m (328 ft)

P	SERVICE switch [BOOT SV/NM]
This switch is used for maintenance purposes.
For normal operations, select the [NM] position.

Q	Ground connector [SIGNAL GND]
Connect to the system’s earth ground.

R	Security slot
You can connect a security cable manufactured by 
Kensington.
Refer to the operating instructions supplied with the cable 
for connection instructions.
The security slot and security cable are for the prevention 
of theft. Panasonic accepts no responsibility for any 
damage incurred if an incidence of theft occurs.

Right panel area

USB

S T

S	USB connector (*2) (Type A connector) [USB]
Project files can be loaded and saved by connecting this 
unit and a USB memory.
Furthermore, you can also load and save Still data, save 
log files, and load firmware.

*2  USB2.0 DEVICE, has USB bus power functionality

T	Cooling fan
Blocking the vents of the cooling fan may cause a 
malfunction.
Leave sufficient space in the vicinity of the vents.

Parts and their functions



23

Front panel area

LEVEL

W X

W	�Headphone connector [  ]  
(Φ3.5 mm, stereo mini jack)
Audio output can be monitored by connecting headphones 
to the unit.
PGM, PVW, AUX1, AUX2, or CLN can be selected with the 
setting menus on this unit.

X	Monitor volume dial [LEVEL]
This dial is used to adjust the volume of the monitoring 
headphones.

Parts and their functions

Left panel area

DC IN 16V

V U

U	�DC IN connector [DC IN 16 V ]  
(DC 16 V, 3.0 A)
The AC Adaptor provided with the unit is connected to this 
connector.

V	Hole for fitting the cable clamp
Attach the supplied cable clamp to secure the AC Adaptor. 
(page 17)
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Preparations

Turning the unit’s power on and off

Turning on the power

1	 Set the [POWER] switch to the ON position.
When power is supplied to the unit, the [POWER] 
indicator lights.

During start up of the unit, the PGM bus crosspoint 
buttons and PST bus crosspoint buttons light blue in 
order. When all of the buttons turn off, start up of the unit 
is complete.

Turning off the power

1	 Set the [POWER] switch to the OFF position.
The unit’s power is turned off, and the [POWER] indicator 
goes off.

Checking the video output

Described below are the steps taken to display the unit’s OSD menu on an external monitor to check the unit’s video output.

Displaying the OSD menus on a HDMI 
monitor

1	 Connect the HDMI monitor to the unit’s 
HDMI OUT connector.

2	 Turn on the power of the HDMI monitor.

3	 Turn on the power of the unit.

4	 Hold down the [MENU] button.
The [MENU] button indicator lights, and the OSD menus 
are displayed on the HDMI monitor.
If the OSD menus do not appear on the monitor, refer to 
“How to forcibly display the OSD menus”.

If the OSD menu fails to appear on the HDMI monitor 
even after the above steps have been taken, it may mean 
that the HDMI monitor does not support the unit’s HDMI 
output format. 
Check the input specifications of the HDMI monitor.

Note

Displaying the OSD menus on an SDI monitor

1	 Connect the SDI monitor to the unit’s SDI OUT 2 
connector.

2	 Turn on the power of the SDI monitor.

3	 Turn on the power of the unit.

4	 Hold down the [MENU] button.
The [MENU] button indicator lights, and the OSD menus 
are displayed on the SDI monitor.
If the OSD menus do not appear on the monitor, refer to 
“How to forcibly display the OSD menus”.

	p The OSD menus cannot be output from the SDI OUT 1 
connector.

	p If the OSD menu fails to appear on the SDI monitor 
even after the above steps have been taken, it may 
mean that the video format which has been set in the 
unit is not the correct one. 
Take the steps in the next section to change the unit’s 
video format. 
 Refer to “Changing the video format”.

Notes
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Changing the video format

You can specify a video format while the power is off, and then start up the system.
If the OSD menus cannot be displayed even when the SDI monitor has been connected to the unit, the video format must be 
changed. 
Follow the steps below to change the video format.
If the OSD menus can be displayed using a PC monitor, change the video format by following the steps in “Setting the system 
format”.

1	 Turn off the power of the unit.

2	 	�Turn on the unit’s power while at the same time holding down the button that corresponds to the video 
format supported by the SDI monitor.

Button to press at the same time Video format
[MENU] + A bus crosspoint [1] 1080/59.94p

[MENU] + A bus crosspoint [2] 1080/50p

[MENU] + A bus crosspoint [3] 1080/59.94i

[MENU] + A bus crosspoint [4] 1080/50i

[MENU] + A bus crosspoint [5] 1080/29.97p

[MENU] + A bus crosspoint [6] 1080/25p

[MENU] + B bus crosspoint [1] 1080/24p

[MENU] + B bus crosspoint [2] 1080/23.98p

[MENU] + B bus crosspoint [3] 720/59.94p

[MENU] + B bus crosspoint [4] 720/50p

	p Continue pressing the button until start up of the unit is complete.

3	 	�Hold down the [MENU] button.
The [MENU] button indicator lights, and the OSD menus are displayed on the SDI monitor.

If the OSD menu fails to appear on the SDI monitor even after the above steps have been taken, it may mean that the SDI 
monitor does not support the unit’s SDI output format. 
Check the input specifications of the SDI monitor.

Note

Preparations
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OSD (on-screen display) menu operations

The unit’s settings are selected using the OSD menus which are displayed on the external monitor.
Described here is how to operate the OSD menus.

Displaying and clearing the OSD menus

Basic operations

When the [MENU] button is held down, the [MENU] button indicator lights, and the OSD menus are displayed on the external 
monitor.
When the [MENU] button is held down while an OSD menu is displayed, the [MENU] button indicator goes off, and the OSD 
menu display is cleared.

Changing the connector for outputting the OSD menus

The OSD menu output connector can be changed using the Operate > Menu Out item on the [12] Config.

SDI OUT2 The menus are output from the SDI OUT 2 connector.

HDMI OUT The menus are output from the HDMI OUT connector.

SDI2+HDMI The menus are output from both the SDI OUT 2 connector and HDMI OUT connector.

Furthermore, using the setting in the OUT6 (UVC OUT) > Menu Out item in [11] Output, the OSD menu output settings from the 
USB connector (USB STREAM OUT, Type C connector) can be changed.

On The OSD menus are output via the USB connector (Type C connector).

Off The OSD menus are not output via the USB connector (Type C connector).

The OSD menus cannot be output from the SDI OUT 1 connector.
Note

How to forcibly display the OSD menus

When the [MENU] button and [SHIFT] button are pressed at the same time while the unit is operating, the following is 
automatically set:

	p The SDI OUT 2 connector and HDMI OUT connector are set to output the OSD menus. Furthermore, output from the USB 
connector (Type C connector) is enabled.

	p The screen size of the OSD menus output from the HDMI OUT connector is set to “Auto”.

Preparations
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Menu configuration and moving between menus

Menu configuration of the unit

The OSD menus of this consist of “main menu” and “submenu” which have multiple layers.

Main menu:
This lists the submenu items.

Submenu:
Submenu items in lower layers are displayed.
This displays the setting items and the settings. 
The settings can be changed on this screen.

Moving between the main menu and submenus

Moving from the main menu to a submenu
To select a submenu item:

Turn the OSD/TIME dial to select an item.
Entering the setting selected for the submenu item:

Press the OSD/TIME dial to enter the selected item’s setting.

Moving from a submenu to a submenu in an upper layer or to the main menu
Press the [EXIT] button to return to a submenu in an upper layer or to the main menu.

 �Turn the OSD/TIME dial, and select the 
submenu item.

 �Press the OSD/TIME dial to enter the 
selected item’s setting.

 �Press the [EXIT] button.

Main menu

Submenu

“>” is displayed to the right of items that 
have submenus.

“>” is displayed to the right of items that have 
further submenus.

Settings
“▼” is displayed to the right of items that have 
values that can be changed.

Submenu items

Displaying menus consisting of more than one page

When a menu contains many setting items, they are displayed on more than one page.
In this manual, only one menu screen is shown even when that screen consists of more than one page.

Preparations
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Operations using the submenus

1	 Select the line with the setting item.
The highlighted cursor moves up and down when you turn the OSD/TIME dial.
When the cursor is on the line for the setting item you want to change, pressing the OSD/TIME dial makes it possible to 
change the setting value.
Furthermore, “>” is displayed to the right of the item if it has further submenus.
The submenus in the layer below are displayed when you press the OSD/TIME dial.

Turn the OSD/TIME dial, and select 
the item.

Press the OSD/TIME 
dial to enter the item.

Setting value can now be changed.

2	 	Change the setting.
There are the two followings ways to change the setting values:

	p Pull-down menu
While the cursor is on the line for the setting item you want to change, pressing the OSD/TIME dial displays a pull-down 
menu with the values that can be set.
Turn the OSD/TIME dial to move the cursor to the setting value, then press the OSD/TIME dial to update with that value.

	p Changing a numerical value
Press the OSD/TIME dial while on the line for the setting item you want to change so the setting can be changed.
Turn the OSD/TIME dial to change the setting.
The values change faster if you turn the dial faster.

Turn the OSD/TIME dial to change the 
setting that is now blinking.

[Returning the setting to its default value]
When the OSD/TIME dial is held down now, the value is returned to its default value.

When values are changed for the regular setting items, these changes are reflected straight away but, with some of the 
setting items (such as Format), the changes will not be reflected unless the OSD/TIME dial is pressed once the changes 
have been made.
The cursor blinks on this type of item.

Note

Preparations
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Entering character strings

Some setting items on this unit require you to enter character strings.

Press the OSD/TIME dial while on the line for the setting item you want to change so the character string can be entered.
A character string selection screen similar to a keyboard appears, and the yellow border indicates selection.
Turn the OSD/TIME dial to select a character, then press the OSD/TIME dial to enter the character.
Selecting the following changes the types of characters available.

[A-a] Switches between upper-case and lower-case characters

[BS] Deletes one character

[123#+=] Switches to numeral and symbol input

[!?~] Switches to symbol input

[   ] Space

[  ] Moves the cursor left

[  ] Moves the cursor right

[Enter] Confirms the character string and returns to the setting line

[Load TEXT] Opens the screen for loading character strings from a USB memory

Notes regarding [Load TEXT]

When you select [Load TEXT] you can load a text file (.txt) that was saved to the “HS\HSW10\TEXT” folder on the USB memory 
formatted by this unit, and use the content to set as a character string.
[Load TEXT] cannot be selected if a USB memory is not connected.

[Load TEXT] can be selected when a USB memory is connected.

Preparations
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After selecting [Load TEXT], select the text file you want to load from the displayed dialog.

There are the following restrictions on the text file:
	p A load error occurs if you include multi-byte characters, such as are found in Japanese.
	p You can load only up to the available input character string length.
	p Line feed characters are automatically deleted.

Indications used in this Operating Instructions

The operations for the setting items are indicated in this Operating Instructions as shown below.
Example: �When operating the “[1] WIPE > BKGD Transition > Direction” item.

[1] WIPE > 		
	 BKGD Transition > Direction	

Submenu  
Setting item

Preparations
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Menu delegation function

When the following buttons are pressed twice, the menu switches to the delegated menu.
(The menu delegation function)
The operation corresponding to the button pressed is also executed.

<List of menu delegation functions>
Button Menu selected

AUTO

[5] TIME
FTB
KEY 1 ON
KEY 2 ON
MIX/WIPE [1] WIPE

KEY 1 F/S • When PinP is “On”
[3] Key > PinP
• When PinP is “Off” and “Chroma” is selected as the Key Type
[4] ChromaKey
• When PinP is “Off” and other than “Chroma” is selected as the Key Type
[3] Key

KEY 2 F/S • When PinP is “On”
[3] Key > PinP
• When PinP is “Off” and other than “Chroma” is selected as the Key Type
[3] Key

USER 1

[12] Config > User Button

USER 2
USER 3
USER 4 (SHIFT + USER 1)

USER 5 (SHIFT + USER 2)

USER 6 (SHIFT + USER 3)

Bus status displays

When the [MENU] button is pressed again while the OSD menu is being displayed, the status screen is displayed.
Furthermore, when the A bus, B bus, or AUX bus crosspoint buttons are held down, the status screen is shown on the OSD 
menu.

AMB:F
GRN:S

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Preparations
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Basic operations

Background transition

Selecting the bus

Press one of the crosspoint buttons to select the material to 
be used for the background transition. 
Depending on the operating status, the button pressed will 
light in one of two colors.

Lighting in 
red

When the selected input signals are output to 
PGM.
(However, the indicator lights in amber during 
FTB operations.)

Lighting in 
green

When the selected input signals are not output 
to PGM.

PGM

PST

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

1 7 2 8 3 9 4 10 5 11 6 12

PGM PVW

		   Lighting in red
		   Lighting in green

	p When the crosspoint buttons are held down, the button 
numbers and the names of the input materials assigned to 
the buttons are displayed on the built-in display in the form 
of a list for as long as the crosspoint buttons remain held 
down.

Selecting the bus using the SHIFT function

The SHIFT function enables two materials to be allocated — 
the front material and the rear material — to one button, and 
the materials to be selected using the [SHIFT] button.
A total of 12 materials — front materials (1 to 6) and rear 
materials (7 to 12) — can be allocated to the three groups of 
12 crosspoint buttons whether these buttons are the PGM/A 
bus crosspoint buttons, PST/B bus crosspoint buttons or AUX 
bus crosspoint buttons.

All SHIFT is used to switch all the materials of the PGM/A bus 
crosspoint buttons, PST/B bus crosspoint buttons or AUX bus 
crosspoint buttons from front materials to rear materials or 
vice versa.

Rear materials are selected only while the [SHIFT] button is 
being pressed.

	p When the rear materials (7 to 12) have been selected, the 
[SHIFT] LED lights in amber.

Selecting the bus mode

Select A/B bus mode or a flip-flop system (PGM/PST system) 
in the setting menu.

Select the bus mode with the following menu operation:

[12] Config >
	 Operate > Bus Mode

A/B When the fader lever is at side A, the signals 
selected by the A bus are replaced PGM bus 
materials.
When the fader lever is at side B, the signals 
selected by the B bus are replaced PGM bus 
materials.

PGM-A/
PST-B

Using a flip-flop system, the signals selected 
by the A bus are always replaced PGM bus 
materials, and the signals selected by the  
B bus are always replaced PST bus materials.

PGM-B/
PST-A

Using a flip-flop system, the signals selected 
by the B bus are always replaced PGM bus 
materials, and the signals selected by the  
A bus are always replaced PST bus materials.

Selecting the transition mode

Select the transition mode using the [MIX] and [WIPE] 
buttons.

Switch the background transition mode with the [MIX/WIPE] 
switching button.
The LED of the selected mode lights.
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Manual transition

Operate the fader lever to execute transitions manually.
If the fader lever has been operated during auto transition, 
auto transition will be switched to manual operation as soon 
as the fader position overtakes the amount of the transition 
being executed.
The bus tally LEDs on the left of the fader lever indicate the 
program bus output status.

LED A only lights PGM/A bus output
LEDs A and B light During the transition
LED B only lights PST/B bus output

Select the transition target with the following menu operation:

[12] Config >
	 Operate > Fader

Any of the following targets for which the transition is to be 
executed can be set by operating the fader lever.

BKGD Background transition
KEY1 Key transition
BKGD+KEY1 Background transition and key transition will be 

executed concurrently.
NoAssign Transitions are not executed even when the 

fader lever is operated.

Auto transition

	p When the [AUTO] button is pressed, the transition is 
executed automatically using the transition time which has 
been set.

	p The transition is executed in the remaining time when the 
[AUTO] button is pressed while the fader lever is being 
operated.

Auto transition time settings are made with the following 
menu operation:

[5] Time >
	 BKGD

Select the display units with the following menu operation:

[12] Config >
	 Operate > Time Unit

Sec The time is displayed as a number of seconds.
Frame The time is displayed as a number of frames.

Any time from 0 to 999f can be set. The time which can be set 
when seconds are used as the display unit differs depending 
on the system format.

59.94i max. 33s09f 29.97p max. 33s09f
50i max. 39s24f 25p max. 39s24f
59.94p max. 16s39f 24p max. 41s15f
50p max. 19s49f 23.98p max. 41s15f

	p Even when the “KEY1”, “BKGD+KEY1” or “NoAssign” 
has been selected as the setting of the fader lever 
function, the background always serves as the target for 
executing auto transitions.

Cut transition

When the [CUT] button is pressed, the transition is executed 
instantly.

	p Even when the “KEY1”, “BKGD+KEY1” or “NoAssign” has 
been selected as the setting of the fader lever function, the 
background always serves as the target for executing cut 
transitions.

Basic operations
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Basic operations

Wipe

Selecting the wipe pattern

Select the wipe pattern with the following menu operation:

[1] WIPE >
	 BKGD Pattern

<Table of wipe patterns>
Wipe patterns and numbers

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

Selecting the wipe direction

Select the wipe direction for background transitions with the 
following menu operation:

[1] WIPE >
	 BKGD Transition > Direction

(The key transitions are set by the menu. The direction which 
is set here will not be reflected.)
 See “Key transitions”.

A

N

B

B

A

B

A

B

A

B

R

A

A B

A

N/R

B

A B

When [Normal] is selected:
	� Wiping proceeds in the normal direction.
When [Reverse] is selected:
	 Wiping proceeds in the reverse direction.
When [N/R] is selected:
	� The normal direction is replaced with the reverse direction 

(or vice versa) when the transition is completed. 

Wipe decorations (border, soft effect)

A border effect or soft effect can be added to the wiping of 
background transitions.

Setting the border and soft effect

1	Select border On/Off with the following menu operation:

[1] WIPE >
	 BKGD Transition > Border > Border

2	Set the border width with the following menu operation:

[1] WIPE >
	 BKGD Transition > Border > Width

3	Set the amount of soft effect with the following menu 
operation:

[1] WIPE >
	 BKGD Transition > Border > Soft

When “On” has been selected as the Border item setting, the 
ratio of the soft effect to the border width is indicated as the 
amount of soft effect. 
When only the soft effect is to be added to wipe, select “Off” 
as the Border item setting.

Setting the border color

Adjust Hue, Sat, and Lum of the border color with the 
following menu operation:

[1] WIPE >
	 BKGD Transition > Border Color > Hue

[1] WIPE >
	 BKGD Transition > Border Color > Sat

[1] WIPE >
	 BKGD Transition > Border Color > Lum
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 To call the preset color
Select the preset color with the following menu operation and 
press the OSD/TIME dial:

[1] WIPE >
	 BKGD Transition > Border Color > Load

	p When OSD/TIME dial is pressed, what has been set so far 
is canceled and replaced with the preset color values.

	p To save the values that were set before calling the preset 
color, refer to “Shot memories”.

Setting the wipe start position

Wipe start can be set at any desired position.

Target patterns:
9, 10, 11, 12, 13

1	Set the wipe start position with the following menu 
operation:

[1] WIPE > 
	 BKGD Transition > Position > X-Position

[1] WIPE > 
	 BKGD Transition > Position > Y-Position

[1] WIPE > 
	 Key1 Transition > Position > X-Position

[1] WIPE > 
	 Key1 Transition > Position > Y-Position

This setting is possible only if the target pattern has been 
selected for the background or key pattern.

2	Either operate the fader lever or press the [AUTO] button 
to check the wipe operation.  
(When, for instance, –50 has been set for X-Position and 
–50 for Y-Position, the following screen (or key) appears 
from the bottom left and wipe is performed while the 
screen (or key) moves to the screen center.)

<X-Position, Y-Position setting range>

Y-Position

X-Position

		   Inside screen area
		   Outside screen area

Basic operations
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Basic operations

Key
This operation combines the background image with another 
image. 
The key definition can be adjusted, and an edge can be 
added to the combined image.

Key1 and Key2 are available as materials to compose the 
background images.
The default settings for priority (image positioning) are as 
shown in the figure below.

<Priority default settings>

Key1

Key2

Background image

You can change the prioritization for Key1 and Key2.
 Refer to “Setting the priority”.

How key combinations work is shown in the figure below.

<How key composition works>

HSW10

HSW10

Background

Key source

Key fill

Output image 
Invert

Selecting the key type
1	Select the target key (Key1/Key2) with the following menu 

operation:

[3] Key >
	 Key Select

2	Select the key type with the following menu operation:

[3] Key >
	 Key Type

Lum(ChromaOff)
(luminance key·
Chroma off/
self key)

This is for creating the key signals from the 
luminance component of the key source 
signal. 

Lum(ChromaOn)
(luminance key·
Chroma off/
self key)

This is for creating the key signals from 
the luminance component or chroma 
component of the key fill signal.

Linear
(linear key/EXT 
key)

This is for creating the key signals from the 
luminance component of the key source 
signal. 
It is used when the key source signal and 
key fill signal are different.

Chroma
(chroma key/self 
key)

This is for creating the key signals using 
a specific hue of the key fill signal as the 
reference.

Full
(full key/self key)

This is for creating the key signals using 
the images on the full screen as the key 
source signals.

Since the luminance and chroma keys are operated as 
self keys, the key fill signals are used as the key source 
signals. For the full key, the images on the full screen are 
used as the key source signals. 
When the luminance key, chroma key or full key has 
been selected as the key type, the key signals will 
remain unchanged even when the key source signals are 
switched.
When using the linear key, use material with a black 
background and white characters or shape to be combined 
by the key as the key source signal. 
Material which is not black and white may not be combined 
clearly.
Material with a white background and black characters, 
etc. can be reversed using the key invert function for use.
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Basic operations
3	When the luminance key has been selected, the chroma 

component can be included in the generation of the key 
signals in view of the self key application. (This does not 
apply to the linear key.) 
Select Lum (Chroma On) or Lum (Chroma Off) for the key 
type.

Chroma On In addition to the luminance component, the 
chroma component is also taken into account in 
the generation of the key signals.
This is the setting for using a color with a low 
luminance component for the key signals (such 
as when defining blue characters).

Chroma Off The key signals are generated from only the 
luminance component.

4	Select the fill type with the following menu operation:

[3] Key >
	 Fill

Bus The bus signal is used for the key fill signal.
Matte The internal fill matte is used for the key fill 

signal.

Selecting the key material

Selecting the key fill and key source signals

Press the [KEY] button in the AUX bus selection area, and 
switch the selection of the key fill signal (indicator lights in 
amber) and key source signal (indicator lights in green).

<Selecting the key fill signal>
With the indicator of the [KEY] button lit in amber, press one 
of the AUX bus crosspoint buttons 1 to 6 to select the key fill 
signal.
The indicator of the selected AUX bus crosspoint button lights 
in amber. (It will light in red if the selected signal is being 
output from the PGM connector.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

		   Lighting in amber

<Selecting the key source signal>
With the indicator of the [KEY] button lit in green, press one 
of the AUX bus crosspoint buttons 1 to 6 to select the key 
source signal.
The indicator of the selected AUX bus crosspoint button lights 
in green. (It will light in red if the selected signal is being 
output from the PGM connector.)
Since the luminance and chroma keys are operated as self 
keys, the key fill signals are used as the key source signals. 
When the luminance key or chroma key has been selected 
as the key type, the key signals will remain unchanged even 
when the key source signals are switched.

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

		   Lighting in green
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Linking the key fill signal and key source signal 
selection

1	Select the target key (Key1/Key2) with the following menu 
operation:

[3] Key >
	 Key Select

2	Set Key Signal Coupling with the following menu operation:

[3] Key >
	 Key Signal Coupling

3	Set Fill/Source with the following menu operation:

[12] Config >
	  Key Source Signal Coupling > Fill/Source

	p If Fill/Source is Fill to Source, select what to use as the 
Source for the Fill.
	p Alternatively, if it is Source to Fill, select what to use as 
the Fill for the selected Source.

<Key Signal Coupling>
When the [KEY] button lights in amber, the key fill signal can 
be selected, and when it lights in green, the key source signal 
can be selected.

Key Signal Coupling

Independent If Fill to Source, you can independently set a 
Source that is linked to Fill and separate from 
other KEYs.
If Source to Fill, you can independently set a Fill 
that is linked to Source and separate from other 
KEYs.

Coupling Follows the settings of items other than Fill/
Source within Key Source Signal Coupling.

<Fill To Source>
When the key fill signal is selected, the key source signal also 
switches automatically.

<Source To Fill>
When the key source signal is selected, the key fill signal 
switches automatically.

Setting the fill matte color

Adjust Hue, Sat, and Lum of the fill matte with the following 
menu operation:

[3] Key >
	 Fill Matte > Hue

[3] Key >
	 Fill Matte > Sat

[3] Key >
	 Fill Matte > Lum

■ To call the preset color
Select the preset color with the following menu operation and 
press the OSD/TIME dial:

[3] Key >
	 Fill Matte > Load

	p When OSD/TIME dial is pressed, what has been set so far 
is canceled and replaced with the preset color values.

	p To save the values that were set before calling the preset 
color, refer to “Shot memories”.

Basic operations
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Key transitions
1	Select the transition mode with the following menu 

operation:

[12] Config >
	 Operate > Fader

You can set the target for transitioning when you operate 
the fader lever from the following:

BKGD Background transition
KEY1 Key transition
BKGD+KEY1 Background transition and key transition at 

the same time
NoAssign No transition when the fader lever is operated

2	Select the transition type (MIX/WIPE) with the following 
menu operation:

[3] WIPE > 
	 Key1 Transition > Type

If you select WIPE, select the wipe pattern with the 
following menu operation:

[1] WIPE >
	 Key1 Pattern

<Table of wipe patterns>
Wipe patterns and numbers

1 2 3 4 5

6 7 8 9 10

11 12 13 14 15

16

3	Set the transition time with the following menu operation:

[5] Time >
	 Key1

[5] Time >
	 Key2

Set the transition time the same as for background 
transition.

4	Set the wipe direction with the following menu operation:

[3] WIPE >
	 Key1 Transition > Keyout Pattern

Normal The key out pattern moves in the same direction 
as the key in pattern.

Reverse The key out pattern moves in the opposite 
direction from the key in pattern.

<Pattern examples>

Pattern example 1 Pattern example 2
Wipe patterns 9 to 16

Key in

Key out 
(Normal)

Key out 
(Reverse)

: This indicates the areas where keys are combined.

	p Wipe patterns 9 to 16 behave like pattern example 2.

5	Execute the transition. 
Use the fader lever to execute the transition manually.

Key auto transition

When the [KEY ON] button in the transition area is pressed, 
the transition is automatically executed at the transition time 
that has been set.
During key in, the indicator of the [KEY ON] button blinks in 
red, and it lights in red when the transition is completed.
If the [KEY ON] button is pressed with the picture completely 
keyed in, the Key image transition (key out) is executed.
During key out, the indicator of the [KEY ON] button lights in 
red, and it goes off when the transition is completed. 
If the [KEY ON] button is pressed during the transition, the 
transition direction is reversed.

Basic operations
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Key preview

Key preview images can be output to the preview output, and 
the keys can be adjusted and checked.

Set the preview with the following menu operation:

[3] Key >
	 PVW

Linking of Menus

PVW images
When PVW is OFF:

The PGM status is displayed in the PVW.
This is not reflected in the transition status, however.

When PVW is ON:
When PVW is set to “On”, the PGM images are displayed 
after the PVW.

Background of the PVW
The BKGD images for PVW will be PST irrespective of 
settings.

When you press the user button assigned On/Off, it switches 
alternately between On (button lights) and Off (button turns 
off).
(The relevant user button items are KEY1_PVW/KEY2_
PVW.)

Menu User button When the user button is pressed
On Lights Off: Extinguished

Off Extinguished On: Lights

Adjusting the luminance key and linear key

These steps are taken to adjust the luminance key and linear 
key definition.

1	Adjust the definition of the key with the following menu 
operation:

[3] Key >
	 Key Adjust > Clip

[3] Key >
	 Key Adjust > Gain

[3] Key >
	 Key Adjust > Density

2	Set the key invert with the following menu operation:

[3] Key >
	 Key Adjust > Invert

When “On” is selected, the key signals to be generated 
internally are inverted.

Parameter Description of setting Setting range
Clip Reference level for generating 

key signals
0.0 to 108.0

Gain Key amplitude 0.0 to 200.0

Density Key density 0.0 to 100.0

Invert Key signal inversion On, Off

Basic operations
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Basic operations

Adjusting the chroma key

How the chroma key is to be defined can be adjusted.

Before proceeding with the adjustments, select “Chroma” as 
the key type using the menu item below.

[3] Key >
	 Key Type

As the chroma key, a key signal is created using a specific 
hue as a reference. 
For instance, the key signal is created by detecting the color 
of the background from the image of a person standing in 
front of a specific background color, and another background 
is combined.

This unit uses an area system whose area is designated by 
a rectangular frame. The result of averaging the colors of the 
pixels inside that area is used as the chroma key reference 
color (key reference), and the maximum deviation from the 
average value is used as the radius of the chroma key oval.
Chroma keys faithful to the chroma space sample (area   
in the figure) can be generated.



Y

Hue
Sat Radius

Chroma

Hue Radius

Oval-shaped chroma key

Executing the sampling automatically

By specifying the area where the background is to be 
inserted, the chroma components are sampled.

■ Marker

[4] ChromaKey >
	 Marker

This item is used to set the sample marker to ON to display 
the marker on the PVW image.

■ Marker Pos

[4] ChromaKey >
	 Marker Position

This item is used to adjust the X coordinate, Y coordinate and 
size of the sample marker.

■ Sample

[4] ChromaKey >
	 Sample

Press the OSD/TIME dial to sample the hue components of 
the area selected by the sample marker.

	p When sampling is completed, the image obtained by 
combining the chroma key with the PVW image is output. 
(Set the PVW function of the key to ON.)
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Other chroma key settings

■ Marker Aspect

[4] ChromaKey >
	 Marker Aspect

This item is used to change the aspect ratio of the sample 
marker.

■ Ref Adjust

[4] ChromaKey >
	 Ref Adjust

This item makes it possible to change the color to be used as 
the chroma key reference from the sampled color.

Hue (Hue) Hue to be used as the reference
Sat (Saturation) Color saturation to be used as the 

reference
Lum (Luminance) Luminance to be used as the reference

	p After auto sampling is finished, the sampled values are 
displayed.

■ Y-Influence

[4] ChromaKey >
	 Y-Influence

This item is used to set the extent of the influence to be 
exerted by the Y (luminance) component. 
The higher the value set, the greater the influence, and with a 
“0” setting, the luminance component has no influence.

■ Radius

[4] ChromaKey >
	 Radius

This item is used to set the range of the color to be defined.

Hue (Hue-Radius) Extent of the range of the hue to 
be defined

Sat (Saturation-Radius) Extent of the range of the color 
saturation to be defined

	p After auto sampling is finished, the sampled values are 
displayed.

■ Soft

[4] ChromaKey >
	 Soft

This item is used to adjust the amount of the soft effect on the 
boundary of the color to be defined.

■ Cancel

[4] ChromaKey >
	 Cancel

This item is used to adjust the amount of color muting.
The color muting is adjusted when the background color is 
superimposed over the fill image.

Knack of adjusting the chroma key
The chroma key adjustments are facilitated by following 
the steps below.

1	��Initiate automatic sampling, and decide on the color 
to be defined.

2	��Using the “Radius” item, adjust so that the 
background color is completely defined.

3	�Using the “Soft” item, finely adjust the key signal 
boundary.

Note
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Key decorations

A border, shadow or other edge can be added to the key.

Setting the key edge

1	Select the type of edge with the following menu operation:

[3] Key >
	 Edge > Type

Off An edge is not added.
Border A border is added around the entire edge.
Drop A diagonal border is added.
Shadow A shadow is added.
Outline An outline (only a border with no fill) is added.

Border Drop

OutlineShadow

2	Select the width of the edge with the following menu 
operation:

[3] Key >
	 Edge > Width

3	Select the direction (in 45° units) for adding “Drop” and 
“Shadow” with the following menu operation:

[3] Key >
	 Edge > Direction

(Top)

(Bottom)

(Right)(Left)

225180 270

135 315

4590 0

4	Select density of the edge with the following menu 
operation:

[3] Key >
	 Edge > Density

Selecting the Edge Fill settings

Materials to be inserted as edges can be set.

Select the material of edge with the following menu operation:

[3] Key >
	 Edge > Fill

Color The color set using Edge Color is used.
CBGD1

The color background is used.CBGD2
Still1 The still image video memory (Still1) is used.
Still2 The still image video memory (Still2) is used.

Setting the edge color

Adjust Hue, Sat, and Lum of the edge color with the following 
menu operation:

[3] Key >
	  Edge > Color > Hue

[3] Key >
	  Edge > Color > Sat

[3] Key >
	  Edge > Color > Lum

■ To call the preset color
Select the preset color with the following menu operation and 
press the OSD/TIME dial:

[3] Key >
	  Edge > Color > Load

	p When OSD/TIME dial is pressed, what has been set so far 
is canceled and replaced with the preset color values.

	p To save the values that were set before calling the preset 
color, refer to “Shot memories”.
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Masking the key signals

These steps are taken to mask the key signals using the 
mask signal of the box pattern.

1	Set the mask mode with the following menu operation:

[3] Key >
	 Mask > Size

Off The key signals are not masked.
Manual The area that is set using the Mask Adjust sub 

menu is masked.
4:3 The signals are masked to the 4:3 aspect ratio.

2	Set whether to invert the mask signal with the following 
menu operation:

[3] Key >
	 Mask > Invert

On The mask signal is inverted.
Off The mask signal is not inverted.

3	Set the mask area with the following menu operation:

[3] Key >
	 Mask > Position > Left

[3] Key >
	 Mask > Position > Top

[3] Key >
	 Mask > Position > Bottom

[3] Key >
	 Mask > Position > Right

Parameter Description of setting Setting range/
Initial value

Left Key left position −50.00 to 50.00/
−25.00

Top Key top position −50.00 to 50.00/
25.00

Bottom Key bottom position −50.00 to 50.00/
−25.00

Right Key right position −50.00 to 50.00/
25.00

The Left setting cannot exceed the Right setting (and vice 
versa) and, similarly, the Top setting cannot exceed the 
Bottom setting (and vice versa).

<Key mask setting> (figure shows the default values)

0 

50 

-50 
500-50

TOP (25) 

BOTTOM (-25)

(25)
RIGHT

(-25)
LEFT  

Area masked

Area where the key signal is effective

Video signal range

Setting the priority

The relative positions of the images when Key1 and Key2 
images are to be superimposed onto one another can be set.

Set the relative positions of the 2nd item and the 1st item with 
the following menu operation:

[3] Key >
	 Key Priority > Key*

*	� Only the menu selected in [3] Key > Key Select is 
displayed.

1st Set the upper image.

2nd Set the lower image.

2nd:
 Key1

1st:
 Key2
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PinP (picture in picture)
Another image can be combined with the background image.
This unit supports PinP for 2 channels, Key1 and Key2.

Set enable (On)/disable (Off) for PinP with the following menu 
operation:

[3] Key >
	 PinP > PinP

Selecting the PinP channel and material

Press the [Key1] or [Key2] button among the AUX bus 
selector buttons.

The pressed button lights.
The state in which the PinP materials are selected is now 
established for the AUX bus crosspoint buttons.

The selected AUX bus crosspoint button lights in amber. 
(It will light in red if the selected signal is a PGM output 
signal.)

AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Selecting Shape

Square, Circle, Heart, Flower or Star can be selected as the 
shape used for combining PinP images.

	p This setting is enabled only when [Full Key] is [ON].

1	Select the shape when combining images with the 
following menu operation:

[3] Key >
	 PinP > Shape

2	Select the transmissivity (darkness) when combining 
images with the following menu operation:

[3] Key >
	 PinP > Density

Full Key On/Off

Set enable (On)/disable (Off) for Full Key with the following 
menu operation:

[3] Key >
	 PinP > Full Key

On Irrespective of the values set with [3] Key > Key 
Type, PinP images are composed with Full Key.

Off PinP images are composed according to the 
values set with [3] Key > Key Type.

PinP adjustments

Adjusting the PinP position and size

Set the X and Y coordinates and the size with the following 
menu operation:

[3] Key >
	 PinP > Position > X-Position

[3] Key >
	 PinP > Position > Y-Position

[3] Key >
	 PinP > Position > Size
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Linking Key1 PinP and Key2 PinP

The Key1 PinP and Key2 PinP images perform a symmetrical 
operation for the axis whose coordinates have been set. 
The image serving as the reference is the PinP image of the 
menu being operated.

Linking Key1 PinP and Key2 PinP

Select the position to be used for reference with the following 
menu operation:

[3] Key >
	 PinP > Sync > Symmetry

The image serving as the reference is the PinP image of the 
menu being operated.

When “X” has been selected as the Symmetry 
setting

The coordinates are made symmetrical to the X axis.

When “Y” has been selected as the Symmetry 
setting

The coordinates are made symmetrical to the Y axis.

When “Center” has been selected as the Symmetry 
setting

The coordinates are made symmetrical to the center.

When “Same” has been selected as the Symmetry 
setting
The coordinates are the same.

Copying the settings

Setting values can be copied with the following menu 
operation:

[3] Key >
	 PinP > Sync > Copy to Key

The Key1 PinP settings can be copied to Key2 PinP and, 
similarly, the Key2 PinP settings can be copied to Key1 PinP.

	p Source names not selected in [3] Key > Key Select are 
displayed.

The setting value for Key1 PinP (or Key2 PinP) is copied and 
set as the value for Key2 PinP (or Key1 PinP) when the OSD/
TIME dial is pressed with the following menu operation:

The following settings are not copied.
	p [3] Key > PinP > PinP
	p [3] Key > PinP > Shape
	p [3] Key > PinP > Density
	p [3] Key > PinP > Full Key
	p [3] Key > PinP > Trim > Trim
	p [3] Key > PinP > Trim > Pair
	p [3] Key > PinP > Trim > Preset

Note
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PinP decorations

A border or soft effect can be added to PinP.

1	Set border On/Off with the following menu operation:

[3] Key >
	 PinP > Border > Border

2	Set the border width with the following menu operation:

[3] Key >
	 PinP > Border > Width

3	Set the amount of soft effect with the following menu 
operation: 
The soft effect is OFF if 0.0 is set.

[3] Key >
	 PinP > Border > Soft

When “On” has been selected as the Border item setting, 
the ratio of the soft effect to the border width is indicated 
as the amount of soft effect. 
When only the soft effect is to be added to PinP, select 
“Off” as the Border item setting.

4	Set the border width variation with the following menu 
operation:

[3] Key >
	 PinP > Border > Mode

Fix The border width is kept constant.

Variable The border width changes to suit the PinP size.

Setting the border color

Adjust Hue, Sat, and Lum of the border color with the 
following menu operation:

[3] Key >
	 PinP > Border > Color > Hue

[3] Key >
	 PinP > Border > Color > Sat

[3] Key >
	 PinP > Border > Color > Lum

■ To call the preset color
Select the preset color with the following menu operation and 
press the OSD/TIME dial:

[3] Key >
	 PinP > Border > Color > Load

	p When OSD/TIME dial is pressed, what has been set so far 
is canceled and replaced with the preset color values.

	p To save the values that were set before calling the preset 
color, refer to “Shot memories”.

Trimming settings
1	Set trimming On/Off with the following menu operation:

[3] Key >
	 PinP > Trim > Trim

On Trimming is performed.
Off No trimming

2	Set the trimming type with the following menu operation:

[3] Key >
	 PinP > Trim > Preset

16:9 Automatic trimming so that the aspect ratio is 
16:9.

12:9 Automatic trimming so that the aspect ratio is 
12:9.

9:9 Automatic trimming so that the aspect ratio is 
9:9.

7:9 Automatic trimming so that the aspect ratio is 
7:9.

6:9 Automatic trimming so that the aspect ratio is 
6:9.

Manual Trimming using the value set on the Trim sub 
menu.

3	Set Pair On/Off with the following menu operation:

[3] Key >
	 PinP > Trim > Pair

On The settings are changed in such a way that the 
Left and Right trimming amounts and the Top 
and Bottom trimming amounts are the same. 
(This makes for a top-bottom and left-right 
symmetry.)

Off Pair settings not made.
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Key1 and Key2 can be linked.

The [KEY1 ON] button and the [KEY2 ON] button On/Off 
(button lights/button turns off) can be linked.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

Set On/Off for whether there is a link for each of the buttons 
with the following menu operation:

[3] Config >
	 Key1/2 Link

	p There is no linking if “Off” is selected.

Key Link

4	Set the trimming values with the following menu operation:

[3] Key >
	 PinP > Trim > Adjust > Left

[3] Key >
	 PinP > Trim > Adjust > Top

[3] Key >
	 PinP > Trim > Adjust > Bottom

[3] Key >
	 PinP > Trim > Adjust > Right

Parameter Description of setting Setting range/
Initial value

Left Trimming value at left −50.00 to 50.00/
−50.00

Top Trimming value at top −50.00 to 50.00/
50.00

Bottom Trimming value at 
bottom

−50.00 to 50.00/
−50.00

Right Trimming value at right −50.00 to 50.00/
50.00

<Trimming settings> (figure shows the default values)

0

60

-60
600-60

TOP (50)

BOTTOM (-50)

(-50)
LEFT

(50)
RIGHT

Area trimmed

Area where PinP is effective

Original size of PinP
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FTB (Fade to Black)
The user can fade out from a program image to the black 
screen/white screen/Still/color background screen or fade in 
to a program image from a black screen/white screen/Still/
color background.

1	Set the duration of the transition. 
Set the transition time the same as for each background 
transition with the following menu operation:

[5] Time >
	 FTB > Trans Time

 Refer to “Auto transition”.

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

2	The screen fades out to the setting screen at the set 
transition time when you press the [FTB ON] button in the 
transition area.
During fade-out, the indicator of the [FTB ON] button blinks 
in red, and it lights in red when the transition (fade-out) is 
completed, and the black screen is displayed.* 
When the [FTB ON] button is pressed with the black 
screen displayed, fade-in to the program image is initiated. 
During fade-in, the indicator of the [FTB ON] button lights 
in red, and it goes off when the transition (fade-in) is 
completed. 
If the [FTB ON] button is pressed at any point during a 
transition, the direction of the transition is reversed.

*: �In the FTB status, the crosspoint button which is 
normally lit in red lights in amber.

Selecting the image

The image to be used for fading out can be selected.

Select the image for fade-out with the following menu 
operation:

[5] Time >
	 FTB > Source

Still1 The still image video memory (Still1) is used.
Still2 The still image video memory (Still2) is used.
CBGD1

The color background is used.CBGD2
White White background
Black Black background

Muting audio

You can select whether to synchronize the fade-out of audio 
with the image fade-out.

Select whether to have audio fade-out with the following 
menu operation:

[5] Time >
	 FTB > Mute

Off No audio fade-out during image fade-out.
On Audio fade-out during image fade-out.
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Internal color signals

This unit supports two sets of internal color signals.

Setting the color background

The color background to be used by the bus can be set.
Two methods are available: under one method the Hue (hue), 
Sat (color saturation) and Lum (luminance) are set, and under 
the other the 8 preset colors (white, yellow, cyan, green, 
magenta, red, blue and black) are called. 
The Hue, Sat and Lum of the called colors can also be 
adjusted.

Adjusting the colors

1	Select the target color background (CBGD1/CBGD2) with 
the following menu operation:

[2] CBGD >
	 CBGD Select

2	Adjust the color (Hue, Sat, Lum) with the following menu 
operation:

[2] CBGD >
	 CBGD Main > Hue

[2] CBGD >
	 CBGD Main > Sat

[2] CBGD >
	 CBGD Main > Lum

■ To call the preset color
Select the preset color with the following menu operation and 
press the OSD/TIME dial:

[2] CBGD >
	 CBGD Main > Load

	p When OSD/TIME dial is pressed, what has been set so far 
is canceled and replaced with the preset color values.

	p To save the values that were set before calling the preset 
color, refer to “Shot memories”.

Setting the Wash effect

The gradation effect for color backgrounds can be set.

Selecting the Wash effect and setting the colors

1	Set the Wash (gradation) effect with the following menu 
operation:

[2] CBGD >
	 CBGD Wash > Wash

On The gradation effect is added.
Off The gradation effect is not added.

2	Set the color of the Wash (gradation) effect with the 
following menu operation:

[2] CBGD >
	 CBGD Wash > Color

Dual A dual-color gradation effect is added. 
(This results in a gradation of two colors, 
namely, the CBGD1 Main color and the CBGD1 
Sub color.)

Rainbow The rainbow color gradation effect is added.

3	If “Dual” is selected, adjust the color (Hue, Sat, Lum) of the 
sub color with the following menu operation:

[2] CBGD >
	 CBGD Sub > Hue

[2] CBGD >
	 CBGD Sub > Sat

[2] CBGD >
	 CBGD Sub > Lum
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Adjusting the Wash waveforms

1	Select the waveform of the gradation with the following 
menu operation:

[2] CBGD >
	 CBGD Wave > Pattern

Sine Sine waves are selected.
Saw Sawtooth waves are selected.

2	Select the cycle of the gradation with the following menu 
operation:

[2] CBGD >
	 CBGD Wave > Cycle

3	Select the phase of the gradation with the following menu 
operation:

[2] CBGD >
	 CBGD Wave > Phase

4	Select the angle of the gradation with the following menu 
operation:

[2] CBGD >
	 CBGD Wave > Angle

Setting the Wash movements

1	Set the movement of the gradation with the following menu 
operation:

[2] CBGD >
	 CBGD Move > Move

Off No movement is set.
Roll The gradations are scrolled.
Rotation The gradations are rotated.

2	Set the speed of the movement with the following menu 
operation:

[2] CBGD >
	 CBGD Move > Speed
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Internal color bar signal

The unit supports 1 internal color bar signal.

Selecting the color bar signal

You can set the built-in color bar type to Type1 to 3 with the 
following menu settings:

[12]Config >
	 CBAR > Type

Type1

Type2

Type3

	p The color bar is for the adjustment of the color phase. 
The width and position of the bar may differ from other 
models.

Test tone settings

The settings related to the test tone signals (1 kHz) output 
with color bar signals can be set.

Set the test tone function with the following menu operation:

[12] Config >
	 CBAR > Test Tone

Normal Test tones are output at the normal volume 
(–12 dB).

Low Test tones are output at lower volume (–20 dB).
Off Test tones are not output.
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In-built test pattern signal
This unit can output a test pattern signal.
It allows you to check factors such as the aspect ratio on 
connected devices.
A test pattern signal with an angle of view is selected that 
corresponds to the system format set on this unit.
It is loaded to either Still1 or Still2 in the video memory and 
can be used as an internal source.

<Test pattern when the system mode is 1080>

<Test pattern when the system mode is 720>

1	Select the device to which the test pattern signal will be 
output with the following operation:

[6] Still >
	 Still Select

2	Press the OSD/TIME dial (Execute) in the following menu 
to load to the selected video memory:

[6] Still >
	 Test Pattern > Load
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Switching the AUX output

Selecting the AUX output materials

The output signals of the AUX buses (AUX1, AUX2) can be 
selected.

1	Press one of the [AUX1], [AUX2] buttons among the AUX 
bus selector buttons. 
The selected button lights in amber.

2	Press one of the AUX bus crosspoint buttons. 
The selected signal is output to the pressed [AUX1], 
[AUX2] button.
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

The button with the signals selected by AUX1 lights in amber.

<Signals that can be selected with the AUX bus>
Name of signal Description of signal

IN1 SDI/HDMI input signal 1

IN2 SDI input signal 2

IN3 SDI input signal 3

IN4 SDI input signal 4

IN5 HDMI input signal 2

IN6 IP input signal 1

IN7 IP input signal 2

IN8 IP input signal 3

IN9 IP input signal 4

PGM Program video signal

PVW Preview video signal

CLN Clean signal

MV Multi view display output signal

KeyOut Key output signal

Black Black signal

CBGD1, CBGD2 Color background 1, 2

CBAR Color bar

Still1, Still2 Video memory (still image) 1, 2

	p When the AUX bus for which “MV” has been selected is 
displayed on the sub screen of the multi view display, the 
images are looped as if two mirrors were facing each other.

AUX1/2 transitions

The MIX transition is executed when the output signal set for 
AUX1/2 is switched.

1	Press the [AUX1] or [AUX2] button of the AUX bus selector 
buttons. 
The selected button and its corresponding AUX bus 
crosspoint button light in amber.

2	Press the AUX bus crosspoint button for the output signal 
to be switched to. 
The MIX transition is now initiated for the length of the 
transition time that was set using the Time menu. 
While the transition is underway, the transition source AUX 
button lights in green, and the transition destination AUX 
button blinks in amber. 
As soon as the transition is completed, the transition 
source AUX button goes off, and the transition destination 
AUX button lights in amber. 
Furthermore, when another signal is selected at a midway 
point through a transition, the transition processing 
continues from that midway point.
AMB:F
GRN:S

AUX

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV PGM PVW

Blinks in amber (while the transition is underway).
Lights in green.

	p The AUX bus transition when Shot Memory is recalled is 
linked to the Shot Memory dissolve time.
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Setting enable/disable for the AUX1/2 
transition

The AUX1/2 transition time and transition enable/disable can 
be set.

1	Set the transition time with the following menu operation:

[5] Time >
	 AUX1 Bus Trans > Trans Time

[5] Time >
	 AUX2 Bus Trans > Trans Time

Any time from 0 to 999f can be set. The time which can 
be set when seconds are used as the display unit differs 
depending on the system format.

59.94i max. 33s09f 29.97p max. 33s09f

50i max. 39s24f 25p max. 39s24f

59.94p max. 16s39f 24p max. 41s15f

50p max. 19s49f 23.98p max. 41s15f

2	Set the enable/disable for transition with the following 
menu operation:

[5] Time >
	 AUX1 Bus Trans > Transition

[5] Time >
	 AUX2 Bus Trans > Transition

On Enable
Off Disable

When disable has been set for the transition, the output 
signals are switched with no transition when the output 
signals set in AUX1/2 is switched.
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Shot memories

The background transition pattern, PinP size, border width and other video effects can be registered in the memory and recalled. 
The memory used for this is referred to as a shot memory.
By setting effect dissolve, it is possible to ensure a smooth change of the switching from the current images to the images or 
operations registered in the shot memory.

Memory items that can be registered and recalled

Item Material selection Transition Pattern Menu
BKGD  PGM/A bus

 PST/B bus
 Fader amount 
 Wipe direction

 �BKGD patterns  
(MIX, WIPE)

 [1] WIPE

Key1  Key1 Fill bus
 Key1 Source bus

 Key1 On/Off
 Fader amount 
 Wipe direction

 �KEY patterns  
(MIX, WIPE)

 [1] WIPE
 [3] Key
 [4] ChromaKey

Key2  Key2 Fill bus
 Key2 Source bus

 Key2 On/Off  [3] Key

AUX1  AUX1 bus

AUX2  AUX2 bus

CBGD  [2] CBGD

Storing the settings in the memory (Store)

Images and operations to be registered can be set and then 
registered in the memories.

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	Using the unit, set the images or operations to be kept in 
the memory.

2	Set the item to be registered in the memory with the 
following menus:

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select > Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 �Refer to “Memory items that can be registered and 
recalled”.

3	Press the [SHOT MEM] button. 
The [SHOT MEM] button turns amber.

4	Hold down the AUX BUS selector button (1 to 12) of the 
memory number to register. (Approx. 1 second)
The AUX BUS selector button of the memory number lights 
green when registration is complete.

	p The AUX BUS selector buttons 1 to 6 act as 7 to 12 
while you are pressing the [SHIFT] button.

	p AUX BUS selector buttons that light green or amber 
already have a memory registered.

5	Repeat the above steps to register other kinds of settings 
in the memories.
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Recalling the operations stored in the 
memory (Recall)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	Select the target to be recalled from the memory with the 
following menus:

[7] Shot Memory >
	 Target Select > BKGD

[7] Shot Memory >
	 Target Select > Key1

[7] Shot Memory >
	 Target Select > Key2

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

 �Refer to “Selecting targets for registration and targets 
for playback”.

2	Turn “On” the following menu to use the crosspoint buttons 
on the control panel to select the material rather than using 
the material registered in the “Material selection” item.

[7] Shot Memory >
	 XPT Disable

 �Refer to “Selecting targets for registration and targets 
for playback”.

3	Press the  [SHOT MEM] button. 
The  [SHOT MEM] button turns amber.

4	Press the AUX BUS selector button (1 to 12) of the 
memory number to recall.

	p The AUX BUS selector buttons 1 to 6 act as 7 to 12 
while you are pressing the [SHIFT] button.
	p In the case of a shot memory, the video effects are 
recalled, and playback starts. 
During playback, the AUX BUS selector button of the 
memory number lights amber.

Refer to “Setting the user buttons” when recalling memory 
operations from the user buttons

Deleting the operations stored in the memory 
(Delete)

POWER

AMB:F
GRN:S

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4 USER 2 5 USER 3 SHOT MEM6

PGM PVW

SHIFT

SHIFT

MIX

WIPE

1	Hold down the [SHOT MEM] button.
The [SHOT MEM] button blinks amber.
The AUX BUS selector buttons where memory is 
registered also blink green or amber.

2	Hold down (for about 1 second) the AUX BUS selector 
button (1 to 12) of the memory number to delete.
The pressed AUX BUS selector button turns off.

	p The AUX BUS selector buttons 1 to 6 act as 7 to 12 
while you are pressing the [SHIFT] button.
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Selecting targets for registration and targets 
for playback

Selecting the target and the “Material selection” item 
when registering a memory

When creating a shot memory, you select the items that are 
to be saved.

Set “On” for the items to be saved with the following menu 
operation:

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On Register the target setting in the memory.
Off Do not register the target setting in the memory.

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On Register the “Material selection” item in the 
memory.

Off Do not register the “Material selection” item in 
the memory.

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On Register the target setting in the memory.
Off Do not register the target setting in the memory.

Selecting the target and the “Material selection” item 
when playing back a memory

When playing back a shot memory, you select the item that is 
to be played back and the “Material selection” item.

Set “On” for the item to be played back with the following 
menu operation:

[7] Shot Memory >
	 Target Select > BKGD > Target

[7] Shot Memory >
	 Target Select > Key1 > Target

[7] Shot Memory >
	 Target Select > Key2 > Target

On Plays back the target.
It does not play back if it is not registered in 
the memory, however.

Off Does not play back the target.

[7] Shot Memory >
	 Target Select > BKGD > XPT

[7] Shot Memory >
	 Target Select > Key1 > XPT

[7] Shot Memory >
	 Target Select > Key2 > XPT

On Plays back the “Material selection” item.
It does not play back if it is not registered in 
the memory, however.

Off Does not play back the “Material selection” item.

[7] Shot Memory >
	 Target Select > AUX1

[7] Shot Memory >
	 Target Select > AUX2

[7] Shot Memory >
	 Target Select > CBGD

On Plays back the target.
It does not play back if it is not registered in 
the memory, however.

Off Does not play back the target.

[7] Shot Memory >
	 XPT Disable

On Does not play back the “Material selection” items 
of BKGD, Key1, and Key2.

Off Plays back the “Material selection” items of 
BKGD, Key1, and Key2.
It does not play back if it is not registered in 
the memory, however.
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Setting effect dissolve (shot memory)

Switching from the current image to the image or operation 
stored in the shot memory can be performed smoothly.

1	Set the effect when switching images with the following 
menu operation:

[7] Shot Memory >
	 Effect

Cut The images are switched using the cut effect.
Dissolve The images are switched using the dissolve 

effect.

	p Set the time for the dissolve effect with the following 
menu operation:

[5] Time >
	 Effect Dissolve

2	Select the effect when changing colors with the following 
menu operation:

[7] Shot Memory >
	 Hue Path

The following colors are targeted by Hue.
	p Colors of the color background
	p Colors of the borders
	p Colors of the edges
	p Colors of the fill matte

Short The colors are changed toward less hue on the 
vectorscope.

Long The colors are changed toward more hue on the 
vectorscope.

CW The Hue is changed clockwise on the 
vectorscope.

CCW The Hue is changed counterclockwise on the 
vectorscope.

	p The pressed AUX BUS selector button lights in amber when 
the operation is switched.

	p When the Effect item is changed from “Dissolve” to “Cut” 
while operation is being switched, the dissolve effect is 
released, and the images are switched to the images of the 
selected shot memory in an instant.

	p During the operation switching, the operation of the fader 
lever is canceled.

	p Other memory operations cannot be recalled while an 
operation is switching.

Basic operations
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Video memories
This unit can save still image memories (Still) in two channels 
for use.

	p Images with key signals can be stored in the video 
memories (still images and moving images).

	p The video memory data can be stored onto, and read out 
from, USB memory.

	p If the system format of this unit is changed between 1080 
and 720, the stored video memories are deleted. 
Before changing the system format, save the video 
memories to a USB memory or project file.

■ Video memory input/output
The image input materials can be selected from the output 
signals of the AUX buses (AUX1, AUX2).

<Image systems of the video memories>

Still2

Still1

AUX1, AUX2:
	 �Selected using the 

menu

AUX1, AUX2:
	 �Selected using the 

menu

Video

Key

Video

Key

Recording still images (Still)
1	Select “Still1” or “Still2” with the following menu operation:

[6] Still >
	 Still Select

2	Set the images to be recorded in the video memory with 
the following menu operation:

[6] Still >
	  Capture Setting > Video

AUX1, AUX2 The output signals of the AUX buses (AUX1, 
AUX2) are recorded as the material.

3	Set the review display with the following menu operation:

[6] Still >
	  Capture Setting > Review

On After the images have been recorded, the 
images of the video memory recorded in the 
AUX bus are displayed (for 2 seconds or so).

Off The review display is not shown.

4	The still image is recorded at the same time you press the 
OSD/TIME dial (Execute) in the following menu.

[6] Still >
	  Capture
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USB memory
You can save the video memory data and setup data of this unit to a USB memory as a project file.
Conversely, this data can be loaded from the USB memory to the unit.
Furthermore, it is possible to update the unit’s software.

	p It may take a while to store a still image file with high image quality on the USB memory.

Video memory (still image data: Still1, Still2):
<File formats supported>

Bitmap (bmp), JPEG (jpg), TARGA (tga), TIFF (tif), GIF (gif), PNG (png)

	p This unit supports 24-bit uncompressed or 32-bit uncompressed TARGA files. 
If any other types of TARGA files are loaded into the unit, black images will be displayed as the thumbnails, and the unit 
cannot recognize the files.
	p Be aware that saving video memory still images on the memory card in GIF format will cause the picture quality to 
deteriorate.

<Applicable sizes> 
HD/1080i:	 1920×1080
HD/1080p:	1920×1080

HD/720p:	 1280×720

	p The size of images is converted automatically if it does not match any of the “applicable sizes”.
	p Images that do not match any of the “applicable sizes” are output centered without having their size changed. If the size is 
large, the parts that protrude outside of the size are cut off. If the size is small, the blank parts are blacked out.

Project file data (Project):
The “project file data” refers to all the data stored in the unit with the exception of the following data.
Project files can be saved.

Date, time, network settings

Software for updating (Update):
The software for updating is loaded. 
This software can be obtained from “Service and Support” on the Web site whose address is provided below:

	 https://pro-av.panasonic.net/en/
For the update procedure, follow the steps in the directions which are contained in the download file.

Log file (Log):
Log files stored in the unit can be saved.

	qConcerning USB memory
USB memory used with the unit should conform to USB 2.0 standards.
Be sure to format USB memory using the unit.
Use memory cards formatted with FAT or exFAT. 
(NTFS formatted USB memory cannot be recognized.)

Operation with this unit has been confirmed for the following USB memory devices:
	p KIOXIA TransMemory U301 (32GB, 64GB, 128GB)
	p SanDisk Cruzer Glide CZ600 (32GB, 64GB, 128GB)

For the latest information not available in the Operating Instructions, visit the following Web sites.
https://pro-av.panasonic.net/en/

	p Memory cards must not be used or stored in an environment where they may be
	 •	Exposed to high temperatures/humidities;
	 •	Exposed to water droplets; or
	 •	Electrically charged.
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The data is stored in the following folders on the USB memory.
When data is to be loaded, first store the data in the respective folders, and then load the files.

<Data folder configuration>
Data type Save Type item Storage folder Extension

Project file (project) Project (*1) “HS\COMM\PROJECT” 001, 002, … (*3)

Video memory (Still file) Still1, Still2 (*2) “HS\COMM\IMAGE” bmp, tga, png, jpg(jpeg), tif(tiff), gif

Update file – “HS\HSW10\UPDATE” 10d

Log file Log “HS\HSW10\LOG” log

Load TEXT file (page 29) “HS\HSW10\TEXT” txt (*4)

*1	� The project file saves together the setup data, shot memory data, and still image data selected with the following menu operation:

[18] USB Memory >
	  Save > Setup

[18] USB Memory >
	  Save > Shot

[18] USB Memory >
	  Save > Still

*2	� When the still image data with key signals attached is stored into the video memory, select “tga” or “png” as the file format. 
The still image data of any other file format cannot be stored with attaching the key signals.

*3	� The project file is saved in a folder created as File Name folder created under the HS\COMM\PROJECT folder.   
When the project file being stored is large, the file is divided and each file is appended with a serial number extension (001, 002, etc.).

*4	� When you select [Load TEXT] you can load a text file (.txt) that was saved to the "HS\HSW10\TEXT” folder on the USB memory formatted 
by this unit, and use the content to set as a character string.[Load TEXT] cannot be selected if a USB memory is not connected.

USB memory handling precautions
	p “Unmount” the USB memory before removing it.  
If the USB memory is removed without “Unmount”, the transition may pause or the content saved in the USB memory may 
be lost.

	p The data stored on USB memory may be lost as a result of misplacing the USB memory or performing erroneous 
operations, for instance. It is recommended that valuable data be stored on a computer or other device.

Notes when working with exFAT
	p The time stamp shown when using exFAT may differ to that shown on the computer.  
This unit works with the UTC time zone, so if you are using a computer running on the Japan time zone (UTC +9) for 
example, there will be a 9-hour difference in the time stamp display on the computer.
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Formatting USB memory

Before using a USB memory on this unit, the USB memory 
must first be formatted on this unit. Executing the format 
means that the USB memory is formatted and a dedicated 
directory is created. (All files saved on the USB memory will 
be erased.)

1	Insert the USB memory into the unit’s USB connector 
(Type A connector).

2	Press the OSD/TIME dial (Execute) in the following menu 
to format.

[18] USB Memory >
	 Format

The item is grayed out if a USB memory is not inserted.
	p To format, select “YES” in the confirmation screen.
	p To cancel, select “NO”.

Format the USB memory to use it in this unit.

Saving data on USB memory
1	Insert a USB memory that was formatted on this unit into 

the USB connector (Type A connector).

2	Select the data to save in the USB memory with the 
following menu operation:

[18] USB Memory >
	 Save > Save Type

When saving still images:
Select the file format for saving still images with the 
following menu operation:

[18] USB Memory >
	 Save > File Format

When saving project files:
Turned “On” the items to be saved as the project file with 
the following menu operation:

[18] USB Memory >
	 Save > Setup

[18] USB Memory >
	 Save > Shot

[18] USB Memory >
	 Save > Still

3	Press the OSD/TIME dial (Execute) in the following menu 
to display the file selection screen.

[18] USB Memory >
	 Save > Save

�For the destinations where the data is stored, refer to 
<Data folder configuration>.

	p Be aware that saving video memory still images on the 
USB memory in GIF format will cause the picture quality 
to deteriorate.

	p Alphanumeric characters and symbols can be used for 
file names.  
Files using other characters cannot be displayed on this 
unit.
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Loading data from USB memory

1	Insert the USB memory on which the data is stored into the 
USB connector (Type A connector). 
Load the file after its data has been stored in the each 
folder.  
Data stored in other folders will not be recognized by the 
unit.
For the destinations where the data is stored, refer to 
<Data folder configuration>.

2	Press the OSD/TIME dial (Execute) in the following menu 
to display the file selection screen.

[18] USB Memory >
	 Load > Load

<Example of what appears on the file selection screen>

3	Select the type of file to load with the following menu 
operation:

[18] USB Memory >
	 Load > Load Type

4	Turn the OSD/TIME dial to select the file name to load.
A shortened file name may be displayed if the filename 
being loaded exceeds 11 characters. 
If the name of the file to be loaded is 33 characters or 
more, it will not be displayed on the file selection screen.

	p Alphanumeric characters and symbols can be used for 
file names.  
Files using other characters cannot be displayed on this 
unit.

5	Press the OSD/TIME dial to load the file.

Displaying the USB memory information

1	Insert the USB memory on which the data is stored into the 
USB connector (Type A connector).

2	Display the following menus:

[18] USB Memory >
	 Free

[18] USB Memory >
	 Total

Free The USB memory's remaining free space is 
displayed.

Total The memory card’s capacity is displayed.
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Internal storage

The setup data for this unit can be saved as a project file in the internal storage.
Furthermore, you can also load the setup data from the internal storage to this unit.

	p It may take some time when saving still image files with high image quality to the internal storage.
	p The following data can be selected and saved or loaded as a project file.
Setup data, shot memory data, still video memory

	p The date, time, and network settings cannot be saved.

Project file management screen

Display the following menus:

[14] Project

	p You can load, save, delete and rename project files in the 
internal storage using this menu screen.  
You can also view the information for the project file that 
was most recently loaded.

Saving project files to the internal storage
1	Select the file to save with the following menus:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

	p You can overwrite a project file that has already been 
saved.
	p You cannot overwrite files that have the Protect item 
“On”.

2	Press the OSD/TIME dial (Execute) in the Save item to 
save the project file in the internal storage.

Loading project files from the internal 
storage
1	Select the file to load with the following menus:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	Press the OSD/TIME dial (Execute) in the Load item to 
load a project file from the internal storage.

3	You can protect the target file by setting the Protect item.
	p Project files that have the Protect item “On” cannot be 
overwritten, deleted, or filenames changed.

Deleting project files from the internal 
storage
1	Select the file to delete with the following menus:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	Press the OSD/TIME dial (Execute) in the Delete item to 
delete the project file from the internal storage.

	p You cannot delete files that have the Protect item “On”.

3	You can protect the target file by setting the Protect item.
	p Project files that have the Protect item “On” cannot be 
overwritten, deleted, or filenames changed.
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Changing the filenames of project files saved 
in the internal storage
1	Select the project file for which you want to change the 

name with the following menus:

[14] Project >
	  Project File > Project 1

[14] Project >
	  Project File > Project 2

[14] Project >
	  Project File > Project 3

2	You can change the name of the project files saved in the 
internal storage with the Name item.

	p The file name can have a maximum of 32 characters.
<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3	You can protect the target file by setting the Protect item.
	p Project files that have the Protect item “On” cannot be 
overwritten, deleted, or filenames changed.
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Input/output signal settings

Input signal settings
The available inputs are as follows:

Logical input 
name

Physical input 
name Limitations

IN1 SDI IN1/HDMI IN1 SDI/HDMI mutually exclusive, simplified UC/DC, with scaler

IN2 SDI IN2 Simplified UC/DC

IN3 SDI IN3 With UC/DC

IN4 SDI IN4 With UC/DC

IN5 HDMI IN2 With scaler

IN6 LAN SRT/NDI|HX

IN7 LAN SRT/NDI|HX

IN8 LAN NDI, equipped with α compatibility, IN9 is disabled at this time

IN9 LAN NDI

When setting input signals, first select the input signal you want to set in the following menus:

[10] Input >
	  IN1 > SDI/HDMI

[10] Input >
	  INx > Streaming Mode
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<List of settings by input signal>

Input connector

Setting menu and page in this manual

Status FS Freeze Limited Name Up/Down 
Converter C/C HDMI Status

P69 P70 P70 P71 P71 P71 P72 P74
SDI IN 1    –  –  –

SDI IN 2    –  –  –

SDI IN 3    –    –

SDI IN 4    –    –

HDMI IN 1 – –    –  

HDMI IN 2 – –    –  

IP IN1 – – – –  – – –

IP IN2 – – – –  – – –

IP IN3 – – – –  – – –

IP IN4 – – – –  – – –

Input connector

Setting menu and page in this manual

HDMI Input Scale SRT Status SRT Input NDI Status NDI Input Camera 
Setting

P73 P73 P75 P75 P77 P76 P104
SDI IN 1 – – – – – – 

SDI IN 2 – – – – – – 

SDI IN 3 – – – – – – 

SDI IN 4 – – – – – – 

HDMI IN 1   – – – – 

HDMI IN 2   – – – – 

IP IN1 – – *1 *1 *2 *2 

IP IN2 – – *1 *1 *2 *2 

IP IN3 – – – –   

IP IN4 – – – –   

: Can be set.
	 —: Cannot be set.

*1	 Only for SRT settings
*2	 Only for NDI/NDI|HX settings
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Settings for the exclusionary input 
connectors

Set the exclusionary input for the SDI input connectors (SDI 
IN 1)/HDMI input connectors (HDMI IN 1).

Set the input signal type with the following menu operation:

[10] Input >
	  IN1 > SDI/HDMI

SDI IN Selects the SDI signal input to SDI IN 1 for IN1. 
Even if HDMI signals are input, they are not 
input to this unit.

HDMI IN Selects the HDMI signal input to HDMI IN1 for 
IN1. Even if SDI signals are input, they are not 
input to this unit.

Checking the input signal status

You can check the status of input signals.

For SDI input signals

Display the following menus:

[10] Input >
	  INx > Status

The unit automatically determines the content of input signals 
and displays the following information.

Format Displays the image format information for the 
SDI signal being input.

Audio Displays the audio information for the SDI signal 
being input.

For HDMI input signals

Display the following menus:

[10] Input >
	  INx > Status

The unit automatically determines the content of input signals 
and displays the following information.

Size Displays the resolution information for the HDMI 
signal being input.

Dot Clock Displays the dot clock information for the HDMI 
signal being input.

H-Frequency Displays the horizontal frequency information for 
the HDMI signal being input.

V-Frequency Displays the vertical frequency information for 
the HDMI signal being input.

For SRT input signals

 Refer to “Displaying the SRT input signal information”.

For NDI input signals

 Refer to “Displaying the NDI input signal information”.
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Setting the frame synchronizer

The frame synchronizer can be set to On or Off for each SDI 
input.
The HDMI input frame synchronizer is permanently On. 
It cannot be set from On to Off or vice versa.

Set the frame synchronizer with the following menu operation:

[10] Input >
	 INx > FS Mode

Off Turns the frame synchronizer Off. The line 
synchronizer function operates in this case.
The line synchronizer function automatically 
adjusts the phases of input video signals to 
match the phases of the horizontal sync signals.

Normal Enables the frame synchronizer function. When 
a signal that is different from the system format 
is input, the screen turns black.

Auto Enables the frame synchronizer function. Even 
when a signal that is different from the system 
format is input, the screen does not turn black.
The video output in this case may be disrupted.

	p If the output signal phase is set to [0H], “Off” cannot be 
selected as the FS item setting. 
If the FS item is set to “Off”, this changes to Normal.
	p When inputting 3G-SDI Level B Mapping signals, set the 
frame synchronizer setting to “Auto”.

Setting the delay amount

The input signals can be delayed.
	p This setting is for input signals to SDI IN1 to 4.
	p This does not have an effect on embedded audio.

Set the delay amount with the following menu operation:

[10] Input >
	 INx > FS Delay

Freezing the input signals

The SDI/HDMI input signals can be frozen and used. 
While signals are frozen, the tally signals of the corresponding 
input will not be output.

Setting freeze

1	Select the behavior of freeze with the following menu 
operation:

[10] Input >
	  INx > Freeze Select

Frame The images are frozen frame by frame.
Field The images are frozen field by field.

This is used to freeze moving images.
With interlace signals, however, diagonal lines 
and moving parts appear jagged.

	p Frame or Field can also be selected while an image is 
frozen.

2	Freeze and release input images with the following menu 
operation:

[10] Input >
	  INx > Freeze

	p Image signals are frozen when you change “Disable” to 
“Enable”.

	p Image signals are released from freeze when you 
change “Enable” to “Disable”.  
When you freeze signals set to output to multi view 
displays, an “F” mark is displayed in front of the source 
name.

	p When the unit is used with the frame synchronizer 
function OFF, the output images may be disturbed when 
freezing is executed, but the frozen images will not be 
adversely affected.

	p If, when the switcher is used with the frame synchronizer 
function at OFF, “Enable” is set as the freeze setting, 
the frame synchronizer function will be automatically 
switched to ON.



71

Limited settings

On this unit, you can make settings for full range and limited 
range to suit the HDMI tone levels of connected input 
devices, such as cameras.

[10] Input >
	 INx > Limited

Off Select when the tone levels of the HDMI input 
are full range.

On Select when the tone levels of the HDMI input 
are limited range.

	p Full range: HDMI input supports RGB 0 to 255.
	p Limited range: HDMI input supports RGB 16 to 235. This 
is also referred to as the video range.

Setting the material names

Material names can be given to the input signals.
These names can be selected from the default settings or 
user settings.

Select the material name type with the following menu 
operation:

[10] Input > 
	 INx > Name Type

Default
(default settings)

The following material names are selected 
automatically:
IN1 to 9

User
(user settings)

The material names are set using up to 
32 characters.

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Setting the up-converter

Select the settings for SDI IN3, SDI IN4, that is built into the 
optional unit listed below:

1	Set the image motion detection sensitivity with the 
following menu operation:

[10] Input > 
	 INx > Up/Down Converter > Move Detect

1 Toward still images

3 Standard

5 Toward moving images

2	Set the degree of sharpness of edges of images with the 
following menu operation:

[10] Input > 
	 INx > Up/Down Converter > Sharp

1 Not sharp edges

3 Standard

5 Very sharp edges

Input/output signal settings
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Color Corrector

Make settings for the Color Correctors built in to SDI/HDMI.

Color Corrector settings

Set enable (On)/disable (Off) for the Color Corrector with the 
following menu operation:

[10] Input > 
	 INx > Color Correct > C/C

Process control

1	Set the Y signal gain value with the following menu 
operation:

[10] Input > 
	 INx > Color Correct > C/C Process > Y-Gain

2	Set the pedestal level value with the following menu 
operation:

[10] Input > 
	 INx > Color Correct > C/C Process > Pedestal

3	Set the gain value of the saturation with the following menu 
operation:

[10] Input > 
	 INx > Color Correct > C/C Process > C-Gain

4	Set the amount of change to the hue with the following 
menu operation:

[10] Input > 
	 INx > Color Correct > C/C Process > Hue
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Setting the HDMI input signals

Make settings for HDMI input signals.
Signals with the following resolutions can be input.

<HDMI input signal compatibility chart>

HDMI input signals
System format

1080/ 
59.94p

1080/ 
50p

1080/ 
29.97p

1080/ 
25p

1080/ 
24p

1080/ 
23.98p

1080/ 
59.94i

1080/ 
50i

720/ 
59.94p

720/ 
50p

1080/59.94p 
(1920 x 1080)/ 
59.94 Hz, 60 Hz

 – – – – –  –  –

1080/50p 
(1920 x 1080)/50 Hz –  – – – – –  – 

1080/29.97p 
(1920 x 1080)/ 
29.97 Hz

– –  – – – – – – –

1080/25p 
(1920 x 1080)/25 Hz – – –  – – – – – –

1080/24p 
(1920 x 1080)/24 Hz – – – –  – – – – –

1080/23.98p 
(1920 x 1080)/ 
23.98 Hz

– – – – –  – – – –

1080/59.94i 
(1920 x 1080)/ 
59.94 Hz, 60 Hz

 –  – – –  –  –

1080/50i 
(1920 x 1080)/50 Hz –  –  – – –  – 

720/59.94p 
(1280 x 720)/59.94 Hz, 60 Hz  – – – – –  –  –

720/50p 
(1280 x 720)/50 Hz –  – – – – –  – 

WSXGA+ 
(1680 x 1200)/60 Hz          

SXGA 
(1280 x 1024)/60 Hz          

WXGA 
(1280 x 768)/60 Hz          

XGA 
(1024 x 768)/60 Hz          

: Can be set.
—: Cannot be set.

	p If signals with any other resolutions or frequencies are input, the signals cannot be imported correctly.  
The images which are output at a time like this may be black or disturbed.

	p These units are incompatible with the HDCP (High-bandwidth Digital Content Protection).

Select the scaling mode with the following menu operation:

[10] Input >
	 INx > Scale

Fit-V The aspect ratio of the input images is maintained, and the size of the images is increased or 
reduced in accordance with the vertical resolution.

Fit-H The aspect ratio of the input images is maintained, and the size of the images is increased or 
reduced in accordance with the horizontal resolution.

Full The size of the input images is increased or reduced in accordance with the system resolution.
(The aspect ratio of the input images is not kept the same. The rate at which the image size is 
increased or reduced in the vertical direction and in the horizontal direction differs.)
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Displaying the HDMI input signal information

These are used to display the information concerning the HDMI input signal images. 
The information cannot be changed.

Display the following menus:

[10] Input >
	 INx > Status

Size This indicates the pixel count of the images.
Dot Clock This indicates the dot clock frequency of the images.
H-Frequency This indicates the horizontal frequency of the images.
V-Frequency This indicates the vertical frequency of the images.

The formats supported are listed below.

<HDMI formats supported>

HDMI input signal Dot clock frequency 
(MHz)

Frequency
Horizontal 

(kHz)
Vertical 

(Hz)
XGA 1024×768 Digital 65.0 48.36 60.00

WXGA 1280×768 Digital 79.5 47.78 59.87

SXGA 1280×1024 Digital 108.0 63.98 60.02

WSXGA+ 1680×1050 Digital 146.2 65.29 59.95

720/59.94p 1280×720 Digital 74.25/1.001 44.96 60.00/1.001

720/50p 1280×720 Digital 74.25 37.50 50.00

1080/59.94i 1920×1080 Digital 74.25/1.001 33.72 60.00/1.001

1080/50i 1920×1080 Digital 74.25 28.13 50.00

1080/23.98p 1920×1080 Digital 74.2 27.0 24.00/1.001

1080/24p 1920×1080 Digital 74.2 27.0 24.00

1080/25p 1920×1080 Digital 74.2 28.1 25.00

1080/29.97p 1920×1080 Digital 74.2 33.7 30.00

1080/59.94p 1920×1080 Digital 148.5/1.001 67.50/1.001 60.00/1.001

1080/50p 1920×1080 Digital 148.5 56.25 50.00

	p If the format of the input signals is not supported, it may not be possible to import the signals properly, and a black image or 
disturbed image may appear.
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SRT Input signal settings

This unit can input a maximum of 2 SRT signals.

SRT settings for inputs that support SRT are available in 
“Input signal settings”.
When setting SRT input signals, first set the input signal you 
want to set in the following menu:

[10] Input > 
	 INx > Streaming Mode

1	Set the connection mode with the following menu 
operation:

[10] Input >
	 INx > Mode

Caller Specify when specifying the server URL and 
port number of the transmission source to send 
requests to start transmission from this unit.

Listener Specify when specifying the standby port when 
starting transmission externally.

2	Set the server URL and port number of the transmission 
source with the following menu operation (For Caller only):

[10] Input >
	 INx > Server URL

[10] Input >
	 INx > Server Port

3	Set the standby port number for this unit with the following 
menu operation (For Listener only):

[10] Input >
	 INx > Port

	p A message is displayed if you select one of the ports that 
is not available.

4	Set the Stream ID with the following menu operation:

[10] Input >
	 INx > Stream ID

5	Set the encryption mode for the transmitted images with 
the following menu operation:

[10] Input >
	 INx > Encryption

Disable Received images are not decoded. Unencrypted 
images can be handled.

Enable Decode received images.

6	Set the phrase for decoding the received images with the 
following menu operation:

[10] Input >
	 INx > Passphrase

Displaying the SRT input signal information

You can check the status of the SRT signal being input to this 
unit.
Display the following menus:

[10] Input > 
	 INx > Status

This unit automatically determines the content of the SRT 
input signal and displays the following information:

Format Displays the image format information for the 
SRT signal being input.

Sampling 
Rate

Displays the sampling rate information for the 
SRT signal being input.

Audio 
Channel

Displays the surround information for the SRT 
signal being input.

Compress Displays the compression format information for 
the SRT signal being input.

Setting the material names (SRT input signal)

Material names can be given to the input signals.
These names can be selected from the default settings or 
user settings.

Select the material name type with the following menu 
operation:

[10] Input >
	 INx > Name Type

Default
(default settings)

Select the material names from the 
following: 
IN1 to 9

User
(user settings)

The material names are set using up to 
32 characters.

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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NDI/NDI|HX

This unit can input 2 HB signals and 2 HX signals for a 
maximum total of 4 NDI/NDI|HX signals.

NDI|HX

This unit supports both NDI|HX version1 and NDI|HX 
version2.
Both NDI|HX version1 and NDI|HX version2 support H.264 
as the image compression standard. NDI|HX version2 also 
supports H.265.

NDI Input signal settings

NDI settings for inputs that support NDI are available in “Input 
signal settings”.
When setting NDI input signals, first set the input signal you 
want to set in the following menu:

[10] Input >
	 INx > Streaming Mode

1	Select the mode to use for searching for NDI input sources 
on the network with the following menu operation:

[10] Input >
	 INx > Scan Mode

HB/HX v2 Searches for NDI or NDI|HX version2 input 
sources.

HX v1 Searches for NDI|HX version1 input sources.

2	Press the OSD/TIME dial (Execute) in the following menu 
to execute the device search:

[10] Input >
	 INx > Scan

	p The search results are displayed in a list in the format 
MACHINE NAME(SOURCE NAME).
	p Machine searches on a network may take some time.

3	Select the combination of the device to be set as the input 
source and the NDI image source, then confirm with the 
OSD/TIME dial.

	p This can be unselected by selecting “None”.

Reception protocol settings

Set the protocol to use with the NDI transmitter.

1	Set the protocol to use with the NDI transmitter with the 
following menu operation:

[10] Input >
	 INx > Protocol

TCP Sets TCP as the protocol to use with the NDI 
transmitter. (Default) 
Permits communication using sTCP.

UDP Sets UDP as the protocol to use with the NDI 
transmitter. 
Permits communication using UDP and sTCP.

	p The superior protocol is selected through negotiations 
with the protocol settings on the NDI transmission side.

	p sTCP (single TCP): A connection-oriented 
communication method that guarantees accurate 
delivery of data, but the communication speed is slower 
compared to UDP.

	p UDP: A connectionless communication method that 
enables high-speed data transfers, but the reliability of 
that data is less than TCP.

	p It is necessary to fix the protocol to UDP when 
performing multicast transmissions.

Notes
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Displaying the NDI input signal information

You can check the status of the NDI signal being input to this 
unit.
Display the following menus:

[10] Input >
	 INx > Status

This unit automatically determines the content of the NDI 
input signal and displays the following information:

Format Displays the image format information for the 
NDI signal being input.

Sampling 
Rate

Displays the sampling rate information for the 
NDI signal being input.

Audio 
Channel

Displays the surround information for the NDI 
signal being input.

Frame Data Displays the color information for the NDI signal 
being input.

Compress Displays the compression format information for 
the NDI signal being input.

Streaming 
Mode

Displays the format information for the NDI 
signal being input.

Setting the material names (NDI input signal)

Material names can be given to the input signals.
These names can be selected from the default settings or 
user settings.

Select the material name type with the following menu 
operation:

[10] Input >
	 INx > Name Type

Default
(default settings)

The following material names are selected 
automatically:
IN1 to 9

User
(user settings)

The material names are set using up to 
32 characters.

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Input settings for material with α channel

This unit can input normal NDI signals and signals with α 
channel, switching between them to use as material.
A maximum of 1 set of NDI signals with α channel can be 
input, with the settings shown in the below chart possible by 
switching the input mode:

α channel settings
Disabled Enabled

IN8 Fill Fill
IN9 Fill Key

Select the enable/disable for the α channel with the following 
menu operation:

[10] Input >
	 INx > Alpha Setting > Use alpha

Setting groups

By setting NDI senders and receivers in groups to which each 
belongs, you can specify the group to be searched when 
performing machine searches.
It is possible to specify multiple groups, separating them with 
commas.
This function is not available with NDI|HX version1.

1	Select enable or disable for the group search function with 
the following menu operation:

[10] Input >
	 INx > Group > Group

Enable Group search function enabled.
Disable Group search function disabled. (Default)

2	Enter the group name with the following menu operation:

[10] Input >
	 INx > Group > Group Name

	p You can enter a character string of up to 64 characters.
<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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Discovery Server settings

It is possible to set the function for automatically searching for 
NDI sources to centrally register with an external server.
Enabling this setting is effective when there is a large amount 
of NDI sources on the network and it is desirable to avoid 
an increase in traffic, or when multicast transmission is not 
possible or undesirable.

1	Select whether to set an external server with the following 
menu operation:

[10] Input >
	 INx > Use Discovery server > 

Use Discovery server

Enable External server settings enabled.
Disable External server settings disabled. (Default)

2	Enter the IP address of the external server with the 
following menu operation:

[10] Input >
	 INx > Use Discovery server >

Discovery server IP

RTSP port settings

You can set the port and the request URL of this unit to match 
the RTSP port settings of the camera to be connected.
This function is effective with NDI|HX version1.

1	Enter the RTSP port number to suit the camera settings 
with the following menu operation:

[10] Input >
	 INx > RTSP > Port

	p Port numbers 10668, 10669, and 10670 cannot be used.
2	Enter the Request URL to suit the camera settings with the 

following menu operation:

[10] Input >
	 INx > RTSP > Request URL

	p Enter a character string of up to 255 characters.
<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3	After entering Port and Request URL, press the OSD/TIME 
dial (Execute) in the following menu to update the settings 
with the changes:

[10] Input >
	 INx > RTSP > Connect

Analog audio input signal settings

Analog audio can be input to two input channels (left channel 
and right channel) of this unit.

1	Enable analog audio input with the following menu 
operation:

[15] Ancillary/Audio >
	 Analog IN > Audio

Off Analog audio input disabled.
On Analog audio input enabled.

2	Set the level for analog audio input with the following menu 
operation:

[15] Ancillary/Audio >
	 Analog IN > Input Type

LINE Set to line input level.
MIC Set to microphone input level.

3	Set the gain with the following menu operation:

[15] Ancillary/Audio >
	 Analog IN > Gain

	p You can enter in a range between –36 and 12dB.
4	Set the delay amount with the following menu operation:

[15] Ancillary/Audio >
	 Analog IN > Delay (ms)

	p You can enter in a range between 0 and 512 ms.
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Output signal settings
Outputs available are as follows:

<Output (common)>
Logical output name Physical output name Limitations

OUT1 SDI OUT1

OUT2 SDI OUT2

OUT3 HDMI OUT

OUT4 LAN SRT/RTMP/NDI

OUT5 LAN SRT/RTMP/NDI

OUT6 USB STREAM OUT UVC fixed allocation

Before proceeding to set the output signals, first select the output signals to be set using the Output sub menu.

[11] Output > 
	 OUT4 > Streaming Mode

[11] Output > 
	 OUT5 > Streaming Mode

<List of settings by output signal>

Output connector

Setting menu and page in this manual

Assign SDI Output HDMI 
Output

Down 
Converter Scale SRT 

Output NDI Output RTMP 
Output

UVC 
Output

P80 – P80 – P80 P81 P82 P84 P84
SDI OUT 1   – – – – – – –

SDI OUT 2   – – – – – – –

HDMI OUT  –  –  – – – –

IP(OUT4)  – – – –    –

IP(OUT5)  – – – –    –

UVC OUT  – – – – – – – 

: Can be set.
	 —: Cannot be set.
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Assigning the output signals

Assign output signals to each of the outputs.

Set the output signal type with the following menu operation:

[11] Output >
	 OUTx > Assign

PGM An image provided with the wipe, mix, key, 
downstream key or other effect is output at the 
switcher’s main line output.

PVW This is the preview output that enables the next 
operation to be checked before it is executed.

CLN The clean signal (the image resulting when the 
key, downstream key or other effect has been 
removed from the PGM signal) is output.

AUX1, AUX2 The signals selected by the 2 lines of AUX buses 
(AUX1, AUX2) are output.

MV The multi view display signals are output. 
Multiple input signals and output signals are 
reduced in size and output to one screen.

KeyOut The key signal is output.

Setting the HDMI output signals

Make settings for HDMI output signals.

1	Set the output signal type with the following menu 
operation:

[11] Output >
	 OUT3 > Assign

 Refer to “Assigning the output signals”.
2	Select the resolution of the video to be output with the 

following menu operation:

[11] Output >
	 OUT3 > Size

Auto The equipment information of the output 
destination is captured by the HDMI signals, and 
the images are output at the optimum resolution.

XGA (1024 × 768) / 60 Hz
WXGA (1280 × 768) / 60 Hz
SXGA (1280 × 1024) / 60 Hz
WXGA+ (1680 × 1050) / 60 Hz
Native Same format as the system format is output.

3	Set the output color space with the following menu 
operation:

[11] Output >
	 OUT3 > color

Auto Device information about the connection 
destination is obtained via the HDMI signal, 
and output uses the optimum color space 
accordingly.

RGB The color space is set with the RGB format.
YUV444 The color space is set with the Y, Cb, Cr at 4:4:4. 

(With this method, for each 4 horizontal pixels, 
4 pixels each are sampled of the luminance 
component and 2 color difference components)

YUV422 The color space is set with the Y, Cb, Cr at 4:2:2. 
(With this method, for each 2 horizontal pixels, 
1 pixel each is sampled of the color difference 
components, and each pixel is sampled of the 
luminance component)

4	Select the scaling mode with the following menu operation:

[11] Output >
	 OUT3 > Scale

Fit-V The aspect ratio of the output images is 
maintained, and the size of the images is 
increased or reduced in accordance with the 
vertical resolution. 
(Black bands are inserted into the areas where 
there are no images. The protruding parts of the 
images are cropped.)

Fit-H The aspect ratio of the output images is 
maintained, and the size of the images is 
increased or reduced in accordance with the 
horizontal resolution.
(Black bands are inserted into the areas where 
there are no images. The protruding parts of the 
images are cropped.)

Full The size of the output images is increased 
or reduced in accordance with the system 
resolution.

Full80% The size of the output image is increased or 
reduced in accordance with the 80% size of the 
system resolution.

Full90% The size of the output image is increased or 
reduced in accordance with the 90% size of the 
system resolution.

	p The aspect ratio is not maintained at the Full, Full80% or 
Full90% setting. 
The rate at which the image size is increased or reduced 
in the vertical direction and in the horizontal direction 
differs.

5	Set the image motion detection sensitivity with the 
following menu operation:

[11] Output >
	 OUT3 > Move Detect

1 Toward still images

3 Standard

5 Toward moving images
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Setting the SRT output signals

This unit can output a maximum of 2 SRT signals.

Assign SRT output signals.

1	Set the output signal type with the following menu 
operation:

[11] Output >
	 OUTx > Assign

 Refer to “Assigning the output signals”.
2	Set the connection mode with the following menu 

operation:

[11] Output >
	 OUTx > Mode

Caller Specify when specifying the server URL and port 
number of the transmission destination to send 
requests to start transmission from this unit.

Listener Specify when specifying the standby port when 
starting transmission externally.

3	Set the URL, port, and Stream ID with the following menu 
operation (For Caller only):

[11] Output >
	 OUTx > Destination URL

[11] Output >
	 OUTx > Destination Port

[11] Output >
	 OUTx > Stream ID

Destination URL URL of the connected server
Destination Port Port of the connected server
Stream ID Stream ID of the connected server

	p DNS settings are required in order to resolve the domain 
name of the connected server.

<Characters which can be used for filenames>

A to Z, a to z, 0 to 9

4	Set the standby port with the following menu operation (for 
Listener only):

[11] Output >
	 OUTx > Port

	p A message is displayed if you select one of the ports that 
is not available.

5	Set the TTL/HOP limit with the following menu operation:

[11] Output >
	 OUTx > TTL/HOP limit

6	Set the time between when images are sent and when 
they are played on the receiving device with the following 
menu operation:

[11] Output >
	 OUTx > Latency(ms)

	p The set time may not be guaranteed depending on the 
network bandwidth.

7	Set the encryption mode for the images to be transmitted 
with the following menu operation:

[11] Output >
	 OUTx > Encryption

Disable Images are transmitted without encryption.
AES128 Images are transmitted with AES-128 

encryption.
AES256 Images are transmitted with AES-256 

encryption.

8	Set the phrase for decoding the encrypted images with the 
following menu operation:

[11] Output >
	 OUTx > Passphrase

9	Select H.264 or H.265 as the image format with the 
following menu operation:

[11] Output >
	 OUTx > Codec

:	�Set the bit rate control mode for the image format with the 
following menu operation:

[11] Output >
	 OUTx > Rate Control Mode

CBR Transmission is with the bit rate set in Target bit 
rate.

VBR With the bit rate set in Max bit rate as the 
maximum, transmissions are made to approach 
the bit rate set as the Target bit rate.
The actual bit rate depends on the video being 
transmitted.

;	�Set the target bit rate for transmission with the following 
menu operation:

[11] Output >
	 OUTx > Target bit rate

<	�Set the maximum bit rate for transmission with the 
following menu operation (for VBR only):

[11] Output >
	 OUTx > Max bit rate
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Setting the NDI output signals

This unit can output a maximum of 2 NDI signals.
NDI|HX output is not possible.

For NDI signals, there is 1 output of High Bandwidth and 
1 output of Low Bandwidth output constantly with each NDI 
output.

NDI|HX

This unit can only output NDI signals. It cannot output NDI|HX 
version1/2 signals.

Assigning NDI output signals

Assign NDI output signals.

Set the output signal type with the following menu operation:

[11] Output >  
	 OUTx > Assign

 Refer to “Assigning the output signals”.

Common NDI output signal settings

On this unit, it is possible to set with character strings the 
Machine Name and Source Name displayed when searching 
from an NDI receiver.

1	Set the name to display for the NDI receiver with the 
following menu operation:

[11] Output > 
	 OUTx > Machine Name

	p You can enter a character string of up to 20 characters.
2	Set the name to display for the NDI receiver with the 

following menu operation:

[11] Output > 
	 OUTx > Source Name

	p You can enter a character string of up to 32 characters.
<Characters which can be used for filenames>

A to Z, a to z, 0 to 9, space, -, _

NDI transmission protocol settings

Set the protocol to use with the NDI receiver.

1	Set the protocol to use with the NDI receiver with the 
following menu operation:

[11] Output > 
	 OUTx > Protocol

TCP TCP is set as the protocol to use with the NDI 
receiver. (Default)
Permits communication using sTCP.

UDP UDP is set as the protocol to use with the NDI 
receiver.
Permits communication using UDP and sTCP.

	p The superior protocol is selected through negotiations 
with the protocol settings on the NDI transmission side.

	p sTCP (single TCP): A connection-oriented 
communication method that guarantees accurate 
delivery of data, but the communication speed is slower 
compared to UDP.

	p UDP: A connectionless communication method that 
enables high-speed data transfers, but the reliability of 
that data is less than TCP.

	p It is necessary to fix the protocol to UDP when 
performing multicast transmissions.

Notes
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NDI multicast settings

Set whether to enable or disable multicast transmission for 
the NDI receiver.
When multicast transmissions are to be enabled, 
transmissions are made according to the settings for IP 
address, subnet mask, and TTL/HOP Limit.
With this unit, it is possible to perform multicast transmissions 
within the same subnet.

1	Set enable or disable for multicast transmissions with the 
following menu operation:

[11] Output >  
	 OUTx > Multicast > Multicast

Enable Multicast transmission to the NDI receiver is 
enabled.

Disable Multicast transmission to the NDI receiver is 
disabled. (Default)

2	Set the IP address, subnet mask, and TTL with the 
following menu operation:

[11] Output > 
	 OUTx > Multicast > IP Address

[11] Output > 
	 OUTx > Multicast > Subnet Mask

[11] Output > 
	 OUTx > Multicast > TTL/HOP Limit

Setting NDI groups

By setting NDI senders and receivers in groups to which each 
belongs, you can specify the group to be searched when 
performing machine searches.
It is possible to specify multiple groups, separating them with 
commas.

1	Set enable or disable for the group search function with the 
following menu operation:

[11] Output > 
	 OUTx > Group > Group

Enable Group search function enabled.
Disable Group search function disabled. (Default)

2	Enter the group name with the following menu operation:

[11] Output > 
	 OUTx > Group > Group Name

	p You can enter a character string of up to 64 characters.
<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

NDI discovery Server settings

It is possible to set the function for automatically searching for 
NDI sources to centrally register with an external server.
Enabling this setting is effective when there is a large amount 
of NDI sources on the network and it is desirable to avoid 
an increase in traffic, or when multicast transmission is not 
possible or undesirable.

1	Set enable or disable for the external server settings with 
the following menu operation:

[11] Output > 
	 OUTx > Use Discovery server > 

Use Discovery server

Enable External server settings enabled.
Disable External server settings disabled. (Default)

2	Enter the IP address for the external server settings with 
the following menu operation:

[11] Output > 
	 OUTx > Use Discovery server > 

Discovery server IP
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Setting the RTMP output signals

This unit can output a maximum of 2 RTMP signals.

Assign RTMP output signals.

1	Set the output signal type with the following menu 
operation:

[11] Output > 
	 OUTx > Assign

 Refer to “Assigning the output signals”.
2	Set the URL and Stream Key of the server with the 

following menu operation:

[11] Output > 
	 OUTx > Server URL

[11] Output > 
	 OUTx > Stream Key

Server URL URL of the connected server
Stream Key Stream Key of the connected server

	p DNS settings are required in order to resolve the domain 
name of the connected server.

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

3	Set the bit rate control mode for the image format with the 
following menu operation:

[11] Output > 
	 OUTx > Rate Control Mode

CBR Transmission is with the bit rate set in Target bit 
rate.

VBR With the bit rate set in Max bit rate as the 
maximum, transmissions are made to approach 
the bit rate set as the Target bit rate.
The actual bit rate depends on the video being 
transmitted.

4	Set the target bit rate for transmission with the following 
menu operation:

[11] Output > 
	 OUTx > Target bit rate

5	Set the maximum bit rate for transmission with the 
following menu operation (for VBR only):

[11] Output > 
	 OUTx > Max bit rate

Setting the UVC output signals

This unit supports output of UVC (USB Video Class) and UAC 
(USB Audio Class).
By connecting the USB connector (Type C connector) to a 
computer, this unit can be used like a Web camera.

Assign UVC output signals.

Set the output signal type with the following menu operation:

[11] Output > 
	 OUTx > Assign

 Refer to “Assigning the output signals”.

If the output format is changed by changes to the system 
format settings, you will need to restart the app that is 
receiving the UVC images on the computer.

Note
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This unit has 1 headphone connector [  ] (Φ3.5 mm, stereo 
mini jack).

Assign the analog output signals.

1	Set the output signal type with the following menu 
operation:

[15] Ancillary/Audio >
	 Analog OUT > Assign

PGM Outputs the audio data of the selected source.
PVW
AUX1, 2
CLN

2	Adjust the volume with the monitor volume dial.  
Values can be viewed in the following menu:

[15] Ancillary/Audio >
	 Analog OUT > Volume

3	Analog audio output can be muted, irrespective of the 
monitor volume adjustment.  
Set with the following menu:

[15] Ancillary/Audio >
	 Analog OUT > Mute

OFF Audio output not muted.
ON Audio output muted.

The volume value set at 2 is not changed.

Input/output signal settings
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Send operations for SRT/RTMP signals

Start and stop operations for SRT/RTMP signals are performed with the [STREAM] button.

OFF

Hold down  
(1 second) Hold down  

(1 second)

Hold down  
(1 second)

Short press

Short press

Short press
On Air Stand by

OFF The initial setting when the power is turned on. 
Signals are not sent. The [STREAM] button is off.

Stand by Images set for this mode are sent. The [STREAM] 
button lights green.

On Air Images set for this mode are sent. The [STREAM] 
button lights red.

The operation target changes by pressing the [SHIFT] button.

[SHIFT] not pressed IP OUT1
[SHIFT] pressed IP OUT2

The status of IP OUT1/2 can be linked with the following 
menu operation:

[11] Output >
	 OUTx > Streaming Link

Furthermore, you can assign the image signal for Stand by 
during SRT/RTMP output with the following menu operation:

[11] Output >
	 OUTx > Assign STDBY

 Refer to “Assigning the output signals”.
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The sync signals to be used by the system can be selected.
External sync:

For synchronization with an external sync signal  
(gen-lock). 
The reference input signal is looped through and output.

BB Black burst signal (vertical phase of 0H)
Tri-level sync Tri-level sync signal (vertical phase of 0H)
Internal For synchronization with an internal reference 

signal (INT). 
The REFOUT signal (black burst signal) is 
output from the two reference connectors.

	p This unit supports synchronization signals for field 
frequencies that are same as those of the system format.

1	Select the synchronization signal with the following menu 
operation and press the OSD/TIME dial to confirm the 
selected content:

[13] System > 
	 Reference > Sync Select

2	The genlock status is displayed in the following menu:

[13] System > 
	 Reference > Status

Locked Synchronized with the external sync signal or 
internal reference signal.

UnLock Not synchronized with the external sync signal 
or internal reference signal.

Input/output signal settings

Setting the sync signals



88

The phase of the output video signals can be adjusted.

1	Select “0H” or “1H” with the following menu operation:

[13] System > 
	 Output Phase > System

0H The output video signals are output to the 
system Reference signal with using in-phase. 
The frame synchronizer function is ON for all 
input signals. 

1H The output video signals are output to the 
system Reference signal with 1H delay. 
When the frame synchronizer function is ON, the 
output video signals are output with  
1 frame + 1H delay.

2	Adjust H phase with the following menu operation:

[13] System > 
	 Output Phase > H-Phase

H-Phase can be adjusted within a range of –0.50H to 
+0.49H.

	p The setting displayed on the menu differs depending on 
the system format.

3	Adjust V phase with the following menu operation:

[13] System > 
	 Output Phase > V-Phase

V-Phase can be adjusted within a range of –100H to 
+100H.

Input/output signal settings

Adjusting the output signal phase
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Input/output signal settings

Ancillary settings for the AUX bus, PGM, and PVW
Set the function that passes through the V ancillary data and 
embedded audio data of the SDI/HDMI input signal.

Setting for the output signals of the AUX buses (AUX1, 
AUX2)

1	Select ON/OFF with the following menu operation:

[13] Ancillary/Audio > 
	 Ancillary > AUX

OFF The ancillary data and embedded audio of the 
AUX bus (AUX1, AUX2) outputs are not passed 
through.

ON The ancillary data and embedded audio of the 
AUX bus (AUX1, AUX2) outputs are passed 
through.

Setting for the program output signals

2	Select ON/OFF with the following menu operation:

[13] Ancillary/Audio > 
	 Ancillary > PGM

OFF The ancillary data and embedded audio of the 
PGM outputs are not passed through.

ON The ancillary data and embedded audio of the 
PGM outputs are passed through.

Setting for the preview output signals

3	Select ON/OFF with the following menu operation:

[13] Ancillary/Audio > 
	 Ancillary > PVW

OFF The ancillary data and embedded audio of the 
PVW outputs are not passed through.

ON The ancillary data and embedded audio of the 
PVW outputs are passed through.

Setting for clean output signals

4	Select ON/OFF with the following menu operation:

[13] Ancillary/Audio > 
	 Ancillary > CLN

OFF The ancillary data and embedded audio of the 
CLN outputs are not passed through.

ON The ancillary data and embedded audio of the 
CLN outputs are passed through.

Setting for the output signals of the multi view display

5	Select PGM/PVW/OFF with the following menu operation:

[13] Ancillary/Audio > 
	 Ancillary > MV

PGM The ancillary data and embedded audio of the 
PGM are passed through to all MV outputs.

PVW The ancillary data and embedded audio of the 
PVW are passed through to all MV outputs.

OFF The ancillary data and the embedded audio are 
not passed through any MV outputs.

	p If Key is combined, the audio from them are also 
superimposed.

	p VANC data is not passed if the format of the input signal 
is different to the system format.

Notes
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Input/output signal settings

Audio settings for the AUX bus, PGM, and PVW

Select one audio data of each input signal and make settings for the function for the passing through of each of the output 
signals.
For each output signal, you can select only 1 input signal from the following.
IN1 to 9 The embedded audio in each input signal is passed through.

Analog The audio data of the audio input connector is passed through.

Follow Video The embedded audio in input signals selected by a bus is passed through.

OFF The embedded audio is not passed through.

The ancillary settings for each bus should be switched ON to enable this function.

Audio setting for the output signals of the AUX buses 
(AUX1, AUX2)

1	Set the input signal that will pass through the audio data 
with the following menu operation:

[15] Ancillary/Audio >
	 Audio Assign > AUX1

[15] Ancillary/Audio >
	 Audio Assign > AUX2

Audio setting for the program output signals

2	Set the input signal that will pass through the audio data 
with the following menu operation:

[15] Ancillary/Audio >
	 Audio Assign > PGM

Audio setting for the preview output signals

3	Set the input signal that will pass through the audio data 
with the following menu operation:

[15] Ancillary/Audio >
	 Audio Assign > PVW

Audio setting for clean output signals

4	Set the input signal that will pass through the audio data 
with the following menu operation:

[15] Ancillary/Audio >
	 Audio Assign > CLN
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Setting the multi view display

Setting the screen layout

You can select one of the following 10 patterns for the screen layout.
The multi view display of this unit supports MV.

4Split 5-aSplit 5-bSplit 6-aSplit 6-bSplit
9Split 10-aSplit 10-bSplit 12Split 16Split

Display of the following signals can be assigned to sub screens 1 to 16.

Signals that can be assigned
IN1 to 9, Black, CBGD1, CBGD2, CBAR, Still1V, Still1K, Still2V, Still2K, PGM, PVW, CLN, Key Out, AUX1, AUX2, Clock, Analog IN, IP 
OUT1, IP OUT2*1

*1  The status is displayed if IP OUT1(OUT4) or IP OUT2(OUT5) is set to SRT or RTMP.
Unlike the encoding for images, the displayed bitrate is calculated with the priority on the display interval. This means that 
there will be cases where there will be a different value to the output setting.

1	Set the split display mode with the following menu operation:

[9] MultiView >
	 Split

2	Set the size mode of the split screen with the following menu operation:

[9] MultiView >
	 Size

Fit The sizes of the split frame and the split screen will be the same.
SQ The sizes of the split frame and the split screen will be smaller, and the material name, level meter, etc., 

are displayed on the outside of the split screen.

3	Set the signal name to be displayed on the sub screens (1 to 16) with the following menu operation:

[9] MultiView >
	 Source Select

	p When input signals (IN1 to 9) are selected, the display of the material names set in the following menus depends on the 
characters and symbols:

[10] Input >
	 INx > Name Type

[10] Input >
	 INx > Name

	p When AUX buses (AUX1, AUX2) are selected as the input signal, the material name displayed inside [  ] depends on the 
characters and symbols.
	p When the AUX bus for which “MV” has been selected is displayed on the sub screen of the multi view display, the images 
are looped as if two mirrors were facing each other.
	p 12 split frames cannot be selected for 720p.
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<Display modes>
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53 4 21

53 4
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64 53 21

64 53
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3 4 5 6

7 8 9 10

2

21

653 4 7

11108 9 12

1 2 3 4

5 6 7 8

9 10 11 12

13 14 15 16

9Split 10-aSplit 10-bSplit 12Split 16Split

Setting the multi view display
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Setting the multi view display

Setting the split frame and characters

Set the frame, character brightness and background of the 
split screens to be displayed on the multi view display.

1	Set the brightness of the split frame and the display of the 
split frame with the following menu operation:

[9] MultiView > 
	 MV Frame

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Select one of these settings for the brightness of 
the split frame (gray scale).

Off The split frame is not displayed.

2	Set the brightness of the characters and the display of the 
characters with the following menu operation:

[9] MultiView > 
	 MV Character

LUM0%, 
LUM25%, 
LUM50%, 
LUM75%, 
LUM100%

Select one of these character (gray scale) 
brightness settings.

Off The characters are not displayed. 
Neither is the character background shown.

3	Set the character background (half tone) display with the 
following menu operation:

[9] MultiView > 
	 MV Label

On The character background is displayed.
Off The character background is not displayed.

	p This is enabled when Fit mode is on.

Setting the tally displays

Set the tally displays to be superimposed onto the split frame 
of the multi view display.
You can set 2 tally groups on this unit, and you can set 
materials for each of the groups.
The red tally and the green tally can be displayed on the multi 
view display.

1	Select the material to assign to the red tally and the green 
tally with the following menu operation:

[13] System > 
	 Tally Settings > Tally Target > Red Tally

[13] System >
	 Tally Settings > Tally Target > Green Tally

Off No signal
PGM Program video signal
PVW Preview video signal
CLN Clean signal
KeyOut Key output signal
AUX1 AUX1 bus output signal
AUX2 AUX2 bus output signal
IP OUT1 IP OUT1 output signal
IP OUT2 IP OUT2 output signal

2	Display the following menus:

[9] MultiView > 
	 Red Tally

[9] MultiView > 
	 Green Tally

	p The red tally and green tally set in  above can be set 
to display on the multi view display.

3	Set the tally displays to be superimposed onto the split 
frame of the multi view display.

IN1Label Left Label 
Right

Box

On Tally displays are displayed.
Off No tally displays are shown.
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Setting the multi view display

Changing the material names (input signal)

The material names of the input signals (IN1 to 9) to be set on 
the multi view display can be changed.
These names can be selected from the default settings or 
user settings.

1	Select the material name type with the following menu 
operation:

[10] Input > 
	 INx > Name Type

Default
(default settings)

The following material names are selected 
automatically.  
IN1 to 9

User
(user settings)

The material names are set using up to 
32 characters.

User type setting procedure

1	Set the material name type to “User” with the following 
menu operation:

[10] Input > 
	 INx > Name Type

2	Enter the material name with the following menu operation:

[10] Input > 
	 INx > Name

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Changing the material names (output signal)

The material names of the output signals (AUX1, AUX2) to be 
set on the multi view display can be changed.
These names can be selected from the default settings or 
user settings.

Select the material name type for AUX1 and AUX2 with the 
following menu operation:

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

Default
(default settings)

The following material names are selected 
automatically.  
AUX1, AUX2

User
(user settings)

The material names are set using up to 
32 characters.

User type setting procedure

1	Set the material name type to “User” with the following 
menu operation:

[12] Config > 
	 AUX Name > AUX1 Type

[12] Config > 
	 AUX Name > AUX2 Type

2	Enter the material name with the following menu operation:

[12] Config > 
	 AUX Name > AUX1 Name

[12] Config > 
	 AUX Name > AUX2 Name

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \

Setting the level meters

You can display in each split screen the level meters for audio 
signals transmitted together with each input and output.

Left display: Channel 1 of group 1
Right display: Channel 2 of group 1

Set the level meter display with the following menu operation:

[9] MultiView > 
	 Display > Level Meter

OFF The level meters are not displayed.
IN ON The level meters for the input signal (including 

the audio input connector) and the color bar are 
displayed.

OUT ON The level meters for PGM/PVW/CLN/AUX are 
displayed.

IN/OUT ON The level meters for the input signal (including 
the audio input connector), the color bar, and 
PGM/PVW/CLN/AUX are displayed.
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Setting the multi view display

Setting the input signal marks

The status of the input signals can be displayed in front of the 
material names displayed on the split screens.

“F” mark:
This appears when the input signals are frozen.

“ ! ” mark:
This appears when no signals are input or when signals 
with different formats are input.
 �When the “F” mark is displayed, the “!” mark is not 

displayed.

Set the input signal status display with the following menu 
operation:

[9] MultiView > 
	 Display > Input Status

On The input signal status is displayed.
Off The input signal status is not displayed.

Setting the markers

Safety markers can be displayed for the multi view materials.

1	Set the marker display with the following menu operation:

[9] MultiView > 
	 Display > Marker

4:3 The markers are displayed using the 4:3 aspect 
ratio.

16:9 The markers are displayed using the 16:9 aspect 
ratio.

Off The markers are not displayed.

2	Set the marker size with the following menu operation:

[9] MultiView > 
	 Display > Marker Size
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System settings

Setting the system format
One system format (input/output signal) can be selected.

Do not change the format during any of the following 
operations:

	p When reading from a memory card or saving to a USB 
memory

	p When restoring data from video memory or saving data 
to internal storage

	p When recording moving images or still images

Select the format with the following menu operation and press 
the OSD/TIME dial to confirm the selected content:

[13] System > 
	 System Format

Assigning signals to the crosspoints

External video input signals and internally generated signals 
can be assigned to crosspoint buttons 1 to 12.
The assign status of crosspoint buttons 1 to 12 are displayed 
on the OSD menu output destination while you are holding 
down the crosspoint buttons 1 to 12.

Changing the current assignment of the signals selected 
by the crosspoint buttons will cause the positions of the 
lit crosspoint buttons to change to correspond with the 
assignment change. The images output at this time will 
remain unchanged.

The table below lists the materials which can be assigned.

Signal
What 

appears on 
the display

Description

IN1 to 9 IN1 to 9 Input 1 to 9
Refer to “Input signal settings” for 
advanced signal assignment.

Black Black Internally generated signal (black)

CBGD1, 
CBGD2

CBGD1, 
CBGD2

Internally generated signal (color 
background)

CBAR CBAR Internally generated signal (color 
bar)

Still1V, 
Still1K, 
Still2V, 
Still2K

Still1V, 
Still1K, 
Still2V, 
Still2K

Still image video memory

CLN CLN CLN (AUX bus and built-in display 
images only)

KeyOut KeyOut KeyOut (AUX bus and built-in 
display images only)

None None No assignment

	p The image will not be changed by pressing any button to 
which “None” is assigned.

The table below lists the default settings.

Button
What appears 

on the 
display

Button
What appears 

on the 
display

XPT1 IN1 XPT7 IN7

XPT2 IN2 XPT8 IN8

XPT3 IN3 XPT9 IN9

XPT4 IN4 XPT10 CBAR

XPT5 IN5 XPT11 CBGD1

XPT6 IN6 XPT12 CBGD2

Setting the crosspoint switching

The timing at which the crosspoints are to be switched can be 
set.
This switching involves the operations of the crosspoint 
buttons and [Cut] button.

Select the timing for switching with the following menu 
operation:

[8] XPT Assign > 
	 Switch Timing

Any The crosspoints are switched in the nearest 
field. This is suited to live applications.

Field1 The crosspoints are switched in field 1. 
This is suited to editing applications.

Field2 The crosspoints are switched in field 2. 
This is suited to editing applications.

Setting the crosspoints
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System settings

Button assignments

Setting the user buttons

The user can assign several functions which can be set using 
the menu items into six user buttons (U1 to U6).
The user buttons light in amber when the assigned function is 
ON and are off when the assigned function is OFF. 
Each time the user button is pressed, the function setting 
alternates between ON and OFF.

The table below lists the functions which can be assigned to 
the user buttons (U1 to U6).

Function name Description of function
KEY1 PVW Output the KEY1 image to the preview 

output.

KEY2 PVW Output the KEY2 image to the preview 
output.

GPII-EN Enables or disables GPI-In.

GPIO-EN Enables or disables GPI-Out.

AUX TRANS Enables or disables the AUX bus transitions.

AUX1 TRANS Enables or disables the AUX1 bus transitions.

AUX2 TRANS Enables or disables the AUX2 bus transitions.

Effect Dissolve Switches effect dissolve between ON and 
OFF.

None Nothing is assigned.

Shot  
Memory1 to 12

Recalls shot memories 1 to 12.

XPT Disable Enables/disables shot memory XPT Disable.

■ Default settings

Button Function name Button Function name
U1 KEY1 PVW U4 Shot Memory2

U2 KEY2 PVW U5 Shot Memory3

U3 Shot Memory1 U6 Shot Memory4

<Setting method>
Select the functions to assign to the U1 to U6 buttons with the 
following menu operation:

[12] Config >
	 User Button > User 1

[12] Config >
	 User Button > User 2

[12] Config >
	 User Button > User 3

[12] Config >
	 User Button > User 4

[12] Config >
	 User Button > User 5

[12] Config >
	 User Button > User 6
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System settings

Setting the date and time
The user can set the date and time to be used as the USB 
memory’s time stamp. 
Be absolutely sure to set them when an USB memory is to be 
used.

Setting the date

1	Press the OSD/TIME dial in the Date/Time > Date Setting 
menu to set the year, month, and day in that order.

[13] System > 
	 Date/Time > Date Setting

2	While in the day setting state, press the OSD/TIME dial to 
confirm the year, month, and day.

Setting the time

1	Press the OSD/TIME dial in the Date/Time > Time Setting 
menu to set the hours, minutes, and seconds in that order.

[13] System > 
	 Date/Time > Time Setting

2	While in the seconds setting state, press the OSD/TIME 
dial to confirm the hours, minutes, and seconds.
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Proceed with the network settings to perform such tasks as 
updating the software version via LAN.
The network initial setup is: IP address: 192.168.0.8, subnet 
mask: 255.255.255.0. 
When using the host computer with settings matching the 
initial setup, it is not necessary to setup via the menu.

Entering the IP address

Set the IP address with the following menu operation:

[16] Network >
	 LAN > IP Address

Entering the subnet mask

Set the subnet mask with the following menu operation:

[16] Network >
	 LAN > Subnet Mask

Setting the default gateway

Set the default gateway with the following menu operation:

[16] Network >
	 LAN > Default Gateway

Display the MAC address

Display the MAC address with the following menu:

[16] Network >
	 LAN > MAC Address

DNS server settings

Set the primary DNS server and the secondary DNS server 
with the following menu operation:

[16] Network >
	 Primary DNS > IP Address

[16] Network >
	 Secondary DNS > IP Address

	p This is necessary for domain name resolution with SRT or 
RTMP.

	p This will be blank if it is not set.

System settings

Network settings
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System settings

Setting the button illumination

Button illumination

The button indicators can be kept illuminated all the time. 
This will make it easy to see the text printed in the vicinity 
of the buttons, even when you are operating the unit in dark 
places.

1	Make settings for the selected button with the following 
menu operation:

[12] Config > 
	 Button Illumination > Button Illumination > 

Lighting

80% to 150% The button illumination lights. Brightness can be 
adjusted between 80% and 150%.

2	Make settings for the button when the unit is off with the 
following menu operation:

[12] Config > 
	 Button Illumination > Button Illumination > 

XPT Color

Input Set [Color Group1] to [Color Group8] for each of 
the Color Group IN, Color Group Internal, Color 
Group Still, and Color Group Other materials.

Color 
Group1 to 8

8 different colors can be set.

3	Make [R], [G], and [B] settings for button illumination with 
the following menu operation:

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group1

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group2

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group3

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group4

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group5

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group6

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group7

[12] Config > 
	 Button Illumination > Button Illumination > 

Button Color Group8
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Alarm status displays

Alarms that alert about problems with the unit’s power or 
the cooling fan are displayed on the OSD menu output 
destination.

Display the following menus:

[13] System >
	 Alarm > Power

[13] System >
	 Alarm > Fan

[13] System >
	 Alarm > Temperature

The alert status of the power supplies is displayed in the 
Power item.
The alert status of the cooling fan is displayed in the Fan 
item.
The alert status of the internal temperature is displayed in the 
Temperature item.

No Alarm No irregularity
Alarm Irregularity

Alarm message

Messages are displayed on the OSD menu output destination 
when alarms occur.
These messages are displayed only when OSD menus are 
being displayed.

 Alarm message 
displayed Type of trouble Operation

ALARM ! Fan Stop. Shutdown of the 
cooling fan When OK is pressed, 

the alarm message is 
cleared.
 �Contact your dealer 

immediately.

ALARM ! Power 
Stop.

Drop in the supply 
voltage

ALARM ! High 
temperature.

Rise in the 
temperature inside 
the unit

Displaying the version information

Displays the version information for the software and 
hardware of the unit.

Display the following menus:

[13] System >
	 System Information

	p The unit’s system version information is displayed in the 
System Version item.

System settings

Status displays



102

Initializing setting data

Initialization returns the set data to the factory shipment 
status.
When setting data is initialized, the video memory is deleted, 
but the still data and project files saved in the internal storage 
are not deleted.

<Items and data which are not initialized>
	p The items of the menu listed below:

[13] System > 
	 Date/Time

[16] Network

1	Press the OSD/TIME dial (Execute) in the following menu 
to initialize.

[13] System > 
	 Initial > Initial Settings

2	To initialize, operate the OSD/TIME dial to press “YES”.
	p To cancel, operate the OSD/TIME dial to press “NO”.

Initializing fader

The range for executing a transition can be initialized by 
operating the fader lever.
Initialization should be performed when transitions are not 
completed to the end even when the fader lever has been 
moved as far as it will go.

1	Press the OSD/TIME dial (Execute) in the following menu 
to initialize.

[13] System > 
	 Initial > Initial Fader

2	To initialize, operate the OSD/TIME dial to press “YES”.
	p To cancel, operate the OSD/TIME dial to press “NO”.

System settings

Initialization
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Remote camera link functions
It is possible to connect a maximum of 9 remote cameras to this unit via LAN and remote control them.
For compatibility with remote camera products that can be connected, refer to the AV-HSW10 page on the following website:

https://pro-av.panasonic.net/en/

 Examples of connections

SDI/HDMI video 
signals

Switching hub

LAN cables

Compact Live Switcher
AV-HSW10

Monitor 1

Monitor 2

Monitor Monitor

LAN cables

Remote camera controller

External DC 
power supply

External DC 
power supply

LAN connector

Remote camera (maximum 9)

	p Use a GbE compatible switching hub and Cat5e or better STP LAN cables for the connection between the unit and the remote 
cameras.

	p Furthermore, use a network design so that the IP addresses for the unit and the remote cameras are within the same subnet.
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Remote camera link functions
The control functions for the remote cameras connected to this unit are as follows:

	p IP address automatic detection
	p It is possible to tally control connected remote cameras linked to the tally status of this unit

Settings for connections to remote cameras

Selecting the terminals for remote camera 
connection

Select the input signal to which the remote camera is 
connected from the following menu:

[10] Input

	p The following remote camera settings are possible 
according to the input to IN1 to 9.

IP address settings

To set automatically

You can scan for the IP addresses set in the connected 
remote cameras and set them in this unit.

Execute the following menu to scan the IP addresses of 
connected remote cameras:

[10] Input >
	  INx > Camera Setting > Scan IP Address

	p The scan results are displayed in the list of the IP address 
item.

[10] Input > 
	 INx > Camera Setting > IP Address

	p When “Select From List” is displayed, use OSD/TIME 
dial and select the IP address of the connected remote 
camera in the IP address item.
	p “Not Detected” is displayed if the IP address of the 
remote camera could not be detected.
	p Modify the IP address of the unit or the remote camera 
and set so that there is no duplication.
	p The “Duplicate IP Address Detected. (ErrNo = – 650)” 
error message is displayed if the IP address of the 
remote camera is duplicated.

To set manually

You can directly set the IP addresses set in the connected 
remote cameras in this unit.

Execute the following menu to enter the IP addresses of 
connected remote cameras:

[10] Input > 
	 INx > Camera Setting > Edit IP Address

Remote camera port settings

Set the ports of connected remote cameras with the following 
menu operation:

[10] Input > 
	 INx > Camera Setting > Port

Remote camera authentication settings
1	Execute the following menu to set the user name used for 

authentication with connected remote cameras:

[10] Input > 
	 INx > Camera Setting > Edit User Name

2	Execute the following menu to set the password used for 
authentication with connected remote cameras:

[10] Input > 
	 INx > Camera Setting > Edit Password

<Characters which can be used for filenames>
A to Z, a to z, 0 to 9, space, 
! # $ % & ' ( ) @ ^ ` _ { } - * = [ ] ; , . + | ~ : ? < > \
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Remote camera link functions

Checking the remote camera connection 
status
1	The camera names set on the remote cameras are 

displayed in the following menu:

[10] Input > 
	 INx > Camera Setting > Name

2	The IP connection status of the unit and the remote 
cameras is displayed in the following menu:

[10] Input > 
	 INx > Camera Setting > Network Status

No IP Address The IP address of the camera has not been 
entered in the Input menu.

Now 
Checking…

The unit and the remote camera are 
communicating.

Connected The unit and the remote camera are 
connected.

Unauthorized Authentication information has not been 
entered or is incorrect.

Not Connected There is a communication error.

Remote camera tally control settings

You can link the red and green tally controls of remote 
cameras connected to this unit to the red and green tally 
controls of this unit.

1	Set the link between the red tally control on this unit 
and the red tally control on the remote camera with the 
following menu operation:

[10] Input > 
	 INx > Camera Setting > Red Tally

Enable Linked.
Disable Not linked.

2	Set the link between the green tally control on this unit 
and the green tally control on the remote camera with the 
following menu operation:

[10] Input > 
	 INx > Camera Setting > Green Tally

Enable Linked.
Disable Not linked.
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External interfaces

Setting the GPI I/O
The user can set the functions that are to be controlled from 
the GPI ports and set whether to enable the control.

1	Set enable (On) and disable (Off) for the controls to 
perform from the ports with the following menu operation:

[12] Config > 
	 GPI > GPI-In Setting > GPI-In Enable

[12] Config > 
	 GPI > GPI-Out Setting > GPI-Out Enable

2	Set the AUX bus notifying the tally with the following menu 
operation:

[12] Config > 
	 GPI > GPI-In Setting > AUX Sel

[12] Config > 
	 GPI > GPI-Out Setting > AUX Tly Sel

3	Assign functions to each of the pin numbers with the 
following menu operation:

[12] Config > 
	 GPI > GPI-In Port > Port1 Assign

[12] Config > 
	 GPI > GPI-In Port > Port2 Assign

[12] Config > 
	 GPI > GPI-In Port > Port3 Assign

[12] Config > 
	 GPI > GPI-In Port > Port4 Assign

[12] Config > 
	 GPI > GPI-In Port > Port5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 1 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 2 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 3 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 4 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 5 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 6 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 7 Assign

[12] Config > 
	 GPI > GPI-Out Port > Port 8 Assign

 �Refer to “Control using the GPI Input port” and “Output 
from the GPI Output port”.

	p Settings for the GPI-In Enable (or GPI-Out Enable) item 
can be assigned to one of the user buttons.
 Refer to “Setting the user buttons”.



107

External interfaces
	w Control using the GPI Input port

Assign Item Description of function assigned Control method
KEY 1/2 ON KEY1, KEY2 button in transition area

Operations are performed using 
contact inputs (30 ms or more).

FTB ON FTB button in transition area

BKGD AUTO AUTO button when the background is selected

BKGD CUT CUT button when the background is selected

KEY1 AUTO AUTO button when the key is selected

KEY1 CUT CUT button when the key is selected

REC Still1 Still1 recording

REC Still2 Still2 recording

AUX XPT1 to 12 Crosspoint buttons (1 to 12) used to switch the AUX buses.
 �Select the AUX buses (AUX1, AUX2) to be controlled using the 

menu.

RTly DSBL Red tally signal is not output
Functions are enabled using contact 
inputs (or disabled in open status).GTly DSBL Green tally signal is not output

AUXTly DSBL AUX tally signal is not output

No Assign No function assigned

	w Output from the GPI Output port

Assign Item Description of function assigned Output
CUT Cut transition executed

Low pulses are output  
(approx. 50 to 60 ms).

KEY1 ON, KEY2 ON Key1, 2 transition start

FTB ON FTB transition start

BKGD CUT Cut transition for the background executed

KEY1 CUT Cut transition for a key1 executed

AUTO Auto transition execution in progress

A low level is output.BKGD AUTO Auto transition execution in progress for background

KEY1 AUTO Auto transition execution in progress for key1

RTly SDI IN1 to 4 Red tally for SDI IN1 to IN4

A low level is output during tally 
output.

RTly HDMI IN1, 2 Red tally for HDMI IN1, 2

RTly IP IN1 to 4 Red tally for IP IN1 to IN4

GTly SDI IN1 to 4 Green tally for SDI IN1 to IN4

GTly HDMI IN1, 2 Green tally for HDMI IN1, 2

GTly IP IN1 to 4 Green tally for IP IN1 to IN4

AUXTly SDI IN1 to 4 When SDI IN1 to IN4 have been selected by the AUX bus*
A low level is output while the inputs 
are selected.AUXTly HDMI IN1, 2 When HDMI IN1, 2 have been selected by the AUX bus*

AUXTly IP IN1 to 4 When IP IN1 to IN4 have been selected by the AUX bus*
No Assign No function assigned

*: Select the AUX buses (AUX1, AUX2) whose signals are to be output using the menu.
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Com

GPI Out
ALARM Out

Example of GPI Out and ALARM connections
Ensure that the conditions given below are satisfied.

Dielectric strength:	Max. DC 24 V
Current:	 Max. 50 mA

AV-HSW10 (Max. voltage: 24 V)

Tally LED(Max. current: 50 mA)
Com

GPI In

+3.3 V

Example of GPI In connections
Provide contact inputs.

AV-HSW10

TALLY/GPI

12345

12 11 10

678

15 14 13 9

Pin No. Signal name
1 GPI-Out1

9 GPI-Out8

2 GPI-Out2

10 GPI-In1

3 GPI-Out3

11 GPI-In2

4 GPI-Out4

12 GPI-In3

5 GPI-Out5

13 GPI-In4

6 ALARM Out

14 GPI-In5

7 GPI-Out6

15 GPI-Com

8 GPI-Out7

LAN

Connect the unit and computer or the unit and an external device*.
*:	� An external device can be controlled from the unit.

	p Use a CAT5E or better, straight or crossover STP (Shielded Twisted Pair) LAN cable, maximum 100 m (328 ft).
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Controlling with external panels

With this unit, you can perform the following operations from external panels (*) connected via an IP network:
	p Select materials for each bus
	p Execute video transitions
	p Play back shot memories
	p Crosspoint selection for each bus

*: �This unit supports the LBP series from LAWO. Consult LAWO for LBP series settings and operations.

Preparations

Use a LAN cable to connect the external panel to the LAN 
connector on the back of the unit.
It is possible to connect a maximum of 20 external panels. 
When connecting multiple external panels, connect via a hub.

Turning ON/OFF external panels and this unit
Take note of the following points when turning ON/OFF or 
restarting the devices.

	p If the external panel cannot be connected even after 
3 minutes or more have elapsed since restarting this 
unit, restart the external panel.

	p If an external panel is to be turned off while this unit is 
running, first set the following item to “Disable”, then 
turn off the external panel.

[17] External Interfaces >
	 External Panel Information > Active

Notes

External panel settings

Check the following settings on this unit, then make the 
settings on the connected external panels:

	p Set the address value set in the following item to the IP 
address of the device that is to be controlled by the external 
panel:

[16] Network >
	 LAN > IP Address

	p Set the port number set in the following item to the port 
number of the device that is to be controlled by the external 
panel:

[17] External Interfaces >
	 External Panel Information > Port No

Also set the subnet mask and the default gateway in the 
following menus according to the network environment 
connected:

[16] Network >
	 LAN > Subnet Mask

[16] Network >
	 LAN > Default Gateway

Settings on this unit when external panels 
are connected

Receiving port number settings

1	Set enable/disable for external panel functions with the 
following menu operation:

[17] External Interfaces >
	 External Panel Information > Active

2	Set the receiving port number used by this unit with the 
following menu operation:

[17] External Interfaces >
	 External Panel Information > Port No

Possible setting range 62000 to 65535
Default value 62010
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Shot memory playback target settings

Set the playback targets for when shot memories of this unit 
are played back by operations on the external panels.

Set the playback targets for the shot memory with the 
following menu operation:

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

BKGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

Key2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX1

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

AUX2

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

CBGD

[17] External Interfaces > 
	 External Panel IP > Shot Memory Recall > 

XPT

	p ME, AUX, color background, and crosspoint area can be 
individually turned ON/OFF.

External interfaces
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List of bus IDs and source IDs

When operations are performed on external panels, crosspoint setting commands are issued that specify the materials (Source) 
for the buses (Destination).
When this unit receives the crosspoint setting command from the external panel, materials are selected and video transitions 
are executed according to the bus and material combinations specified in the command.
This section describes the IDs (numbers) used by this unit to identify each bus and each material.

IDs can be categorized broadly into the following 2 types:

1)	Normal bus IDs and material IDs
IDs that specify the buses inside the switcher (PGM, AUX1, etc.) and the switcher materials (IN1, CBGD1, STILL1-V, etc.).
Use a number between 1 and 512.

2)	Extended bus IDs and extended material IDs
IDs used for playback of video transitions, macro memories, and shot memories.
When this unit receives a crosspoint setting command in which the same extended ID is specified for the bus and the 
material, the corresponding function is executed.
For example, when a command is received that specifies the BKGD AUTO material (ID: 522) for the BKGD AUTO bus (ID: 
522), an AUTO transition is executed.
Use a number between 513 and 1024.

Executable operations Specified bus and material
ME key transition KEY1 AUTO, KEY2 AUTO

ME key transition (CUT) KEY1 CUT, KEY2 CUT

ME AUTO transition BKGD AUTO

ME CUT transition BKGD CUT

Playing back shot memory registered memories SHOTPLAY1 to SHOTPLAY12

Crosspoint selection for each bus XPT1 to XPT12

	p Consult LAWO for details on how to assign IDs to the operations of each of the buttons on the LBP series.

Settings for the external panel (LBP series from LAWO) used as the external interface (ExtPanel)
Take note of the following points when connecting multiple (2 or more) external panels.

	p When creating configuration data for multiple external panels, create the data within the same .snap file.
	p For each external panel to be used, use the same parameter settings, with just the name of the router to be different.

If you do not take the above measures and make settings for the extended bus IDs/extended source IDs 810 to 821 (XPT1 to 
XPT12) of the control IDs on multiple external panels, the external panels may not work correctly.

Notes
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Bus ID

ID Bus ID Bus ID Bus ID Bus ID Bus
1 PGM 112 – 152 – 160 MV-8 168 MV-16
2 PVW 113 AUX1 153 MV-1 161 MV-9 169 –
3 KEY1-F 114 AUX2 154 MV-2 162 MV-10 …

4 KEY1-S 115 – 155 MV-3 163 MV-11 512 –

5 KEY2-F … 156 MV-4 164 MV-12
6 KEY2-S 149 – 157 MV-5 165 MV-13
7 – 150 VMEM-V 158 MV-6 166 MV-14

… 151 VMEM-K 159 MV-7 167 MV-15
–: Unused ID

Source ID
ID Source ID Source ID Source ID Source ID Source
1 IN1 … … 201 PGM 232 IP OUT2
2 IN2 144 – 164 – 202 – 233 –
3 IN3 145 CBGD1 165 MV 203 PVW …

4 IN4 146 CBGD2 166 – 204 – 250 –

5 IN5 147 CBAR … … 251 CLOCK
6 IN6 148 Black 170 – 226 – 252 –
7 IN7 149 STILL1V 171 Key Out 227 AUX1 …

8 IN8 150 STILL1K 172 CLN 228 AUX2 512 –
9 IN9 151 STILL2V 173 – 229 –
10 Analog IN 152 STILL2K … 230 –
11 – 153 – 200 – 231 IP OUT1

–: Unused ID

Extended bus ID
ID Bus ID Bus ID Bus ID Bus ID Bus

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9

515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11

517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Disabled ID (-1) sent

Extended Source ID	
ID Source ID Source ID Source ID Source ID Source

513 – 522 BKGD AUTO 714 SHOTPLAY5 … 817 XPT8
514 KEY1 AUTO 523 BKGD CUT 715 SHOTPLAY6 809 – 818 XPT9
515 KEY2 AUTO 524 – 716 SHOTPLAY7 810 XPT1 819 XPT10
516 – … 717 SHOTPLAY8 811 XPT2 820 XPT11
517 – 709 – 718 SHOTPLAY9 812 XPT3 821 XPT12

518 KEY1 CUT 710 SHOTPLAY1 719 SHOTPLAY10 813 XPT4 822 –
519 KEY2 CUT 711 SHOTPLAY2 720 SHOTPLAY11 814 XPT5 …

520 – 712 SHOTPLAY3 721 SHOTPLAY12 815 XPT6 1024 –
521 – 713 SHOTPLAY4 722 – 816 XPT7

–: Unused ID
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External Control

<Overview>
It is possible to switch the materials of all buses on the unit 
and transmit and receive the material name information of 
all buses on this unit with external devices connected to the 
network such as system controllers and tally interfaces.
It is also possible to switch the Key Signal Coupling settings 
from external devices.
It is possible to transmit and receive tally information and 
Source ID information using a transmission format that is 
compatible with TSL UMD Protocol V5.0.
By connecting the AW-RP series Remote Camera Controller 
from Panasonic via IP, it is possible to switch materials, 
transmit Tally information, perform focus assist, and acquire 
material names for the buses of the unit using the AW-RP 
series camera selector.

	p Refer to the operating instructions for AW-RP series for 
information about control bus settings, etc.

<Preparation>
Use a LAN cable to connect the external device to the LAN 
connector on the rear of this unit.
The unit supports 20 IP connections. When connecting to 
multiple external devices, connect via a hub. Set IP address 
so there is no duplication.
Check the network settings for this unit in the following 
menus:

[16] Network >
	 LAN > IP Address

[16] Network >
	 LAN >  Subnet Mask

The initial settings are; IP Address: “192.168.0.50”, Subnet 
Mask: “255.255.255.0”.

<Settings>
1	Set enable/disable for External Control functions with the 

following menu operation:

[17] External Interfaces >
	 External Control Switcher > Active

2	Set the network with the following menu operation:

[17] External Interfaces >
	 External Control Switcher > Port No

3	Set the command transmission interval with the following 
menu operation:

[17] External Interfaces >
	 External Control Switcher > Interval Time

4	Set the sending of change notifications for the 
transmission source with the following menu operation:

[17] External Interfaces >
	 External Control Switcher > Response

On Send a change notification to the transmission 
source.

Off Do not send a change notification to the 
transmission source.

5	Set the IP address of the connected external device with 
the following menu operation:

[17] External Interfaces >
	 External Control AUX Panel > IP AddressXX

6	Set the receiving port number of the connected external 
device with the following menu operation:

[17] External Interfaces >
	 External Control AUX Panel > Port No

	p Set to 60031 when connecting to the Remote Camera 
Controller AW-RP series.

7	Information about the DMSG-CONTROL parameter of the 
TSL UMD Protocol V5.0 commands

Red Tally settings are output when RH tally is output.
Green Tally settings are output when TXT tally is output.

8	The following item needs to be set to “User” if the material 
names are to be changed:

[10] Input >
	 INx > Name Type

<Command specifications>
Refer to the AV-HSW10 external interface communications 
protocol specifications.



114

<Overview>
Multiple cameras can be connected to this unit and switched for use, but as each camera has different color properties, it may 
appear strange when switching. For that reason, you need to perform a matching process so that, after completing individual 
adjustments on each camera, the color properties of the other cameras are matched with the master camera. This function is 
provided as a way to perform the adjustments on this unit in order to simplify color property matching.

<Settings>
1	Use the functions of the cameras to make adjustments on 

each individual camera. This is not a function of this unit. 
Refer to the operating instructions, etc., of the device being 
used.

2	Decide a master camera, match the 24 points on the 
Macbeth chart with the markers, or match the markers, 
then record.

	p It is anticipated that a Macbeth chart will be used with 
this function, but other color charts can also be used.

3	Successively match the other cameras with the 24 points 
of the Macbeth chart as you did with the master camera, 
then use the master camera recording to calibrate.

	p The parameters are determined by comparing the 
extracted 24 points with each other, but a characteristic 
of the calibration process means that it will not be an 
absolute match. Calibrations are made so that the 
overall variation after calibration is reduced to the 
minimum.
	p If the camera settings are readjusted due to changed 
conditions, etc., you will need to run this function 
again. For this reason, we recommend turning OFF the 
automatic adjustment functions of the cameras.

Automatic color tone adjustment
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Master camera recording

1	Select the target input with the following menu operation:

[19] Color Adjust > 
	 Target

2	Display a marker on the target input with the following 
menu operation:

[19] Color Adjust > 
	 Marker

3	Set the marker position with the following menu operation:

[19] Color Adjust > 
	 Left

[19] Color Adjust > 
	 Top

[19] Color Adjust > 
	 Bottom

[19] Color Adjust > 
	 Right

[19] Color Adjust > 
	 Set capture points

Left Specify the left edge of the area where the point 
is to be generated.

Top Specify the upper edge of the area where the 
point is to be generated.

Bottom Specify the lower edge of the area where the 
point is to be generated.

Right Specify the right edge of the area where the 
point is to be generated.

Set capture 
points

24 points are generated in the specified area in 
a vertical 6 × horizontal 4 pattern.

 

Left, Top 

Bottom, Right 

4	Adjust the marker positions with the following menu 
operation:

[19] Color Adjust > 
	 Points > Point x

5	Select the place to record the color of the marker position 
with the following menu operation:

[19] Color Adjust > 
	 Parameter No

6	Press the OSD/TIME dial (Execute) in the following menu 
to record in the selected place:

[19] Color Adjust > 
	 Capture for Master

	p If there is already a recording, it is overwritten.
7	Set a name in the recording with the following menu 

operation:

[19] Color Adjust > 
	 Parameters > Parameter x > Name

Calibrating the other cameras
1	Select the target input with the following menu operation:

[19] Color Adjust > 
	 Adjust Target

2	Match markers.
 Refer to  to  in “Master camera recording”.

3	Select the recording of the master camera that will be 
used as the calibration reference with the following menu 
operation:

[19] Color Adjust > 
	 Parameter No

4	Press the OSD/TIME dial (Execute) in the following menu 
to make the color adjustments:

[19] Color Adjust > 
	 Adjust Target

	p [19] Color Corrector > Enable Color Adjust is 
automatically changed to “Enable” at this time. Change 
to “Disable” to disable the calibration.

Automatic color tone adjustment



116

Appearance
Unit: mm (inch)

SIGNAL GND
L/1 R/2 ON2 1 4 3 2 1

AUDIO IN

BOOT

NM SV
STREAM

OUT

LAN TALLY/GPI USB

2 1

HDMI OUT HDMI IN

REF SDI OUT SDI IN POWER

POWER

AMB:F
GRN:S

PGM

PST

AUX

ALARM STREAM

KEY 1 KEY 2
AUX BUS DELEGATION AUX SOURCE

AUX 1 AUX 2 MV

USER 1 4

1 7 2 8 3 9 4 10 5 11 6 12

USER 2 5 USER 3 SHOT MEM EXIT

FTB ON

KEY 1 ON

CUT

AUTO 

BKGD

KEY 2 ON

MENU6

PGM PVW

SHIFT

SHIFT

SHIFT

SHIFT

B

A

MIX

WIPE

U
S
B

LEVEL

175 (6-7/8)

254 (10)

67 (2-5/8)
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Power supply: DC  16 V Dedicated AC Adaptor
Current consumption:	3.0 A (48 W)

 indicates safety information.

General
Ambient operating 
temperature

0 °C to 40 °C (32 °F to 104 °F)

Ambient operating 
humidity

10 % to 90 % (no condensation)

Storage temperature 0 °C to 40 °C (32 °F to 104 °F)
Storage humidity 10 % to 90 % (no condensation)
Mass Approx. 1.8 kg (3.96 lbs.)
Dimensions
(W × H × D)

254 mm × 67 mm × 175 mm (10 inches × 2-5/8 inches × 6-7/8 inches) (excluding protrusions)

Video connectors
<SDI IN 1> to <SDI IN 4> 
terminals

4 lines
	p Connectors: BNC × 4
	p Equipped with frame synchronizer.
	p Connectors <SDI IN 1> and <SDI IN 2> have simplified format converters, <SDI IN 3> and <SDI 
IN 4> have high-performance format converters.

	p Connectors <SDI IN 1> to <SDI IN 4> are equipped with simplified color correctors.
*  SDI IN 1 excludes HDMI IN 1.
3G-SDI 3G-SDI, complied with SMPTE424M standard (Compatible with Level-A/Level-B)

	p 0.8 V [p-p] ± 10 % (75 Ω)
	p Automatic equalizer 100 m (when using a cable)

HD-SDI HD-SDI, complied with SMPTE292M standard
	p 0.8 V [p-p] ± 10 % (75 Ω)
	p Automatic equalizer 100 m (when using a cable)

<HDMI IN 1>, <HDMI IN 
2> terminals

2 lines, HDMI1.4b compatible
Video format inputs:
720p/59.94 Hz, 720p/50 Hz, 1080i/59.94 Hz, 1080i/50 Hz, 1080p/59.94 Hz, 1080p/50 Hz, 
1080p/29.97 Hz, 1080p/25 Hz, 1080p/24 Hz, 1080p/23.98 Hz
PC format inputs:
WSXGA+ (1680 × 1050, 60 Hz), SXGA (1280 × 1024, 60 Hz), WXGA (1280 × 768, 60 Hz), 
XGA (1024 × 768, 60 Hz)
Mode: Full/Fit-H/Fit-V 

	p Equipped with frame synchronizer and simplified color corrector.
	p The HDMI IN 2 connector has a scaler function.
	p Connectors: HDMI × 2
	p This connector does not support the CPRM technologies.

*  HDMI IN 1 excludes SDI IN 1.
<SDI OUT 1>, <SDI OUT  
2> terminals

2 lines
	p Connectors: BNC × 2
	p PGM, PVW, CLN, MV, AUX1/2, and Key Out can be assigned.

3G-SDI 3G-SDI, complied with SMPTE424M standard (Compatible with Level-A)
	p 0.8 V [p-p] ± 10 % (75 Ω)

HD-SDI HD-SDI, complied with SMPTE292M standard
	p 0.8 V [p-p] ± 10 % (75 Ω)

<HDMI OUT> terminal 1 line, HDMI1.4b compatible
	p Connector: HDMI × 1
	p Equipped with scaler function.

Mode: Fit-V, Fit-H, Full, Full-90%, Full-80%
	p PGM, PVW, CLN, MV, AUX1/2, and Key Out can be assigned.
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<LAN> terminal Compatible with 1000Base-T and AUTO-MDIX (for IP signal transmission/control)
	p Connecting cable: LAN cable (CAT5E or more), max. 100 m (328 ft), STP (Shielded Twisted 
Pair) cable recommended

	p Connector: RJ-45
 IP input signal
Assigned to IN 6 to 9.

	p IN 6, IN 7: Selectable from SRT/NDI|HX (version1/version2).
	p IN 8, IN 9: Dedicated to High Bandwidth NDI input.  
Supports NDI α channel input. Used as a pair with IN 9 in this case.

 IP output signal
Assigned to OUT 4 and OUT 5.

	p OUT 4, OUT 5: Selectable from SRT/High Bandwidth NDI/RTMP.
	p PGM, PVW, CLN, MV, AUX1/2, Key Out can be assigned.
	p Equipped with scaler function and i/p conversion function.
	p Possible output formats: 
1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps 
1280 × 720/60fps, 50fps

<USB> terminal Connector for outputting UVC/UAC
Assigned to OUT 6.

	p Connector: USB3.2 Gen1 TypeC, No USB bus power functionality
	p PGM, PVW, CLN, MV, AUX1/2, and Key Out can be assigned.
	p Equipped with scaler function and i/p conversion function.
	p Possible output formats: 
1920 × 1080/60fps, 50fps, 30fps, 25fps, 24fps* 
1280 × 720/60fps, 50fps, 30fps, 25fps, 24fps

*  Planned support with a firmware update
System format 1080/59.94p, 50p, 29.97p, 25p, 24p, 23.98p, 59.94i, 50i

720/59.94p, 50p
Signal processing R:G:B 4:4:4 8bit / 4:2:2 10bit (when HDMI)

Y:Cb:Cr 4:2:2 10bit
ME number 1ME

Audio connectors
<AUDIO IN> terminal 	p L/1 and R/2

	p Connector: Pin jacks
	p Equipped with embedded functionality to each output.
	p Equipped with delay/level adjustment function.

<AUDIO OUT> terminal Connector for headphone monitor
	p Connector: Φ3.5 mm TRS
	p Equipped with output volume adjustment function.

Synchronizing connectors
<REF> terminals  
Reference input

In Genlock mode: Selectable from BB (black burst), Tri-level Sync, and internal synchronization
	p Loop-through output is performed in BB mode and Tri-level Sync mode.
	p If loop-through output is not going to be used, provide a 75 Ω termination.
	p Connectors: BNC×2
	p Same field frequencies as those of the system formats supported.
	p For 23.98 Hz and 24 Hz, only Tri-level input or internal synchronization is supported.

Video delay time 1 line (H) When the frame synchronizer setting is [Off] and neither the up-converter nor 
the down-converter is operating

1 frame (F) When the frame synchronizer setting is on and the up-converter and down-
converter are operating

	p When the signals have passed through PinP, multi view, down-converter or HDMI IN, a 
maximum delay of 1 frame is applied in each case.

Specifications
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Control connectors
<LAN> terminal Compatible with 1000Base-T and AUTO-MDIX (For IP control)

	p Connecting cable: LAN cable (CAT5E), max. 100 m (328 ft), STP (Shielded Twisted Pair) cable 
recommended

	p Connector: RJ-45
<TALLY GPI> terminals INPUT: 5 inputs, general-purpose, photocoupler sensing

OUTPUT: 8 outputs, selected from R/G tally, general-purpose 
ALARM: 1 output, open collector output (negative logic)

	p Connectors: D-Sub 15pin
<USB> terminal 	p Connector: USB2.0/TypeA, with USB bus power functionality

Use a USB memory to save and load configuration files and still data, and perform firmware 
updates.

AC Adaptor

Rated input: �100 V – 240 V AC ( ) 50 Hz/60 Hz 
1.6 A – 0.9 A

Rated output: 16 V DC ( ), 4.06 A

 indicates safety information.
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Setting menu table
No. Sub menu Setting item Setting

1 WIPE 1 BKGD Pattern Setting range Select each pattern (page 34)

Default value 5

2 BKGD 
Transition

Direction Setting range Normal, Reverse, N/R

Default value Normal

Border Setting range
Border

On, Off
Width

0.1 to 100.0

Default value Off 5.0

Setting range
Soft

0.0 to 100.0

Default value 0.0

Border Color
Setting range

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 to 359.9

Default value White 0.0

Setting range
Sat

0.0 to 100.0
Lum

0.0 to 108.0

Default value 0.0 100.0

Position Setting range
X-Position

–100.00 to 100.00
Y-Position

–100.00 to 100.00

Default value 0.00 0.00

3 Key1 Pattern Setting range Select each pattern (page 39)

Default value 5

4 Key1 
Transition

Type Setting range MIX, WIPE

Default value MIX

Keyout Pattern Setting range Normal, Reverse

Default value Normal

Position Setting range X- 
Position

–100.00 to 100.00 Y- 
Position

–100.00 to 100.00

Default value 0.00 0.00

2 CBGD 1 CBGD Select Setting range CBGD1, CBGD2

Default value CBGD1

2 CBGD Main Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Default value Blue, Red

Hue Setting range 0.0 to 359.9

Default value 120.0, 0.0

Sat Setting range 0.0 to 100.0

Default value 100.0

Lum Setting range 0.0 to 108.0

Default value 100.0

3 CBGD Sub Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Default value White

Hue Setting range 0.0 to 359.9

Default value 0.0

Sat Setting range 0.0 to 100.0

Default value 0.0

Lum Setting range 0.0 to 108.0

Default value 100.0

4 CBGD Wash Wash Setting range On, Off

Default value Off

Color Setting range Dual, Rainbow

Default value Dual

Rainbow Sat Setting range 0.0 to 100.0

Default value 100.0

Rainbow Lum Setting range 0.0 to 108.0

Default value 100.0
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2 CBGD 5 CBGD Wave Pattern Setting range Sine, Saw

Default value Sine

Cycle Setting range 0.0 to 100.0

Default value 0.0

Phase Setting range –180.0 to 180.0

Default value 0.0

Angle Setting range 0.0 to 360.0

Default value 0.0

6 CBGD Move Move Setting range Off, Roll, Rotation

Default value Off

Speed Setting range –50.0 to 50.0

Default value 1.0

3 Key 1 Key Select Setting range Key1, Key2

Default value Key1

2 Key Type Setting range Lum (ChromaOff), Lum (ChromaOn), Linear, Chroma, Full

Default value Linear

3 Fill Setting range Bus, Matte

Default value Bus

4 PVW Setting range Off, On

Default value Off

5 Key Adjust Clip Setting range 0.0 to 108.0

Default value 0.0

Gain Setting range 0.0 to 200.0

Default value 100.0

Density Setting range 0.0 to 100.0

Default value 100.0

Invert Setting range On, Off

Default value Off

6 Fill Matte Load Setting range White, Yellow, Cyan, Green, Magenta, Red, Blue, Black

Default value White

Hue Setting range 0.0 to 359.9

Default value 0.0

Sat Setting range 0.0 to 100.0

Default value 0.0

Lum Setting range 0.0 to 108.0

Default value 100.0

7 Edge Type Setting range Off, Border, Drop, Shadow, Outline

Default value Off

Width Setting range 0 to 4

Default value 2

Direction Setting range 0, 45, 90, 135, 180, 225, 270, 315

Default value 0

Density Setting range 25%, 50%, 75%, 100%

Default value 100%

Fill Setting range Color, CBGD1, CBGD2, Still1, Still2

Default value Color
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3 Key 7 Edge Color
Setting range

Load

White, Yellow, Cyan, 
Green, Magenta, Red, 
Blue, Black Hue

0.0 to 359.9

Default value Black 0.0

Setting range
Sat

0.0 to 100.0
Lum

0.0 to 108.0

Default value 0.0 0.0

8 Mask Size Setting range Off, Manual, 4:3

Default value Off

Invert Setting range On, Off

Default value Off

Position Setting range
Left

–50.00 to 50.00
Top

–50.00 to 50.00

Default value –25.00 25.00

Setting range
Bottom

–50.00 to 50.00
Right

–50.00 to 50.00

Default value –25.00 25.00

9 PinP PinP Setting range On, Off

Default value Off

Shape Setting range Square, Circle, Heart, Flower, Star

Default value Square

Density Setting range 0.0 to 100.0

Default value 100.0

Full Key Setting range On, Off

Default value On

Border Setting range
Border

Off, On
Width

0.1 to 100.0

Default value Off 5.0

Setting range
Soft

0.0 to 100.0
Mode

Fix, Variable

Default value 0.0 Fix

Setting range

Color

Load
White, Yellow, Cyan, Green, Magenta, 
Red, Blue, Black

Default value Black

Setting range
Hue

0.0 to 359.9

Default value 0.0

Setting range
Sat

0.0 to 100.0

Default value 0.0

Setting range
Lum

0.0 to 108.0

Default value 0.0

Position Setting range X- 
Position

–100.00 to 100.00 Y- 
Position

–100.00 to 100.00

Default value 0.00 0.00

Setting range
Size

0.00 to 100.00

Default value 25.00
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3 Key 9 PinP Trim Setting range
Trim

Off, On
Pair

Off, On

Default value Off Off

Setting range
Preset

16:9, 12:9, 9:9, 7:9, 6:9, Manual

Default value 16:9

Setting range

Adjust

Left
–50.00 to 50.00

Default value –50.00

Setting range
Top

–50.00 to 50.00

Default value 50.00

Setting range
Bottom

–50.00 to 50.00

Default value –50.00

Setting range
Right

–50.00 to 50.00

Default value 50.00

Sync
Setting range

Symmetry
Off, X, Y, Center, 
Same Copy to 

KEY

Execute

Default value Off

10 Key Signal 
Coupling

Setting range Coupling, Independent

Default value Coupling

11 Key Priority Key Setting range 1st, 2nd

Default value 2nd

4 ChromaKey 1 Marker Setting range On, Off

Default value Off

2 Sample Setting range Execute

Default value Execute

3 Marker 
Position

X-Position Setting range –50.00 to 50.00

Default value 0.00

Y-Position Setting range –50.00 to 50.00

Default value 0.00

Size Setting range 1.00 to 80.00

Default value 10.00

4 Marker Aspect Setting range –50.00 to 50.00

Default value 0.00

5 Ref Adjust Hue Setting range 0.0 to 359.9

Default value 354.0

Sat Setting range 0.0 to 100.0

Default value 100.0

Lum Setting range 0.0 to 108.0

Default value 7.00

6 Y-Influence Setting range 0.0 to 100.0

Default value 0.0

7 Radius Hue Setting range 0.0 to 100.0

Default value 100.0

Sat Setting range 0.0 to 100.0

Default value 50.0

8 Soft Setting range 0.0 to 100.0

Default value 0.0

9 Cancel Setting range 0.0 to 100.0

Default value 0.0
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5 TIME 1 BKGD Setting range 0 to 999 (Frame)

Default value 1s00f

2 Key1 Setting range 0 to 999 (Frame)

Default value 1s00f

3 Key2 Setting range 0 to 999 (Frame)

Default value 1s00f

4 FTB Trans Time Setting range 0 to 999 (Frame)

Default value 1s00f

Source Setting range Still1, Still2, CBGD1, CBGD2, White, Black

Default value Black

Mute Setting range Off, On

Default value Off

5 Effect Dissolve Setting range 0 to 999 (Frame)

Default value 1s00f

6 AUX1 Bus 
Trans

Transition Setting range Off, On

Default value Off

Trans Time Setting range 0 to 999 (Frame)

Default value 1s00f

7 AUX2 Bus 
Trans

Transition Setting range Off, On

Default value Off

Trans Time Setting range 0 to 999 (Frame)

Default value 1s00f

6 Still 1 Still Select Setting range Still1, Still2

Default value Still1

2 Key Status Setting range On, Off

Default value –

3 Capture Setting range Execute

Default value

4 Capture 
Setting

Video Setting range AUX1, AUX2

Default value AUX1

Key Enable Setting range On, Off

Default value On

Key Setting range AUX1, AUX2

Default value AUX1

Review Setting range On, Off

Default value On

5 Test Pattern Load Setting range Execute

Default value

7 Shot Memory 1 Target Select ME Setting range On, Off

Default value On

AUX Setting range On, Off

Default value On

CBGD Setting range On, Off

Default value On

2 Effect Setting range Cut, Dissolve

Default value Dissolve

3 Hue Path Setting range Short, Long, CW, CCW

Default value Short

4 XPT DSBL Setting range Off, On

Default value Off
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8 XPT Assign 1 XPT1
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN1

2 XPT2
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN2

3 XPT3
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN3

4 XPT4
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN4

5 XPT5
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN5

6 XPT6
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN6

7 XPT7
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN7

8 XPT8
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN8

9 XPT9
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value IN9

10 XPT10
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value CBAR

11 XPT11
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value CBGD1

12 XPT12
Setting range

IN1 to 9(**********), Black, CBGD1, CBGD 2, CBAR, Still1V, 
Still1K, Still2V, Still2K, CLN, Key Out, None

Default value CBGD2

13 Switch Timing Setting range Any, Field1, Field2

Default value Any
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9 MultiView

**********: 
Name of the 
currently set 
material

1 Split
Setting range

4Split, 5-aSplit, 5-bSplit, 6-aSplit, 6-bSplit, 9Split, 10-aSplit, 
10-bSplit, 12Split, 16Split

Default value 10-aSplit

2 Size Setting range Fit, SQ

Default value SQ

3 Source Select Pos1 Source

Setting range

IN1 to 9 (**********),
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value PGM

Pos2 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value PVW

Pos3 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN1

Pos4 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP-OUT1, IP-OUT2

Default value IN2

Pos5 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN3

Pos6 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN4

Pos7 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN5

Pos8 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN6

Pos9 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN7

Pos10 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN8
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9 MultiView

**********: 
Name of the 
currently set 
material

3 Source Select Pos11 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value IN9

Pos12 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value Still1V

Pos13 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value Still2V

Pos14 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value CBAR

Pos15 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value CBGD1

Pos16 Source

Setting range

IN1 to 9 (**********), 
CBAR, CBGD1, CBGD2, Still1V, Still1K, Still2V, Still2K, PGM, 
PVW, CLN, Key Out, AUX1, AUX2, MV, Clock, Black, Analog 
IN, IP OUT1, IP OUT2

Default value CBGD2

4 MV Frame Setting range LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Default value LUM75%

5 MV Character Setting range LUM0%, LUM25%, LUM50%, LUM75%, LUM100%, Off

Default value LUM75%

6 MV Label Setting range On, Off

Default value On

7 Red Tally Box Setting range On, Off

Default value Off

Label Left Setting range On, Off

Default value Off

Label Right Setting range On, Off

Default value Off

8 Green Tally Box Setting range On, Off

Default value Off

Label Left Setting range On, Off

Default value Off

Label Right Setting range On, Off

Default value Off
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9 MultiView 9 Display Level Meter Setting range OFF, IN ON, OUT ON, IN/OUT ON

Default value OFF

Input Status Setting range On, Off

Default value On

Marker Setting range 4:3, 16:9, Off

Default value Off

Marker Size Setting range 80 to 100%

Default value 95%

Upper layer
No. Sub menu Setting item Setting

10 Input 1 IN1(SDI1/
HDMI1)

Display only
Menu for the 
next layer

Moves to lower layer A

2 IN2(SDI IN2)

3 IN3(SDI IN3)

4 IN4(SDI IN4)

5 IN5(HDMI IN2)

6 IN6(IP IN1) Moves to lower layer B

7 IN7(IP IN2)

8 IN8(IP IN3)

9 IN9(IP IN4)

Lower layer A
No. Sub menu Setting item Setting

SDI1/HDMI1 1 SDI/HDMI Setting range SDI, HDMI

Default value SDI

SDI IN XX 2 Status Format
Display only

Audio

3 FS Mode Setting range Off, Normal, Auto

Default value Auto

4 FS Delay
Setting range

0F to 6F
 SDI IN1 is 0F to 2F.

Default value 0F

5 Freeze Setting range Disable, Enable

Default value Disable

6 Freeze Select Setting range Frame, Field

Default value Frame

7 Name Type Setting range Default, User

Default value Default

8 Name Setting range 32 characters can be set.

Default value

9 Up/Down 
Converter

Move Detect Setting range 1 to 5

Default value 5

Sharp Setting range 1 to 5

Default value 3
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SDI IN XX 10 Color Correct C/C Setting range On, Off

Default value Off

C/C Process Setting range
Y-Gain

0.0 to 200.0
Pedestal

–20.0 to 20.0

Default value 100.0 0.0

Setting range
C-Gain

0.0 to 200.0
Hue

0.0 to 359.9

Default value 100.0 0.0

11 Camera 
Setting

IP Address Setting range IP Address selection

Default value

Port Setting range 1 to 65535

Default value 80

Edit IP Address Setting range Execute

Default value

Scan IP Address Setting range Execute

Default value

Edit User Name Setting range Execute

Default value

Edit Password Setting range Execute

Default value

Name Setting range Name registered on the camera

Default value

Network Status
Setting range

No IP Address, Now Checking…, Connected, Unauthorized, 
Not Connected

Default value No IP Address

Red Tally Setting range Disable, Enable

Default value Enable

Green Tally Setting range Disable, Enable

Default value Enable

HDMI IN XX 2 Status Size

Display only
Dot Clock

H-Frequency

V-Frequency

3 Freeze Setting range Disable, Enable

Default value Disable

4 Freeze Select Setting range Frame, Field

Default value Frame

5 Limited Setting range On, Off

Default value Off

6 Name Type Setting range Default, User

Default value Default

7 Name Setting range 32 characters can be set.

Default value

8 Scale Setting range Fit-V, Fit-H, Full

Default value Full

9 Color Correct C/C Setting range On, Off

Default value Off

C/C Process Setting range
Y-Gain

0.0 to 200.0
Pedestal

–20.0 to 20.0

Default value 100.0 0.0

Setting range
C-Gain

0.0 to 200.0
Hue

0.0 to 359.9

Default value 100.0 0.0
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HDMI IN XX 10 Camera 
Setting

IP Address Setting range IP Address selection

Default value

Port Setting range 1 to 65535

Default value 80

Edit IP Address Setting range Execute

Default value

Scan IP Address Setting range Execute

Default value

Edit User Name Setting range Execute

Default value

Edit Password Setting range Execute

Default value

Name Setting range Name registered on the camera

Default value

Network Status
Setting range

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Default value No IP Address

Red Tally Setting range Disable, Enable

Default value Enable

Green Tally Setting range Disable, Enable

Default value Enable

Lower layer B
No. Sub menu Setting item Setting

IP IN1,2 1 Streaming 
Mode

Setting range NDI|HX, SRT (selected source shown below)

Default value NDI|HX

IP IN3,4 1 Streaming 
Mode

Setting range NDI

Default value NDI

NDI IN XX 2 Status Format

Display only

Sampling Rate

Audio Channel

Frame Data

Compress

Streaming Mode

3 Alpha Settings Use Alpha Setting range Disable, Enable

Default value Disable

Type
Display only

Alpha Signal

Key Source 
BKGD

Setting range White, Black

Default value White

4 Machine Name
Display only

5 Source Name 

6 Scan Mode Setting range HB/HX v2, HX v1

Default value HB/HX v2

7 Scan Setting range Move to another menu (List of scan results)

Default value

8 Protocol Setting range TCP, UDP

Default value TCP
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NDI IN XX 9 Group Group Setting range Disable, Enable

Default value Disable

Group Name Setting range 64 characters can be set.

Default value

10 Use Discovery 
server

Use Discovery 
server

Setting range Disable, Enable

Default value Disable

Discovery server 
IP

Setting range IP Address input

Default value

11 RTSP Port Setting range 1 to 65535

Default value 554

Request URL Setting range 255 characters can be set.

Default value MediaInput/h264/stream_1

Connect Setting range Execute

Default value

12 Name Type Setting range Default, User

Default value Default

13 Name Setting range 32 characters can be set.

Default value

14 Camera 
Setting

Control Setting range Panasonic, NDI

Default value Panasonic

IP Address Setting range IP Address selection

Default value

Port Setting range 1 to 65535

Default value 80

Edit IP Address Setting range Execute

Default value

Scan IP Address Setting range Execute

Default value

Edit User Name Setting range Execute

Default value

Edit Password Setting range Execute

Default value

Name Setting range Name registered on the camera

Default value

Network Status
Setting range

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Default value No IP Address

Red Tally Setting range Disable, Enable

Default value Enable

Green Tally Setting range Disable, Enable

Default value Enable
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SRT IN XX 2 Status Format

Display only

Video format (1080/59.94p, etc.)

Sampling Rate

Audio Channel

Compress H.264/H.265

3 Name Type Setting range Default, User

Default value Default

4 Name Setting range 32 characters can be set.

Default value

5 Mode Setting range Caller, Listener

Default value Caller

6 Server URL Setting range Enter URL. 1 to 254 characters

Default value

7 Server Port Setting range 0 to 65535

Default value 30000

8 Stream ID Setting range 512 characters can be set.

Default value

9 Port Setting range 1024 to 65535

Default value 2020

10 Encryption Setting range Disable, Enable

Default value Disable

11 Passphrase Setting range 10 to 79 characters can be set.

Default value

12 Camera 
Setting

IP Address Setting range IP Address selection

Default value

Port Setting range 1 to 65535

Default value 80

Edit IP Address Setting range Execute

Default value

Scan IP Address Setting range Execute

Default value

Edit User Name Setting range Execute

Default value

Edit Password Setting range Execute

Default value

Name Setting range Name registered on the camera

Default value

Network Status
Setting range

No IP Address, Now Checking…, Connected, Unauthorized,  
Not Connected

Default value No IP Address

Red Tally Setting range Disable, Enable

Default value Enable

Green Tally Setting range Disable, Enable

Default value Enable
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No. Sub menu Setting item Setting

11 Output 1 OUT1(SDI 
OUT1)

Display only
Menu for the 
next layer

Moves to lower layer A

2 OUT2(SDI 
OUT2)

Moves to lower layer A

3 OUT3(HDMI 
OUT)

Moves to lower layer B

4 OUT4(IP 
OUT1)

Moves to lower layer C

5 OUT5(IP 
OUT2)

Moves to lower layer C

6 OUT6(UVC 
OUT)

Moves to lower layer D

Lower layer A
No. Sub menu Setting item Setting

SDI OUT XX 1 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

Setting menu table



134

Setting menu table
Lower layer B
No. Sub menu Setting item Setting

HDMI OUT 1 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value MV

2 Size Setting range Auto, XGA, WXGA, SXGA, WSXGA+, Native

Default value Auto

3 color Setting range Auto, RGB, YUV444, YUV422

Default value Auto

4 Scale Setting range Fit-V, Fit-H, Full, Full90%, Full80%

Default value Full

5 Move Detect Setting range 1 to 5

Default value 5

Lower layer C
No. Sub menu Setting item Setting

IP OUT XX 1 Streaming 
Mode

Setting range NDI, SRT, RTMP (selected source shown below)

Default value NDI

2 Streaming Link Setting range On, Off

Default value Off

NDI OUT XX 3 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

4 Machine Name Setting range Up to 20 characters

Default value AV-HSW10

5 Source Name Display only Setting range Up to 32 characters

Default value NDI Device xx

6 Protocol Setting range TCP, UDP

Default value TCP

7 Multicast Multicast Setting range Disable, Enable

Default value Disable

IP Address Setting range IP Address input

Default value 239.192.0.30

Subnet Mask Setting range IP Address input

Default value 255.0.0.0

TTL/HOP Limit Setting range 1 to 254

Default value 16

8 Group Group Setting range Disable, Enable

Default value Disable

Group Name Setting range 64 characters can be set.

Default value

9 Use Discovery 
server

Use Discovery 
server

Setting range Disable, Enable

Default value Disable

Discovery server 
IP

Setting range IP Address input

Default value
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SRT OUT XX 3 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

4 Assign STDBY Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

5 Mode Setting range Caller, Listener

Default value Caller

6 Destination 
URL

Setting range Enter URL. 1 to 254 characters

Default value

7 Destination 
Port

Setting range 0 to 65535

Default value 30000

8 Stream ID Setting range 512 characters can be set.

Default value

9 Port Setting range 1024 to 65535

Default value 2020

10 TTL/HOP limit Setting range 1 to 254

Default value 64

11 Latency(ms) Setting range 0 to 9999

Default value 20

12 Encryption Setting range Disable, AES128, AES256

Default value Disable

13 Passphrase Setting range 10 to 79 characters can be set.

Default value

14 Codec Setting range H.264, H.265

Default value H.264

15 Rate Control 
Mode

Setting range CBR, VBR

Default value CBR

16 Target bit rate Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Default value 14Mbps

17 Max bit rate Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Default value 14Mbps
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RTMP OUT XX 3 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

4 Assign STDBY Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

5 Server Setting range 1 to 3

Default value 1

6 Server URL Setting range Enter URL. 1 to 254 characters

Default value

7 Stream Key Setting range 512 characters can be set.

Default value

8 Timeout (sec) Setting range 1 to 30

Default value 10

9 Codec Setting range H.264

Default value H.264

10 Rate Control 
Mode

Setting range CBR, VBR

Default value CBR

11 Target bit rate Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Default value 14Mbps

12 Max bit rate Setting range 4Mbps, 8Mbps, 10Mbps, 14Mbps, 20Mbps, 24Mbps

Default value 14Mbps

Lower layer D
No. Sub menu Setting item Setting

UVC OUT 1 Assign Setting range PGM, PVW, CLN, AUX1, AUX2, MV, Key Out

Default value PGM

2 Menu Out Setting range Off, On

Default value Off
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12 Config 1 Operate Menu Out Setting range SDI OUT2, HDMI OUT, SDI2+HDMI

Default value SDI2+HDMI

Menu Size Setting range FULL, Upper-Left, Upper-Right, Lower-Right, Lower-Left

Default value FULL

Menu Back Setting range 70%, 80%, 90%, 100%

Default value 100%

Bus Mode Setting range A/B, PGM-A/PST-B, PGM-B/PST-A

Default value PGM-A/PST-B

Time Unit Setting range Sec, Frame

Default value Sec

Delegation Setting range On, Off

Default value On

Fader Setting range BKGD, KEY1, BKGD+KEY1, NoAssign

Default value BKGD

2 Key1/2 Link Setting range Off, On

Default value Off

3 CBAR Type Setting range Type1, Type2, Type3

Default value Type1

Test Tone Setting range Normal, Low, Off

Default value Off

4 Button 
Illumination

Button 
Illumination

Setting range
Dimmer

Off, On

Default value Off

Setting range
Lighting

80%, 90%, 100%, 110%, 120%, 130%, 140%, 150%

Default value 150%

Setting range XPT 
Color

Input, Color Group1, Color Group2, Color Group3, 
Color Group4, Color Group5, Color Group6, Color 
Group7, Color Group8

Default value Input

Color Group IN
Setting range

IN1(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN2(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN3(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN4(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN5(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN6(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1
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12 Config 4 Button 
Illumination

Color Group IN
Setting range

IN7(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN8(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
IN9(***)

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Color Group 
Internal Setting range

Black

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
CBGD1

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
CBGD2

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
CBAR

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Color Group Still
Setting range

Still 1V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
Still 1K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
Still 2V

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
Still 2K

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1
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12 Config 4 Button 
Illumination

Color Group Other
Setting range

CLN

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
Key Out

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range
STREAM

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range AUX 
BUS 
DELEG

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Setting range AUX 
SOURCE

Color Group1, Color Group2, Color Group3, Color 
Group4, Color Group5, Color Group6, Color Group7, 
Color Group8

Default value Color Group1

Button Color 
Group1

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.1 0.1

Setting range
B

0.0 to 1.5

Default value 0.1

Button Color 
Group2

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.1 0.1

Setting range
B

0.0 to 1.5

Default value 0.0

Button Color 
Group3

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.0 0.1

Setting range
B

0.0 to 1.5

Default value 0.1

Button Color 
Group4

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.0 0.1

Setting range
B

0.0 to 1.5

Default value 0.0

Button Color 
Group5

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.1 0.0

Setting range
B

0.0 to 1.5

Default value 0.1

Button Color 
Group6

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.1 0.0

Setting range
B

0.0 to 1.5

Default value 0.0

Button Color 
Group7

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.0 0.0

Setting range
B

0.0 to 1.5

Default value 0.1
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12 Config 4 Button 
Illumination

Button Color 
Group8

Setting range
R

0.0 to 1.5
G

0.0 to 1.5

Default value 0.0 0.0

Setting range
B

0.0 to 1.5

Default value 0.0

5 User Button User 1
Setting range

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 
12, XPT Disable

Default value Key1 PVW

User 2
Setting range

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 
12, XPT Disable

Default value Key2 PVW

User 3
Setting range

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 
12, XPT Disable

Default value Shot Memory1

User 4
Setting range

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 
12, XPT Disable

Default value Shot Memory2

User 5 Setting range Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 12

Default value Shot Memory3

User 6
Setting range

Key1 PVW, Key2 PVW, GPII-EN, GPIO-EN, AUX Trans, AUX1 
Trans, AUX2 Trans, Effect Dissolve, None, Shot Memory1 to 12

Default value Shot Memory4

6 AUX Name AUX1 Type Setting range Default, User

Default value Default

AUX1 Name Setting range 32 characters can be set.

Default value

AUX2 Type Setting range Default, User

Default value Default

AUX2 Name Setting range 32 characters can be set.

Default value

7 GPI GPI-In Setting Setting range GPI-In 
Enable

On, Off
AUX Sel

AUX1, AUX2

Default value On AUX1

GPI-In Port

Setting range Port1 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Default value GTly DSBL

Setting range Port2 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Default value BKGD AUTO

Setting range Port3 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Default value BKGD CUT
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12 Config 7 GPI GPI-In Port

Setting range Port4 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Default value KEY1 ON

Setting range Port5 
Assign

No Assign, KEY1 ON, KEY2 ON, FTB ON, BKGD 
AUTO, BKGD CUT, KEY1 AUTO, KEY1 CUT, REC 
Still1, REC Still2, AUX XPT1 to 12, RTly DSBL, GTly 
DSBL, AUX Tly DSBL

Default value KEY2 ON

GPI-Out Setting Setting range GPI-Out 
Enable

On, Off AUX Tly 
Sel

AUX1, AUX2

Default value On AUX1

GPI-Out Port

Setting range Port 1 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value RTly SDI IN1

Setting range Port 2 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value RTly SDI IN2

Setting range Port 3 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value RTly SDI IN3

Setting range Port 4 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value RTly SDI IN4

Setting range Port 5 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value RTly HDMI IN2

Setting range Port 6 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value KEY1 ON
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12 Config 7 GPI GPI-Out Port

Setting range Port 7 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value No Assign

Setting range Port 8 
Assign

No Assign, AUTO, CUT, KEY1 ON, KEY2 ON, FTB 
ON, BKGD AUTO, BKGD CUT, KEY1 AUTO, KEY1 
CUT, RTly SDI IN1 to 4, RTly HDMI IN1, 2, RTly IP 
IN1 to 4, GTly SDI IN1 to 4, GTly HDMI IN1, 2, GTly 
IP IN1 to 4, AUXTly SDI IN1 to 4, AUXTly HDMI IN1, 2, 
AUXTly IP IN1 to 4

Default value No Assign

8 Key Source 
Signal 
Coupling

Fill/Source Setting range Fill To Source, Source To Fill

Default value Fill To Source

IN1(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN1

IN2(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN2

IN3(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN3

IN4(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN4

IN5(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN5

IN6(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN6

IN7(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN7

IN8(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN8

IN9(***)
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value IN9

Black
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value Black
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12 Config 8 Key Source 

Signal 
Coupling

CBGD 1
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value CBGD 1

CBGD 2
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value CBGD 2

CBAR
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value CBAR

Still 1V
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value Still 1V

Still 1K
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value Still 1K

Still 2V
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value Still 2V

Still 2K
Setting range

IN1(***) to IN9(***), Black, CBGD 1, CBGD 2, CBAR, Still 1V, 
Still 1K, Still 2V, Still 2K

Default value Still 2K

9 System Menu 
Lock

Setting range On, Off

Default value Off

Setting menu table
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13 System 1 System Format
Setting range

1080/59.94p, 50p, 59.94i, 50i, 29.97p, 25p, 24p, 23.98p, 
720/59.94p, 50p

Default value 1080/59.94p

2 Reference Reference Select Setting range BB, Tri-level Sync, Internal

Default value BB

Status Setting range

Default value

3 Output Phase System Setting range 0H, 1H

Default value 0H

H-Phase Setting range – 0.50 to 0.49

Default value 0.00

V-Phase Setting range –100 to 100

Default value 0

4 User Auth User Name Setting range

Default value

Password Setting range Execute

Default value

5 Alarm Power Setting range Alarm, No Alarm

Default value

Fan Setting range Alarm, No Alarm

Default value

Temperature Setting range Alarm, No Alarm

Default value

6 Tally Settings Tally Mode Setting range Off, On

Default value On

Tally Target

Setting range Red 
Tally

Off, PGM, CLN, Key 
Out, AUX1, AUX2, IP 
OUT1, IP OUT2 Green 

Tally

Off, PGM, PVW, 
CLN, Key Out, AUX1, 
AUX2, IP OUT1, IP 
OUT2

Default value PGM PVW

7 Date/Time Date Setting Setting range yyyy / mm / dd

Default value

Time Setting Setting range hh : mm : ss

Default value

8 Initial Initial Settings Setting range Execute

Default value

Initial Fader Setting range Execute

Default value

9 System 
Information

System Version Setting range Display only

Default value

System Core1 
Version

Setting range Display only

Default value

System Core2 
Version

Setting range Display only

Default value

System Core 
Update

Setting range Execute

Default value
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14 Project 1 Project File Project 1 Setting range
Protect

Off, On
Load

Execute

Default value Off

Setting range
Save

Execute
Delete

Execute

Default value

Setting range
Name

32 characters
Date

Display only

Default value

Project 2 Setting range
Protect

Off, On
Load

Execute

Default value Off

Setting range
Save

Execute
Delete

Execute

Default value

Setting range
Name

32 characters
Date

Display only

Default value

Project 3 Setting range
Protect

Off, On
Load

Execute

Default value Off

Setting range
Save

Execute
Delete

Execute

Default value

Setting range
Name

32 characters
Date

Display only

Default value

2 Last Load File 
Name

Setting range I: *****, U: *****, L: *****

Default value

3 Last Load Date Setting range yyyy/mm/dd hh:mm

Default value
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15 Ancillary/Audio 1 Ancillary AUX Setting range Off, On

Default value On

PGM Setting range Off, On

Default value On

PVW Setting range Off, On

Default value On

CLN Setting range Off, On

Default value On

MV Setting range PGM, PVW, Off

Default value Off

2 Audio Assign AUX1 Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF

Default value Follow Video

AUX2 Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF

Default value Follow Video

PGM Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF

Default value Follow Video

PVW Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF

Default value Follow Video

CLN Setting range IN1(***) to IN9(***), Analog, Follow Video, OFF

Default value Follow Video

3 Analog IN Audio Setting range Off, On

Default value Off

Input Type Setting range LINE, MIC

Default value LINE

Gain
Setting range

–36dB, –33dB, –30dB, –27dB, –24dB, –21dB, –18dB, –15dB, 
–12dB, –9dB, –6dB, –3dB, 0dB, 3dB, 6dB, 9dB, 12dB

Default value 0dB

Delay(ms) Setting range 0 to 512

Default value 0

4 Analog OUT Assign Setting range PGM, PVW, AUX1, AUX2, CLN

Default value PGM

Mute Setting range Off, On

Default value Off

Volume Setting range 0 to 100

Default value

16 Network 1 LAN IP Address Setting range 0 to 255.255.255.255

Default value 192.168.0.8

Subnet Mask Setting range 0 to 255.255.255.255

Default value 255.255.255.0

Default Gateway Setting range 0 to 255.255.255.255

Default value 192.168.0.1

MAC Address Setting range –

Default value –

2 Primary DNS IP Address Setting range 0 to 255.255.255.255

Default value –

3 Secondary 
DNS

IP Address Setting range 0 to 255.255.255.255

Default value –
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17 External 
Interfaces

1 External Panel 
Information

Active Setting range Disable, Enable

Default value Disable

Port No Setting range 62000 to 65535

Default value 62010

2 External Panel 
IP

Shot Memory 
Recall

BKGD Setting range
Target 

Off, On
XPT

Off, On

Default value Off Off

Key1 Setting range
Target 

Off, On
XPT

Off, On

Default value Off Off

Key2 Setting range
Target 

Off, On
XPT

Off, On

Default value Off Off

AUX1 Setting range Off, On

Default value Off

AUX2 Setting range Off, On

Default value Off

CBGD Setting range Off, On

Default value Off

XPT Setting range Off, On

Default value Off

3 External 
Control 
Switcher

Active Setting range Disable, Enable

Default value Disable

Port No Setting range 62000 to 65535

Default value 62000

Interval Time Setting range 0ms, 16ms, 32ms, 48ms, 64ms, 80ms

Default value 16ms

Response Setting range On, Off

Default value On

4 External 
Control AUX 
Panel

Port No Setting range 62000 to 65535

Default value 65000

IP Address1 Setting range 0 to 255

Default value 0.0.0.0

IP Address2 Setting range 0 to 255

Default value 0.0.0.0

IP Address3 Setting range 0 to 255

Default value 0.0.0.0

IP Address4 Setting range 0 to 255

Default value 0.0.0.0

IP Address5 Setting range 0 to 255

Default value 0.0.0.0

IP Address6 Setting range 0 to 255

Default value 0.0.0.0

IP Address7 Setting range 0 to 255

Default value 0.0.0.0

IP Address8 Setting range 0 to 255

Default value 0.0.0.0

IP Address9 Setting range 0 to 255

Default value 0.0.0.0

IP Address10 Setting range 0 to 255

Default value 0.0.0.0
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Setting menu table
No. Sub menu Setting item Setting

17 External 
Interfaces

4 External 
Control AUX 
Panel

IP Address11 Setting range 0 to 255

Default value 0.0.0.0

IP Address12 Setting range 0 to 255

Default value 0.0.0.0

IP Address13 Setting range 0 to 255

Default value 0.0.0.0

IP Address14 Setting range 0 to 255

Default value 0.0.0.0

IP Address15 Setting range 0 to 255

Default value 0.0.0.0

IP Address16 Setting range 0 to 255

Default value 0.0.0.0

IP Address17 Setting range 0 to 255

Default value 0.0.0.0

IP Address18 Setting range 0 to 255

Default value 0.0.0.0

IP Address19 Setting range 0 to 255

Default value 0.0.0.0

IP Address20 Setting range 0 to 255

Default value 0.0.0.0

18 USB Memory 1 Load Load Type Setting range Still1, Still2, Project, Update

Default value Still1

Load Setting range Execute

Default value

2 Save Save Type Setting range Still1, Still2, Project, Log

Default value Project

Setup Setting range On, Off

Default value On

Shot Setting range On, Off

Default value On

Still Setting range On, Off

Default value Off

File Format Setting range bmp, tga, png, jpg, tif, gif

Default value png

Save Setting range Execute

Default value

3 Free Setting range Free space [KB/MB/GB]

Default value

4 Total Setting range Total space [KB/MB/GB]

Default value

5 Unmount Setting range Execute

Default value

6 Format Setting range Execute

Default value
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Setting menu table
No. Sub menu Setting item Setting

19 Color Adjust 1 Target Setting range IN1(***) to IN5(***)

Default value IN1(***)

2 Parameter No Setting range 1 to 10

Default value 1

3 Marker Setting range Off, On

Default value Off

4 Capture for 
Master

Setting range Execute

Default value

5 Adjust Target Setting range Execute

Default value

6 Enable Color 
Adjust

Setting range Disable, Enable

Default value Disable

7 Left Setting range –50.00 to 50.00 (Left<Right)

Default value –50.00

8 Top Setting range –50.00 to 50.00 (Top>Bottom)

Default value 50.00

9 Bottom Setting range –50.00 to 50.00 (Top>Bottom)

Default value –50.00

10 Right Setting range –50.00 to 50.00 (Left<Right)

Default value 50.00

11 Set Capture 
Points

Setting range Execute

Default value

12 Points Point 1 to 24 Setting range
X-Position

–50.00 to 50.00

Default value
Value generated by Left = –50.00, Top = 50.00, 
Bottom = –50.00, Right = 50.00 (full-screen use)

Setting range
Y-Position

–50.00 to 50.00

Default value
Value generated by Left = –50.00, Top = 50.00, 
Bottom = –50.00, Right = 50.00 (full-screen use)

13 Parameters Parameter 1 to 
10

Setting range
Master

IN1 to 5

Default value

Setting range
Name

16 characters

Default value
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Appendix (glossary)
Defined below are the terms used in this manual.

Word Explanation

AB Bus system A bus control mode. By executing a transition, the A bus and B bus signals are output to 
the program images alternately.

Ancillary Data The auxiliary data other than the video signals which is transmitted inside the data 
stream of the video serial interface. The data superimposed on the vertical blanking 
period is referred to as the V ancillary data (VANC).

Aspect ratio The ratio between the horizontal and vertical dimensions of an image or screen.
It is 16:9 for the HD format and 4:3 for the SD format.

AUX
[Auxiliary Bus]

A spare bus which can be switched by signals other than the main line output signals.

BB
[Black burst]

Abbreviation for Black Burst signals. A full-screen black level composite signal which is 
used as the reference signal for gen-lock.

Border The area or margin that is added to the edge of a wipe or key.
Its width and color can be adjusted. The defocusing of the area around a border is 
referred to as the soft effect.

Chroma key This refers to the function for creating the key signals based on the color information of 
the video signals and combining the keys.

Clip The threshold level of the luminance when key signals are created from a key source.

Color Background The signals which are output from the internal color generator and used as the 
background image.

Cut This refers to the effect where the display is instantly switched to the next image.

Density A parameter which is used to adjust the density of the key signals.

Down Converter This is the function that converts material in the 4K format into the 2K/HD format.

Embedded Audio This refers to the audio data packets which are transferred inside the data stream of the 
video serial interface.

Flip Flop system
(PGM/PST system)

A bus control mode. The signals selected by the program bus are always output as the 
program images. By executing a transition, the program bus and preset bus signals are 
switched over.

Frame Synchronizer A function which matches the synchronization of non-synchronized video input signals.

Freeze A function for pausing video signals.

FTB [Fade to Black] This is the effect where the background image is faded out to the black screen.

Genlock A function for synchronizing the video signals using an external sync signal as the 
reference.

GPI
[General Purpose Interface]

Interface signals which control auto transition from an external source.

Hue The color tone of the video signals.

Key Edge The border or shadow added to the edges of keys.

Key Fill The signal that uses key combination processing to fill in the areas left blank by the key 
signals.

Key Gain A parameter which is used to adjust the amplitude of the key signals.

Key Invert A function which inverts the key signals.

Key Mask This is the function that specifies the area for key combination using the box pattern, etc. 
When only part of the area of the key signals is used, key combination is executed with 
the unnecessary area masked.

Key Source The video signals for creating the key signals.
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Word Explanation

Line Synchronizer A function to automatically adjust the input image signal phase to the horizontal 
synchronization reference signal phase.

Linear Key The function which combines keys using monochrome key signals with gradations in its 
outlines as a reference.

Lum
[Luminance]

The brightness portion of the video signals.

Luminance Key The function which creates key signals based on the luminance (brightness) information 
of the video signals to combine keys.

ME
[Mix Effect]

A video effect device which combines a number of video signals to create mix, wipe, key 
and other video signals.

Mix The picture-changing effect produced by overlapping one image with the next.
It is also referred to as “dissolve”.

Multi View Display This function combines multiple materials and displays them on one screen. PGM, PVW 
and the input material can be previewed at the same time on a single screen.

PinP [Picture in Picture] This function combines a sub screen image with the background image.

PVW
[Preview]

The function for checking ahead of time the image which will be output after the next 
transition. The image is output from the PVW system.

PGM
[Program Bus]

The bus which always carries the program output signals.

PST
[Preset Bus]

The bus which carries the program output signals after the next background transition.

Sat
[Saturation]

This refers to the intensity of the color chrominance level of video signals.

SDI
[Serial Digital Interface]

The standard by which video signals in various SD and HD formats are transmitted along 
a single coaxial cable.

Self Key A function that creates key signals from key fill signals for combining keys.

Setup Data The memory in which the control panel statuses can be saved and recalled.
The button selection statuses as well as the border, color and other setting information 
can be saved in this memory.

Tally The signal which outputs the program output statuses of the input signals to an external 
device. The LED that indicates the program output status on the control panel is also 
referred to as tally.

Transition A function that switches from one image to another.
Wipe, mix and other effects are available for the images during switching.

Tri-level Sync The sync signal used for HD formats.

Trimming This is the function that eliminates the unnecessary parts at the top, bottom, left and/or 
right of the images which are combined using the PinP function.

Up Converter This is the function that converts material in the 2K/HD format into the 4K format which 
yields a high resolution.

Video Memory This is the memory in which the images (still images) with key signals can be stored.

Wipe A video effect in which one image is gradually replaced by another as the boundary 
between the two is moved using a preselected pattern.

Appendix (glossary)
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A
ALARM indicator .....................................................  18

Ancillary/Audio ......................................................  146
Analog IN .............................................................  146
Analog OUT .........................................................  146
Ancillary ...............................................................  146
Audio Assign ........................................................  146

Audio input connector ............................................  21

AUTO button ............................................................  20

AUX bus crosspoint buttons ..................................  20

AUX bus selector buttons .......................................  20

B
Bus tally indicators .................................................  20

C
CBGD ..............................................................  120, 121

CBGD Main .........................................................  120
CBGD Move ........................................................  121
CBGD Select .......................................................  120
CBGD Sub ...........................................................  120
CBGD Wash ........................................................  120
CBGD Wave ........................................................  121

ChromaKey ............................................................  123
Cancel .................................................................  123
Marker .................................................................  123
Marker Aspect .....................................................  123
Marker Position ...................................................  123
Radius .................................................................  123
Ref Adjust ............................................................  123
Sample ................................................................  123
Soft ......................................................................  123
Y-Influence ...........................................................  123

Color Adjust ...........................................................  149
Adjust Target .......................................................  149
Bottom .................................................................  149
Capture for Master ..............................................  149
Enable Color Adjust .............................................  149
Left ......................................................................  149
Marker .................................................................  149
Parameter No ......................................................  149
Parameters ..........................................................  149
Points ..................................................................  149
Right ....................................................................  149
Set Capture Points ..............................................  149
Target ..................................................................  149
Top .......................................................................  149

Config .....................  137, 138, 139, 140, 141, 142, 143
AUX Name ..........................................................  140
Button Illumination .......................  137, 138, 139, 140

CBAR ..................................................................  137
GPI ......................................................  140, 141, 142
Key1/2 Link ..........................................................  137
Key Source Signal Coupling ........................  142, 143
Operate ...............................................................  137
System Menu Lock ..............................................  143
User Button .........................................................  140

Cooling fan ...............................................................  22

CUT button ...............................................................  19

D
Dedicated crosspoint buttons for the AUX bus ....  20

E
EXIT button ..............................................................  19

External Interfaces ........................................  147, 148
External Control AUX Panel ........................  147, 148
External Control Switcher ....................................  147
External Panel Information ..................................  147
External Panel IP .................................................  147

F
Fader lever ...............................................................  20

FTB ON button .........................................................  19

G
Ground connector ...................................................  22

H
HDMI IN connectors ................................................  21

HDMI OUT connector ..............................................  21

Headphone connector .............................................  23

Hole for fitting the cable clamp ..............................  23

I
Input ........................................................................  128

IN1(SDI1/HDMI1) ................................................  128
IN2(SDI IN2) ........................................................  128
IN3(SDI IN3) ........................................................  128
IN4(SDI IN4) ........................................................  128
IN5(HDMI IN2) .....................................................  128
IN6(IP IN1) ..........................................................  128
IN7(IP IN2) ..........................................................  128
IN8(IP IN3) ..........................................................  128
IN9(IP IN4) ..........................................................  128

Index
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K
Key ..........................................................  121, 122, 123

Edge ............................................................  121, 122
Fill ........................................................................  121
Fill Matte ..............................................................  121
Key Adjust ...........................................................  121
Key Priority ..........................................................  123
Key Select ...........................................................  121
Key Signal Coupling ............................................  123
Key Type .............................................................  121
Mask ....................................................................  122
PinP .............................................................  122, 123
PVW ....................................................................  121

KEY 1 ON button ......................................................  19

KEY 2 ON button ......................................................  19

L
LAN cable ...............................................................  103

LAN connector .........................................................  22

M
MENU button ............................................................  19

MIX/WIPE switching button ....................................  20

Monitor volume dial .................................................  23

MultiView ................................................  126, 127, 128
Display .................................................................  128
Green Tally ..........................................................  127
MV Character ......................................................  127
MV Frame ............................................................  127
MV Label .............................................................  127
Red Tally ..............................................................  127
Size .....................................................................  126
Source Select ..............................................  126, 127
Split .....................................................................  126

N
Network ..................................................................  146

LAN .....................................................................  146
Primary DNS .......................................................  146
Secondary DNS ...................................................  146

O
OSD menu ................................................................  26

OSD/TIME dial ..........................................................  19

Output .....................................................................  133
OUT1(SDI OUT1) ................................................  133
OUT2(SDI OUT2) ................................................  133
OUT3(HDMI OUT) ...............................................  133

OUT4(IP OUT1) ..................................................  133
OUT5(IP OUT2) ..................................................  133
OUT6(UVC OUT) ................................................  133

P
PGM bus crosspoint buttons .................................  20

POWER indicator .....................................................  18

Power switch ...........................................................  21

Project ....................................................................  145
Last Load Date ....................................................  145
Last Load File Name ...........................................  145
Project File ..........................................................  145

PST bus crosspoint buttons ...................................  20

R
Reference input connector .....................................  21

S
SDI IN connectors ...................................................  21

SDI OUT connectors ................................................  21

Security slot .............................................................  22

SERVICE switch .......................................................  22

SHIFT button ............................................................  19

Shot Memory ..........................................................  124
Effect ...................................................................  124
Hue Path .............................................................  124
Target Select .......................................................  124
XPT DSBL ...........................................................  124

Shot Memory button ................................................  19

Still ..........................................................................  124
Capture ................................................................  124
Capture Setting ...................................................  124
Key Status ...........................................................  124
Still Select ............................................................  124
Test Pattern .........................................................  124

STREAM button .......................................................  18

System ....................................................................  144
Alarm ...................................................................  144
Date/Time ............................................................  144
Initial ....................................................................  144
Output Phase ......................................................  144
Reference ............................................................  144
System Format ....................................................  144
System Information .............................................  144
Tally Settings .......................................................  144

Index
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User Auth .............................................................  144

T
TALLY/GPI connector ..............................................  22

TIME ........................................................................  124
AUX1 Bus Trans ..................................................  124
AUX2 Bus Trans ..................................................  124
BKGD ..................................................................  124
Effect Dissolve .....................................................  124
FTB ......................................................................  124
Key1 ....................................................................  124
Key2 ....................................................................  124

U
USB connector ...................................................  21, 22

USB Memory ..........................................................  148
Format .................................................................  148
Free .....................................................................  148
Load ....................................................................  148
Save ....................................................................  148
Total .....................................................................  148
Unmount ..............................................................  148

USER buttons ..........................................................  18

W
WIPE .......................................................................  120

BKGD Pattern ......................................................  120
BKGD Transition ..................................................  120
Key1 Pattern ........................................................  120
Key1 Transition ....................................................  120

X
XPT Assign .............................................................  125

Switch Timing ......................................................  125
XPT1 ...................................................................  125
XPT2 ...................................................................  125
XPT3 ...................................................................  125
XPT4 ...................................................................  125
XPT5 ...................................................................  125
XPT6 ...................................................................  125
XPT7 ...................................................................  125
XPT8 ...................................................................  125
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XPT10 .................................................................  125
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